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the complete guide to digital type

introduction

Typography is a craft that, until relatively recently,

was practiced only by skilled individuals. It

required a meticulous eye for detail and knowledge

of legibility that few people possessed. Traditionally,

graphic designers worked in conjunction with

typographers (and printers) to set type, rather than

n the intricacies themselves.

When Apple introduced the Macintosh in 1984, all

that changed. This new computer allowed designers

to set type and manipulate it in ways that had not

been previously possible or financially feasible. It gave

them the freedom to experiment and a new way of

working; type became just another element within

the overall design composition. This freedom also

prompted designers to question the rules held dear

by previous generations of typesetters and enabled

them to use typography in new and creative ways.

This book provides an insight into the typographic

creativity produced by this digital revolution. It takes

you through a brief history of typography and the

anatomy and various classifications of fonts. You will

see the influence that digital media has had on the

practice of typography, in particular the role of

software and digital formats.

Then you will see the conventions that govern

typography. These conventions, laid down over time,

provide a framework for creating legible text, both for

display purposes and extended reading. These rules

always apply, whether using digitally generated type

or traditional methods. Also, the way in which text is

used on the page is very important in determining its

readability, so you will see how to use grid structures,

then learn how to manage your digital fonts using

software such as Suitcase Fusion.



ntroduction

Designers need to create maximum impact with

their typography. You will see at length the various

effects that can be applied to type using software

such as Adobe Photoshop, Illustrator, and FreeHand.

The rise of the internet has made reading type on

screen as important as reading it on paper, so this

effects section been divided in two, looking at print-

then screen-based typography. The section on print

deals with static display typography and

demonstrates how to achieve a myriad of different

effects, from mimicking screen-printing to warping

and distressing type.

Since the internet can carry dynamic content as

well as static type, you will see how to be creative

with moving typography, within the limitations

imposed by screen technology. These limitations are

explored, showing you the typefaces and methods

used to improve on-screen type recognition, along

with a look at animation techniques.

Manipulating fonts is one thing but generating

your own typefaces is something else. So the final

section looks at font creation, taking you from a set

of sketches to a working typeface, explaining the

process of building and digitizing letterforms and

creating font formats for use with both Mac and PC

platforms. Because applications such as Fontographer

and FontLab allow you to design and publish a font in

a matter of hours, you will see how to construct

various pieces of homemade typography, such as

handwritten, modular, and hybrid fonts, including

how to deal with spacing and kerning.

Together, you will learn how to create original,

contemporary digital typography that is both

beautiful and technically accurate.
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typography and fonts

"Y"

In order to produce beautiful, legible typography, the

user must have a good knowledge of the subject: it is

not simply a case of making type look pretty on the

page. A typographer must also understand how the

viewer will read and interpret the information

displayed, and should know what is available in terms

of fonts and printing techniques. With a brief history

of printing technology and how it has advanced

typographic composition, this section explains the

terminology used to describe typography. There is also

a discussion on the implications of digital technology.
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a history of typography
In order to understand why typography looks the way it does, it is important to know how

technological developments have affected the nature of typography over the centuries.T" ce of printing

beg' :he advent of mechaniza-

with the invention of

credited to Johann

iberg. He produced the first printed

booi ne Bible, between 1450 and

^ the writing of contemporary

eated over 300 characters to

proc us letterforms, including

ligatures. Besides his Bible. Gutenberg's

greatest legacy was the printing process

jlar, punch cutting,

nch cutting involved cutting the

m of a glyph, in reverse, onto the end of

jar—the punch. Each character

:s own punch. These were then

assembled to form words and sentences,

•ed using the letterpress.

early commercial printing

of hand composition was the

il printing method—

a

ng in which a raised,

as pressed against the

pap- -pression of the ink

jpher would use a com-

• ble type into words,

>tal spaces were

added I- .vords to justify the

ure and each line

by a

m "leading")

a heavy

n8

The process was time-consuming and,

with the invention of the Linotype and

Monotype machines, was relegated to

small independent printers who dedicated

themselves to small print runs. Today it is

undergoing a revival among a number of

designers, such as Vince Frost, who appreci-

ate the inaccuracies of the process: improp-

erly inked letters can appear patchy and

have a more handcrafted look to them.

the hot-metal revolution

Printing processes gained considerable

speed with the introduction of "hot-metal"

type. The term refers to the process of cast-

ing lines of type in molten metal. It had a

huge impact on the printing industry. The

first Linotype hot-metal line-casting

machine was introduced in 1886. It com-

prised of a keyboard, matrix, and caster. The

keyboard controlled the assembly of the

matrix of letters. When a line was completed,

it was cast as a single piece of metal, called

a "slug." The slugs were then arranged to

make up the required design for inking up

and printing.

In 1887, the Monotype composing

machine appeared, which cast each charac-

ter individually. The keyboard and caster

were separate, with the keyboard operation

Uncials and Black when set in large

letter date back to the amounts due to their

Middle Ages. By heavy stroke widths:

today's standards they we are used to less

are difficult to read complicated glyphs.

ahcftefgljijklmtto
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a history of typography

generating a punched paper ribbon. When

this was fed through the caster it gave

instructions to move the type into position

to produce the lines of text. These were

then assembled in a galley to be printed

from. Letters were cast quickly with this

machinery (up to 150 per minute) and, since

the keyboard was a separate entity, opera-

tors could generate type away from the

noise of the machinery.

the age of phototypesetting

Electronics have played a key role in the

progression of professional printing tech-

niques and also in the availability of cheap

and accurate ways to reproduce type for

the home user.

The first generation of keyboard photo-

typesetters was introduced in 1950. Many

others have been developed since but,

despite this, they break down into two cate-

gories. These are Photo-optical and Photo-

scanning systems. Photo-optical systems

store characters in the form of a master

font on film, disks, grids, or strips. These

negative images are then optically pro-

jected onto photographic film or paper.

Photo-scanning also stores characters in

the form of a master font, but they are not

projected onto film or paper. Instead, they

are scanned electronically and broken

down into dots or lines. They are projected

onto a cathode-ray tube (CRT), then onto

photographic film or paper.

The advantages of this method over hot-

metal type are significant: it is fast and flex-

ible and can set up to 500 characters per

second as opposed to just five using hot-

metal machines.

H The introduction

of the Apple Mac in

1984 revolutionized

the graphic design

industry. This box

meant that the

designer could

generate quality

designs, without

complicated

instructions to

typesetting houses.

The current mode of printing type pro-

fessionally is that of digital typesetting. The

first machine to use digitized fonts was the

Digiset in 1965, designed by Dr. Ing Rudolph

Hell. The method used a CRT to generate

the image. It later gave way to the use of a

laser with the introduction of the

Monotype Lasercomp in 1976.

The 1980s witnessed considerable

changes in the design world. Personal com-

puters came down in price, WYSIWYG dis-

plays appeared and, most importantly, in

1984, the PostScript page language

appeared via the Pagemaker software for

the Apple Macintosh. The PostScript lan-

guage enabled typefaces from any

manufacturer to be used on any compat-

ible computer and printer. Previously, this

had been impossible and printing presses

had only been able to use fonts released by

the manufacture! of the press.

This upheaval resulted in a dramatic

change in the relationship between type-

setting and design. Computer workstations

could now be networked directly to presses.

Where, previously, designers had prepared

pencil sketches for client approval, sending

detailed instructions to the typesetting

houses, each stage could now take place on

a computer, complete and ready to print,

cutting both time and expense.

One major difference between this and

previous methods of printing type is that

there is no physical type. The font informa-

tion is stored as data in the computer's

memory, viewed on screen and output

directly on + o paper, plate, or digital press

cylinder for offset lithography.
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anatomy of a typeface
It is essential to know and understand typography in order to use it convincingly and

competently. This includes learning the terminology involved.

I

y have developed

I js a result, much of

.olved derives from

i now redundant A good

ms we use today have no

g on the generation of digital

>s a vocabulary and termi-

.-. ir : 'i order to describe typography

• jnts accurately, it is favourable

?w and understand the basic technical

properties of the characters that make up

a font Mastering these will help you to

type more appropriately within your

gn proje

our bodies are made up of differ-

own anatomical

" so. too. are type forms. This anatomy of

type helps designers not only to identify one

font sther but also helps identify

purposes, based on the

troke widths from which

hese are the factors that

:>ersona

Although < jwn chd

isually from

otfv- i number of common

«H fonts conform

For ' aselme on which

the • ;"terminethe

toflov.' iscender line,

,:<•,'•'

•nay vary

. appear.

... .

Studying letterforms aids us to under- so lend themselves well to display text.

stand why certain fonts are more elegant Conversely, those with a small x height are

than others—or more quirky. It is precisely better suited to body copy. Understanding

for these reasons that we may choose to how a well-proportioned font is constructed

use a particular font or not. Some fonts will also help if you are planning to design

have a large x-height-to-ascender ratio and any fonts of your own.

THE BASIC TERMINOLOGY OF I

Apex Hairline

The peak of the triangle on an uppercase "A

"

The thinnest stroke of a typeface of varying

stroke widths.

Arm
A projecting horizontal stroke that is Leg

unattached on one or both sides, such as in The diagonal stroke in the lower half of a

a capita! lowercase 1

Ascender Link

The stroke on a lowercase letter, which rises The stroke that connects the bowl and the

above the x-height. loop of a lowercase "g."

Bowl Loop

A curved stroke, which encloses a The bottom half of a lowercase "g."

counterform

Serif

Counter Short strokes thai extend from.and to, the

The negative space that is fully or partially major strokes of letters.

enclosed by a letterfor

Shoulder

Crossbar A curved stroke extending from a stem.

A horizontal stroke that connects two sides of

a letterform Spur

A projection, smaller than a serif, that reinforces

Descender the
i

he end of a

• -• on a lowercase letterform that

"low the baseline Stem

Am.. il or diagonal stroke within a

Ear letterform,

A small stroke that extf 1 he upper

right side of the bowl on a lowercase Tail

A diagonal stroke or loop at the end of a letter.

Eye

wercase Terminal

The end of any stroke that does not terminate

with a Serif



anatomy of a typeface

i— serif r- crossbar r- ascender
,
— cap line r ascender line

' * B shoulder -, bowl—, r spur x-line-n

1 1 1 L) CX
stem descender L counter <- terminal

^JjL r descender line

slab serif

H A slab-serf

letterform differs

from a regular serif in

that the stoke width

is uniform all the way

around. The serifs do

not taper, as you

would normally

expect to see.

ii Certain glyphs

have terms that are

unique only to them,

such as the eye of a

lowercase "e," the

apex of an uppercase

"A" and the loop of a

lowercase "g."

<< All typography

sits on a baseline and

has set depths for

ascenders, descenders,

and capitals. The

x-height is the height

of lowercase letters as

determined by the

height of a lowercase

letter "x."

i— hairline

ear

apex

It Hairlines refer to

the thin serifs, which

contrast with the

thicker strokes of the

rest of the letterform

as demonstrated here

on this lowercase "k."

t
1

THE BASICS

—

I CHARACTER SETS 144

CREATING YOUR OWN
I HANDWRITTEN FONT 148

CREATING YOUR OWN
I FONT FROM SCRATCH 164

CREATINC A FONT
FROM FOUND OBJECTS 174



the complete guide to digital type

descriptions and font classifications

Fonts are classified in categories, based on their visual and historical characteristics. This

gives us an insight into their construction and helps identify them precisely.

Tts available dig-

,an be very

Jesigner There have

been attempts to classify typefaces but it

engmg because many

jal traits. One of the

jsed forms of classification is

base •oncal developments, and yet

^nost recent typeface designs

d place within this classifica-

^ecause digital fonts do not necessar-

e historical standards of

Many of them knowingly and

erately break the rules and. as such,

are 5 of their own.

old style or old style humanist

Known m the past as Venetian, these fonts

finally inspired by carved Roman

md based on 15th-century minus-

's Such fonts are identified by an

ke on the lowercase "e,"

al stresses of an angled

re more rounded and

have angled serifs on the tops of the lower-

case letters.

transitional

Faces in the 1700s evolved from old style

to modern. Those in the interim period,

which include Baskerville, are classified as

transitional. There is a greater contrast

between the thick and thin strokes, with a

more horizontal stress within the letter-

forms. Transitional fonts also appear

wider than old style fonts.

modern

Modern typefaces, such as Bodoni, have

more contrast between thick and thin

strokes—the thin strokes are sometimes

reduced to hairline widths. Stresses with-

in characters are horizontal and serifs join

stems horizontally, with no bracketing.

slab serifs

These typefaces are sometimes known as

Egyptian faces. At the time they were

introduced (around 1815) there was a huge

interest in Egyptian artefacts and so some

foundries used the term for their type

designs. These fonts have heavy square, or

rectangular, serifs. In many of the fonts, the

stroke widths are uniform and there are

horizontal stresses within characters.

sans serif (grotesques)

These first appeared in the 19th century.The

characters have vertical stresses with no

serifs and some contrast in stroke width.

This group also covers categories such as

Neogrotesque, Geometric, and Humanist.

Neogrotesques are uniform in stroke width.

Geometric typefaces are created using sun

pie geometric shapes, such as the circle or

rectangle. They have a single-storey lower-

case letter "a." Finally, Humanist faces are

based on the proportions of old style

Humanist fonts but without serifs. They

have some contrast in their stroke widths

and have two-storey lowercase letters "a"

and "g."

ii Old style fonts
OLD STYLE m , h)de Garamond

and Bembo, designed

GARAMOND:.!! f L-J li]kll HIK >p( ||si U\ \\ \\ / S^rto*
"*

\\>>( DEFGHIJKLMNOPQRST1 VWXYZ L234567890.,?":;&%!-{)

bembo: ;hijklmnopqrstuvwxyz

;( DEFGJ lllkl MN< >PQRSTUVWXYZ l2345f,7S ( ;n.,?
,,

:;c\%!-i \



descriptions and font classifications

TRANSITIONAL 4i Transitional fonts

include Baskerville.

r They have wider forms

baskerville: abcdeiffhi Mmnopqrstuvwxyz and have no middle

' serifs on uppercase "W."

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890.,?":;&%!-{}

MODERN « Modern faces

include Bodoni.They

#t have a high contrast

bodonI: abcdefffhijklmnopqrstuvwxyz between the weight
° 1 l J of strokes and serifs.

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890.
5
?":;&%!-{}

EGYPTIAN << Egyptian faces

also known as slab

serifs, have heavy

rockwell: abcdefghijklmnopqrstuvwxyz rectangular sen* of

"' uniform width.

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890.,?":;&%!-{}

SANS SERIF
« Sans se ,lf faces

have uniform stroke

widths and tend to

helvetica: abcdefghijklmnopqrstuvwxyz becondensed.

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890., ?":;&%!-{}

univers: abcdefghijklmnopqrstuvwxyz

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890., ?":;&%!-{}

eurostile: abcdefghijklmnopqrstuvwxyz

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1 234567890. ,?": ;&%!-{}

optima: abcdefghijklmnopqrstuvwxyz

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1 234567890.,?":;&%!-{}
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descriptions and font classifications continued

Sorr oology used in typography

) I factors. This

formats and

type day. but it is valuable to know

whe gmates from and.

more importantly, how it is used.

the em square

An em is a unit of measurement for any

ne term derives from the

h of an uppercase "m." This letter was

nally as wide as the point size when

•oetal For example, in a 10-point

letter "M" should be 10

poir
•

' his means that the measure-

* of an em is a square of equal size to

.e An em dash is so called

because it is the width of this square. (An

en dash is half this size). Nowadays, with

digital typography, the letter "m" has no

real relationship to an em measurement,

but the term has remained. When typeset-

ting, paragraph indents are usually an em

width, equal to the point size.

upper- and lowercase letters

Many people wonder why we have the

terms upper- and lowercase to describe the

characters within a font. As with much of

the terminology used for typography, this

derives from the printing trays that where

used for storing the type. Two trays were

used for each font, one stored above the

other. The top tray, or upper case, was used

for capital letters, while the bottom tray

(lower case), held all the non-capital letters.

The terms have stayed with us, despite

bearing no relation to digital type.

point size

Type is measured in points, the term deriving

from the days of the letterpress when a let-

terform was printed from a raised character

mt on a steel punch (see p. 10). The point size

refers to the body of the punch and not the

letterform itself. The measurement there-

fore includes the space above and below the

strokes of the letterform. As a result, when

measured manually with a ruler, a character

will always appear slightly smaller than its

given point size.

• an • has the measurement

uppercase lett' becorrv 1 ;>ted has prevailed but in

ng name alone •>

lemony longer bears any

1
' paragrap' re to

6f mod' '°8V



descriptions and font classifications

The text here is set in

a variety of point

sizes. The term refers

to the dimensions of

the typography. One
point is equal to V72

of an inch. It is worth

noting that the size is

determined by the

height from the

bottom of the

descender to the cap

height with a little

extra space, and not

just the measurement

of an uppercase letter.

as is often the

misconception.

POINT SIZE

O r \J I IN I abcdcfghijklmnopqrstuvwxyz

ABCDEFGHIJKLMNOPQRSTUVWXYZ 12345678 &%!-{)

O rUIN I abcdefghijklmnopqrstuvwxyz

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1 23 t567890.,?":;&%!-{]

10 POINT abcdefghijklmnopqrstuvwxyz

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890.,?":;&%!-
1 J

12 POINT abcdefghijklmnopqrstuvwxyz

ABCDEFGHIJKLMNOPQRSTUVVVXYZ 1234567890.,?":;&%!-{

}

16 POINT abcdefghijWmnopqrstuvwxyz

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890.,?":;&%!-{}

18 point abcdefghijklmnopqrstuvwxyz

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890.,?":;&%!-{}

24 point abcdefghijklmnopqrstuvwxyz

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567

3 6 po.nt abcdefghijklmnopqrstuvwxyz

ABCDEFGHIJKLMNOPQRSTU
48PO.NT abcdefghijklmnopqrstuv-wxyz

ABGDEFGHIJKIJVENOPQ
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descriptions and font classifications Continued

nat influence the

look ^n of any typeface.

.vay m which the

proportions of letterforms

proportions of letterforms are an

imp jmponent when designing

and using typography There are four main

nfluence typographic propor-

t is the ratio of stroke width

e height of the character The second

5t between the thickness and

iess of the stroke weight Third is the

proportion of the x-height to the height of

STROKE-TO-HEIGHT RATIO

the capital letters, ascenders, and descen-

ders. The final factor influencing propor-

tion is the width of the letterforms.

stroke-to-height ratio

Roman letterforms are based on charac-

ters found in Roman inscriptions. When

the glyphs are analyzed they are found to

be around ten times as high as their stroke

weight. Any variation of this ratio will have

the effect of making letterforms bolder or

lighter. The proportions of any font can be

difficult to get right. They have to look cor-

rect optically, rather than mathematically.

The function of the font may also play a

factor in this relationship. A display font

can break with several conventions for the

sake of design, while a text face must

obtain the optimum proportions to retain

maximum legibility.

contrast in stroke weight

Original typeforms were based on the cal-

ligraphic penmanship of the Renaissance

period. Since the pens had a flat edge, they

created thick and thin strokes as the pen

travelled around the letterform. Such vari-

ation within the contrast of a stroke is usu-

ally referred to as "stress." The pen pro-

duced angled stresses and, as such, the nib

ABCDEFG ii Garamond is

shown here, which

has relatively tall and

elegant proportions.

- Baskervill

moc ABCDEFG
»

proportion* o*

%ttotr

pronoun-

those of (!

shown or

<< I he H.iskerville

li Mi rfuim r, '.lightly

wider than that of the

Garamond; it has

more coi trasi

betwi enH Moke

\<ujlli\ II r. il-.n

|y shorti i



descriptions and font classifications

was used to create asymmetric letter-

forms. As typefaces have progressed, the

influence of the pen has declined and

stresses have now all but disappeared.

Most sans serif typefaces today have an

almost completely even stroke weight. To

balance the font optically, however, the

horizontal strokes are normally drawn

slightly thinner than the vertical ones.

x-height and proportion

The relationship between the x-height and

the height of caps and ascenders and

descenders can have a profound effect on

a font. Some fonts have a very large x-

height-to-ascender ratio making the font

STROKE WEIGHTS

appear larger at specific point sizes. The

reason for this is that the body of the type-

face covers more space. Other fonts that X-HEIGHT
have a longer ascender and descender

compared to their x-height will appear

smaller at the same point size. ^^" ^W^
As a rule, choose a typeface with longer ^^L^^

ascenders and descenders for text type. ^L

The longer stems allow for better recogni- f ^^L

tion at smaller sizes. It also means that MfAm *JKRkm

short, stubby stems do not become invisi-

ble when reduced in point size. Conversely,
2 It is a common serif faces such as

display type works well with a larger x- misconception that Helvetica, shown here

height-to-cap-height ratio. Here, the fonts of the same size on the right, have a

, ... all conform to the much larger x-height
shorter ascenders and descenders will samex.heightYou and shorter ascenders

work just as well as longer ones. often find that sans and descenders.

hamburgerfont
hamburgerfont
hamburgerfont

hamburgerfont

ii You can see in the

fonts shown here the

difference in stroke

weights between

typefaces. From top

to bottom, Futura

has a fairly uniform

stroke width, whereas

Optima has more

contrast within the

stresses of the shapes.

Bodoni has the largest

contrast of all, ranging

from hairline serifs

to broad strokes and

stresses within the

loops. VAG rounded

at the bottom has a

consistent thickness

to its stroke.



the complete guide to digital type

descriptions and font classifications continued

numerous

weights and illowing the designer

.vithin a

* t'pographically based design.

extended and condensed styles

portions of letterforms can be

imaticaily by making them

45

more extended or condensed. When choos-

ing these kinds of fonts, consider their

function carefully. Condensed letterforms

are useful when setting fonts within a lim-

ited amount of space—for example, when

used in a newspaper. Extra-condensed

fonts, however, require more work on the

part of the reader to recognize and read.

univers

46

univers

47

FRUTIGER'S GRID

The Fi u1 shows

type width and weight

relationships Th<

ranges from 30 (the

narrowest face) to over

80 (the most extended)

Roman faces are given

by odd numbers, italics

by even.

univers

48

univers

39

univers

49

univers

53

univers

55

univers

56

univers

57

univers

58

univers

59

univers

63

univers

65

univers

66

univers

67

univers

68

univers

73

univers

75

univers

77

univers

83

univers

2 - grid

• ••

ighout ii"

Frutl|

type families and Frutiger's grid

a type family I 10 dlei tlon o1 F< mts, .ill of

which are based on the same proportions

and design, but with .1 wide ranging set

uding everything from umdensed to

nded and llghl to heavy,

rhe type designer, Ad nn 1 I ml i|>i 1 tii vel

oped a grid to '.how the variations ol font!

with ' family In 1 onjuni tion with a

,
t '-r n in this system, the Inert

1

ten Indii ate the weight ol the



descriptions and font classifications

font, the single figure increases the width,

with odd numbers for roman fonts and even

numbers for italic.

Frutiger's font, Univers, designed in 1957,

was the first to apply this grid. Originally,

the font had 21 variations in five weights

and four widths. The font family has since

been added to and now includes more than

50 fonts, increasing the choice for the

designer immeasurably.

Using just one extended type family

such as Univers achieves a sense of clarity

and uniformity within a design. This leads to

clear, consistent communication with the

least number of variables to detract from

the information.

Many designers restrict themselves to

just two type families per project for

exactly this reason. It is far more visually

pleasing to the eye to use several variations

of one typeface, than to use several differ-

ent, unrelated fonts.

There are now a growing number of

typefaces that have multiple variations

within a family, and these include typefaces

such as, Futura, Rotis, Frutiger, Optima, and

Meta. Most type designers recognize the

demand and need for such families and pro-

duce different weights and widths as a

result of this.

ABCDEFGHUKLMNOPQRSTUVWyZ 1 234567890, ?":;&%!-{}

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890. ?":;&%!-{}

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890., ?":;&%!-{}

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890., ?":;&%!-{}

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890.,?":;&%!-{}

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890., ?":;&%!-{}

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890.,?' :;&%!-{}

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890., ?":;&%!-{}

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1 234567890.,?":;&%!-{}

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890., ?":;&%!-{}

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890.,?":;&%!-0

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890., ?":;&%!-{}

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890.,?":;&%!-{}

ABCDEFGHIJKLMNOPQRSTUVWXYZ 1234567890., ?":;&%!-{}

ii As you can see

here, a type family

provides a wide

variety of weights

and widths within a

typeface. These can

be used for a variety

of jobs to create

emphasis or enforce

hierarchy with a

given design.

t
A HISTORY OF

I TYPOGRAPHY

ANATOMY OF
I A TYPEFACE

• TYPE AND FONTS

• REVIVING HISTORICAL
FONTS

12

28

i 56
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the digital age
The digital age has brought with it a newfound freedom in typography, allowing

typographic design to push the boundaries of legibility and visual esthetics.
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The advent of the

computer has made

huge changes within

the graphic design

industry. Once the

realm of the skilled

typographer, the

computer has put

type into the hands

of anyone with a

PC. Now type can

be generated,

manipulated, and

output directly from

the desktop.

T
nas revolutionized the

e introduction of the

-4. brought about the

itroduction,

penetrated every aspect

•ne beg ,nariessuch

as April Grr zed the full

potential of* ;^ magazine

also used it not c ate page lay-

:rsigning

opedfc-' llm-

Such people understood that the com-

puter could give a designer a degree of

autonomy: he or she could now manipulate

imagery, design page layouts, and even cre-

ate typefaces for particular projects where,

previously, collaboration with a host of spe-

cialists would have been necessary

Designers like Neville Brody influenced

how the computer was viewed and har-

nessed by the design community. His publi-

cation, Fuse, allowed the experimentation

afforded by the computer to come to the

forefront of the design process

Type is no longer printed for large runs

using letterpress or phototypesetting. The

design industry embraced the new tech-

nology and utilized it to the fullest. Today,

we research via the internet, acquire

images and manipulate them digitally, and

create and manage typography at our own

computer work stations.

Such advances have opened up a debate

about the standards of graphic design.

People question whether this newfound

freedom has resulted in a decline in typo-

graphic standards in particular, since



the digital age

Q /"> CS Cyrillic Emigre Fonts

*
|
C
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+ 1 Onttp://www.emigre.com/encodecype.php?encC- - Q,-

Cyrillic Emigre Fonts

Emigre f hornc i f Orser '
f Cart '

f l-'asazire '
f t :rt; stersl rT-ShlrtsI f Books' fMlsc.1

The following fcrwgre fonts are available in Cyrillic format:

Mason serif Cyrillic Package

D Mac PostScript $95.00

Base Nine Cyrillic Package

B Mac PostScript $95.00
Base Nine Regular

n Mac TrueType $95.00

B Wlncows $95.00
Base Nine Italic

Base Nine BoldADD TO ORDER

Base 9 Bold Italic

OBBrge>K3UK/1MHO
npcmy<t>xuHUium>
blbri3K)flflrJBrilE)K

3MKAMH0nPCTy<DX
liMLUUibbl bT.3 K) 8

Deac History Cyrillic Package

B Mac PostScript $65.00

Dead History Roman

B Mac TrueType $65.00 Dead History Bold

a6BrAcx3MKJiMHon
pc r y <b x uh uj ui bbi b

HDD TO ORDER

rt3K)5iABBrAE>K3
MKJlMHOnPCTYOX
UHlillU bblb Fi3rOfl

Exocet Cyrillic Package €X©C€+ LIGH +

B Mac TrueType $65.00

G wirtcows $65.00

€X«C€+ H€AVY

1 HDD TO ORDER ABBrAC*3MKA
MH©nPC + Y0Xll
HUIUl'bblb"k3KDJl

ABBrAC*3MKA
MHenPCTYOXU
MUIUl'bblbT13KDfl

rriMsoii Serji

almost anybody can now use a computer

to produce a piece of "graphic design."

Should the unskilled be allowed to do this?

Whatever your view, the digital age has cer-

tainly transformed graphic design for the

better and produced some visually stimu-

lating work over the last 20 years.

Today's designers constantly have to

learn new skills in order to keep up to date

with the latest hardware and software. It is

important to know which software to use

for a particular function, and most designers

use image-manipulation packages, such as

Adobe Photoshop, a vector-illustration

package, such as Adobe Illustrator or

FreeHand (the latter formerly made by

Macromedia), and a page layout package,

such as QuarkXpress or Adobe InDesign.

Digital typography has come a long way

since 1984. You can buy and download fonts

over the internet. Individuals now find it

much easier to design their own fonts with

the introduction of software such as

FontLab or Fontographer (both made by

FontLab). They can even market and sell

their fonts via a website. Copyright is

always a problem, as digital formats are

easy to copy and pirate. In typographic

terms, it is not only essential to know one

type format from another, but also how to

use it legally.

t TYPE MANAGEMENT SO

THE TOOLS 140

DESIGNING PIXEL FONTS I7O

GENERATING FONT FILES

AND USINC FONTS 186
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type formats
Fonts are used on every computer—whether an Apple Mac or a PC—and all designers need

to know how to use them.

Toer of type formats

• all users.

jc and PC fonts have

th each other PC

'ac ones another.

regardless of whether they were PostScript

eType.

: '.s are described below,

• on on how the tech-

nology- the growing num-

ber and f OpenType formats.

Typography has. at last, a universal format

everyone can use. regardless of operat-

or computer language.

PostScript Type i

The PostScript format, devised by Adobe,

involves a file with two parts. The first part

is the bitmap data for on-screen represen-

tation of the font. The second, and outline,

file contains information for output on a

printer. The operating system uses the out-

line file to accurately render the font's let-

terforms at the printing stage. It relies on

outlines generated via bezier curves; these

are then converted to bitmaps appropriate

to the resolution of the printer for a greater

degree of accuracy. This format requires a

separate outline file for every font within

the typeface—regular, italic, bold, and bold

. for example The latest operating sys-

tems have built-in rasterizers to read the

vector information contained within the

file and produce more accurate and better-

looking glyphs on screen. The older versions

will require the addition on Adobe Type

Manager (ATM) Light to be installed in

order to produce a more accurate screen

display of a font.

TrueType

TrueType is format that was developed

jointly by Apple and Microsoft to rival

TRUETYPE FONTS POSTSCRIPT FONTS OPENTYPE FONTS

04C.O*

f
TTF

m
Uwidnk

0*411 *,-

i

im»
w

C» -.-*». 19*9 20
17

unburn Preview

' hiutrrtomi
- blkeBTIU \
' BaikeBTRom

v
-

FFIL

Nim. Uiterville Rm/M

Kind Font SuiKaw

ilH Ml Klondllk
i!4f t9t byien

i Tueiday JO
November 1990 It

2 PostScript fonts Modified Tuetdjy in

differ from TrueType November 1990 16

11

m that they have two VXIKWI 1 09 I 1911 90

n order to render
I.ulrejm Ine

0011.0011.0012.00

them correctly—the
M
•mtrejm Type

eand printer UhvyU

font If both these

files are not placed In

the operating system,

the font will be

bitmapped or jagged

when viewed on

screen or printed out

Shaker 2 Botf

Shake r2BI oil

Shaker2H oil

9ukar2M oil

Shaker2lotl

Shaker2l otf

' Shakei^R oil

' Shakei/XB oil

' Shaker2XBIol(

1 OpenType fonts

were developed

by Adobe and

Microsoft as a

response to TrueType

incompatibility

problems between

Macs and PCs.

OpenType fonts use

Unicode-based

character coding

to extend the

TrueType format

across all platforms

V
OTF

Name Shaker2Uotf

Kind OpenType font

Slit 220 Klondllk
1222 lOBbvmi

Created

Modified Thursday 7 July

2005 21 S4



type formats

Adobe PostScript Type i. The character set is

based on Unicode and the fonts combine

both vector and bitmap data for screen

drawing and printing within one file,

known as a suitcase. It works on a similar

principle to PostScript but uses quadratic

as opposed to bezier curves. This allows

them to be scaled infinitely with no loss of

detail. Both the operating systems for the

Macintosh and the PC have TrueType raster-

izers built in, to allow the accurate repre-

sentation both on screen and at the print-

ing stage. The advantage of using TrueType

over PostScript formats is that they will

print more successfully using some of

the cheaper printers available and so are

better suited to the amateur designer or

home user.

iiiiiir''iii'
'
"•••'•"'•'

M

OpenType

OpenType was developed by Microsoft and

Adobe and launched in 1997, and is currently

gaining popularity within the type industry.

The advantage of this format is that it is a

single cross-platform file: it can contain

both PostScript and TrueType outlines. It is

based on the Unicode encoding standard

and can therefore have an expanded char-

acter set that includes small caps, ligatures,

swashes, and any other variations. The font

could also theoretically include characters

from Greek, Cyrillic, and Latin, producing a

multilingual font within a single file. The

possibilities for this format are far reach-

ing. All that remains now is for software to

incorporate a provision for its use. InDesign,

being an Adobe product, allows the use of

OpenType formats, whereas, at the time of

writing, QuarkXpress does not.

i The current crop

of desktop computers

are powerful and have

the ability to handle

many high-definition

applications with

relative ease.

Adobe software,

such as Illustrator and

Photoshop, supports

OpenType formats,

meaning that a

whole host of

specialist glyphs are

now available in one

type file.
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Typography is a craft like any other. While once the

province of skilled typographers, the digital age has

allowed all designers to take control of their text.

Despite the ease with which typography can now be

generated and manipulated, the basic "rules" are the

same now as they have always been. This chapter

looks at the uses of typography and the principles that

govern clear communication. It shows how to avoid

some common mistakes and looks at how to lay out

text within grids to obtain the most legible results.
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type and fonts
Like all aspects of design, typography has to be learned. It has its own set of rules and

conventions that allow it to be used to its full potential.

I e most out of typography,

I :andtheter-

nces between type-

xabulary results

• on and allows

and use the most

JD.

Over the years, the definitions of the ter

typography have

ised. Before the advent of the

CARAMOND 12 & 24PT

rem ipsum dolor mi amel

adipis i m.u dit sed

nummy nibh euismod

unci unt ut laoreel dolore

1 aliquam eral \<>lu tpal

: minim veniam,

si rutl utx m
use ipn lobortis

nisi ul aliqui] immodi >

Lorein ipsum
dol< >r sit amet

elil seddiam

digital age, the terms type, font, and type-

face had distinct differences. Today these

differences are less clear. "Type" was used to

describe the object itself—a piece of metal

with a reversed, raised character on one

side meant for the purposes of printing.

"Font" (sometimes spelled "fount") refers to

the set of characters of a particular type-

face. These would be of the same style and

size. A "typeface" refers to a set or related

BEMBO 12 & 24PT

I orem ipsum dolor sit .unci

1 onse< tetuer adipis < ing elit sed

diam nonummy nibh euismod

rind unt ut laoreel dolore magna

aliquam erat volu tpat. I !

i vi isi

enim ad minim veniam, quis nost

rud c-xti 1 1 cation ullam< orper

suscipit lobortis nisi ut aliquip ex

ommodo < onsequat.

Lorem ipsum

dolor sit amet

elit seddiam
.oth t - Bcmbo

Man/ , >6 to

1 Bern bo's

book DeA-

Bern!

•or

family of fonts. This applies to italic, bold,

and bold italic versions of a font

In addition to this are the classifications

of display and text faces. Traditionally, any

type 12 point and under can be described as

text type 1 Ins type is usually used for body

copy, or any text used for continuous read-

ing of large amounts of information.

Conversely, type sizes above 12 point are

known as "display" or "headline" type. These

TIMES 12 & 24PT

I oivm ipsum dolor sit amet

consectetuer adipis cing elil sod

diam nonumim nibh euismod Unci

tint ut laoreel dolore magna

aliquam erat volu tpat. Ul wisi

enim ad minim veniam, quis nost

rud exerci tation ullamcorper

suscipit lobortis nisi ut aliquip ex

ea commodo consequat.

Lorem ipsum

dolor sit amet

elit seddiam
± l urns Roman was Morison. It was

designed i' intended, and used,

ihi Times newspaper for both headline

in London, England, by and body copy and

'"•r .Hid type was defined by

Classical forms.



type and fonts

are usually used for titles, headlines, sig-

nage, or any text that tries to grab atten-

tion at large sizes.

Body copy has to take many other fac-

tors into account. Text to be used for printed

purposes at small sizes requires a certain

amount of attention to detail in the design

and selection of the font. Stanley Morison

agreed with this by commenting that for

a typeface to be successful, it must be

HELVETICA 12 & 24PT

Lorem ipsum dolor sit amet

consectetuer adipis cing elit

sed diam nonummy nibh

euismod tind unt ut laoreet

dolore magna aliquam erat

volu tpat. Ut wisi enim ad

minim veniam, quis nost rud

exerci tation ullamcorper

suscipit lobortis nisi ut aliquip

ex ea commodo consequat.

Lorem ipsum
dolor sit amet
elit seddiam
i The Neogrotesque

face, Helvetica, was
designed in 1959 by

the Zurich-born type

designer Max
Miedinger. Originally

known as Haas-

Grotesk, Helvetica

became the most

widely used typeface in

the world by the end

of the 20th century.

transparent and go completely unnoticed

by the reader. Our awareness of the means

by which a message is transmitted only

diverts attention from the real meaning of

the message being communicated.

A typeface has its own personality or

"tone of voice." The qualities of the font

lend themselves to particular functions

due to the nature of the design of the let-

terforms. We choose to use certain fonts

GILL SANS 12 & 24PT

Lorem ipsum dolor sit amet

consectetuer adipis cing elit sed

diam nonummy nibh euismod tind

unt ut laoreet dolore magna

aliquam erat volu tpat. Ut wisi

enim ad minim veniam, quis nost

rud exerci tation ullamcorper

suscipit lobortis nisi ut aliquip ex

ea commodo consequat.

Lorem ipsum

dolor sit amet

elit seddiam

because of the values they communicate to

the reader or viewer. They can be strong,

bold, forthright, whimsical, distressed,

futuristic, common, or utilitarian, among

many other personalities. Serif faces have

more in common with traditional or luxury

values, having a sense of history and

integrity to them. Sans serifs are modern

and uniform and so lend themselves to

more functional purposes.

FUTURA 12 & 24PT

Lorem ipsum dolor sit amet

consectetuer adipis cing elit sed

diam nonummy nibh euismod

tind unt ut laoreet dolore magna

aliquam erat volu tpat. Ut wisi

enim ad minim veniam, quis

nost rud exerci tation

ullamcorper suscipit lobortis nisi

ut aliquip ex ea commodo

consequat.

Lorem ipsum

dolor sit amet
elit seddiam

± Gill Sans was

designed by Eric Gill

in 1931 and based on

Edward Johnston's

face for the London

Underground. Due

to its pleasing

proportions and open,

rounded counters, it is

still widely used for

both display text and

body copy.

± Designed ir 1927

by the German

artist Paul Renner,

Futura took its

inspiration from the

Bauhaus arts

movement and

geometric forms. Its

success relies en its

simple construction,

which is functional

and friendly.
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principles of good practice

Good practice relies on a set of conventions that have been built up over time. If adhered

to. these conventions create more legible and credible results.

I

designer and founder of

MetaDt Spiekermann. wrote that

he wanted to be a Minister of Typography

The reason for this was that he had noticed

the rise of computer technology.

- honored art of typography was

being practiced by anyone and everyone.

The results he found were ugly and an insult

to his typographic sensibilities Since his

tenal role was not going to come into

being, his advice was that there was only

one way to achieve high standards within

typographic design, and that was to look,

and practice

Although Spiekermann's desire to govern

typography is a little extreme, his reasoning

is sound.Typography has numerous subtleties

that cannot be be automatically understood

just because the user can use a keyboard. It

takes time to understand the craft and to

implement typography that communicates

a message while still looking good. The key is

to understand the problems that can arise

when using type and not just relying on the

computer's default settings. A good typogra-

pher will consider the function and meaning

of the type and set text with that in mind,

altering the control measurements to suit

Over time a set of typographic conven-

tions have been set up to ensure that

use of typography is competent and consis-

tent. However, these rules are not definitive

but provide a framework within which clear

graphic design can be achieved. These rules

can be broken and in doing so may provide a

meaningful message within itself. If you

understand the rules then you can judge

when it is best to break or disregard them

altogether to effectively achieve the desired

message or idea. However, for the most part,

these rules are for the benefit of everyone

using typography. They provide for clear and

concise text that communicates succinctly,

while looking visually attractive.

Digital technology provides designers

with a wealth of permutations at their fin

gertips, needing only the click of a mouse

button. It is very easy to become seduced by

DEFAULT SETTING

Suspendisse at enim In mattis. arcu

at lacmia convalhs. massa justo laor

'•llus. non consectetuer purus
velit et felts Quisque pellentesque.

Nunc gravida tmcidunt nisi Vestib

ulum quis enim Fusee nulla ante,
• que eu. vulputate eget. semper

sed mi In tempor diam vel sem.
Maecenas aliquet, tellus eu sceler

isque pellentesque. arcu ante sagittis

magna m posuere ipsum nsus sit

ame'

i

tot leadinf

intoacax<-

brtv.'

Proportw

may vary from I

to face, even though

they havr *

point size Always

alter the settings to

e job at hand

Z Here, you can see

that the default

settings for CHI Sans

look very different to

those for Helv

is Gill Sans has

a smaller x-height

Resetting the default

settings to take

account of this

nee results in

better proportions

Suspendisse at enim. In mattis. arcu at

lacmia convalhs, massa justo laoreet

tellus. non consectetuer purus velit et

felis. Quisque pellentesque. Nunc gravida

tmcidunt nisi.Vestibulum quis enim.

Fusee nulla ante, tristique eu, vulputate

eget, semper sed, mi. In tempor diam vel

sem. Maecenas aliquet, tellus eu

scelensque pellentesque, arcu ante

nagna, In posuere ipsum nsus sit

amet mi.

Suspendisse at enim. In mattis, arcu at

lacinia convallis, massa justo laoreet

tellus, non consectetuer purus velit et

felis. Quisque pellentesque. Nunc gravida

tincidunt nisi.Vestibulum quis enim.

Fusee nulla ante, tristique eu, vulputate

eget, semper sed, mi. In tempor diam vel

sem. Maecenas aliquet, tellus eu

scelerisque pellentesque, arcu ante

sagittis magna, in posuere ipsum risus sit

amet mi.

± in tins example,

the text has been

standard body copy,

whic h IS designed to

be read as one piece,

Hi i .in cause

IHolili in', foi the

n ,nli i H I. ap-

portions of text are

i this way, the eyes

get tired.



principles of good practice

AMAC FONT CHICAGO

Lorem ipsum dolor sit amet
conse ctetuer adipis cing elit

sed diam nonummy nibh

euismod tind unt ut laoreet

dolore magna aliquam erat

uolutpat wisi enim ad minim.

CLASSIC FONT UNIVERS

Lorem ipsum dolor sit amet conse

ctetuer adipis cing elit sed diam

nonummy nibh euismod tind unt ut

laoreet dolore magna aliquam erat

volutpat wisi enim ad minim.

CLASSIC FONT GARAMOND

Lorem ipsum dolor sit amet conse

ctetuer adipis cing elit sed diam

nonummy nibh euismod tind unt tit

laoreet dolore magna aliquam erat

volutpat wisi enim ad minim.

ii In these examples,

you can seethe

difference between

using system fonts

such as Chicago and

classic fonts such as

Univers and Garamond.

Designed for reading

continuous text in

print, classic fonts

EMPHASIS 1

have considered

proportions and

spacing. Chicago was

designed to be viewed

on screen. It has none

of the subtleties of

the classical fonts and

proves hard on the

eye when reading a

lot of body copy.

Lorem ipsum dolor sit amet

consectetuer adipis cing elit sed

diam nonummy nibh euismod tind

unt ut laoreet dolore magna
aliquam erat volu tpat. Ut wisi enim

ad minim veniam, quis nost rud

exerci tation ullamcorper suscipit

lobortis nisi ut aliquip ex ea

commodo consequat.

± In this example,

you can seethe use of

several fonts to create

emphasis. This is

confusing for the

reader as they do not

work in harmony with

the rest of the copy

and there seems to be

no reason why a

different font is used

for each word.

EMPHASIS 2

Lorem ipsum dolor sit amet

consectetuer adipis cing elit sed diam

nonummy nibh euismod tind unt ut

laoreet dolore magna aliquam erat

volu tpat. Ut wisi enim ad minim

veniam, quis nost rud exerci tation

ullamcorper suscipit lobortis nisi ut

aliquip ex ea commodo consequat.

Lorem ipsum dolor sit amet

consectetuer adipis cing elit sed diam

nonummy nibh euismod tind unt ut

laoreet dolore magna aliquam erat

volu tpat. Ut wisi enim ad minim

veniam, quis nost rud exerci tation

ullamcorper suscipit lobortis nisi ut

aliquip ex ea commodo consequat.

i Do not choose

typefaces that are too

similar, such as

Helvetica and Futura

(top). The similarity

means that the reader

can often miss the

difference. It is better

to use an italic version

of the same font

(Helvetica) to create

emphasis (below).

the options available. It is much more diffi-

cult to represent the thoughts of the

author and create beautiful, legible typog-

raphy.The best typographers are those who

express the meaning of the text while still

retaining its legibility and making it appear

visually stimulating.

The following "rules" are meant to

reflect the principles of good practice.

Many of them are common sense, others

are the result of years of typesetting expe-

rience and problem-solving. These prob-

lems may occur due to the construction of

the type or the nature of how information

is best presented in order for readers to

retain it. All the rules are designed to retain

the integrity of typographic information as

presented, by whatever means.

font selection

It is often better to use a classical typeface

with a proven track record. These fonts have

consistency within their characters and

have legible proportions that aid the read-

ing process and produce more legible pas-

sages of textual information.

When trying to create emphasis within

a piece of text or separate sections, it is

advisable not to use too many typefaces at

one time. If too many are used, the reader

becomes confused and is unable to deter-

mine what is important and what is not.

There is no clear hierarchy.

When considering emphasis within a

sentence, try to avoid using a typeface that

is too similar in appearance to the main

face. This often looks like a mistake. Strive

for contrast within the text. Use a font that

appears very different—a serif as opposed

to a sans serif or alternatively, use an italic

version of We same typeface for a more

subtle approach.
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principles of good practice continued

sizes, hierarchies, and weights

e choice.

s best to

the design of

•i. Throwing in

everything onry confuses the reader and

rmation presented.

>e text sizes that range

between 8 and 12 point for body copy.This can

be easily read from an average distance of

r>es (30~35cm) These point sizes

have proved to be more legible and comfort-

able for the reader it is important to realize

•ypefaces of the same size may visually

appear larger or smaller, depending on their

grit

To establish clear hierarchy within

typography, avoid using too many different

type sizes and weights at the same time

it is easier for the reader if there is clear

differentiation between all the sizes, but

too many only serves to confuse and cre-

ates a cluttered design. Exercise restraint

and use only two or three font sizes to

maintain functional and esthetically

attractive designs.

For text type, avoid using typefaces t

are too light or too heavy. A font that is too

light cannot be easily distinguished fi

its background; a font that is too heavy is

less legible, as the thickness of the stroke

diminishes the size of the counterspaces,

making the letterform less recognizable.

Typefaces that have a book weight strike a

balance between these extremes and are

more suited to text type.

As a general rule, don't use condensed or

extended faces for body copy. For the letter-

forms to be easily recognized, the space in

and around the letters is crucial at small

sizes. Distorting letters by altering the pro-

portions means the letters do not appear

familiar to us and so retards our ability to

instantly read them. Some type families

may include extended or condensed fonts

whose proportions fall within accepted

proportions, but even these are best avoided

for large amounts of body text.

OPTIMUM SIZES FOR BODY COPY

» •; on the

nght has been set in

ring

between 6 and i6pt

You can see that the

6pt type on the top

too

the

i6pt type on the

bot"

too large to be read

• »We

MW

• I I J 1 1 r i mil

• ir I

nisi hi aliquip

hi. 1

.1111 1 m ti 11 11 1 1 1 r i\ 111U1

1 lolon

olu tpai I 1

1 nil

ipil llllr

1 .1 iicu 1 ipsum doloi mi .unci consectetuer adipis cing

t-lii sed diam nonumm) nibh euismod tind unl ul

laoreel dolore magna aliquam eral volu tpat. I'i wisi

ciiiin .ul minim v< iii.uii. < jui^ nost rud exerci tation

1 ill. u in hi pci suscipil lobortis nisi ut aliquip ex ea

( ommodo < onsequat.

Lorem ipsum dolor sii amel
< onsectetuer adipis cing elii scd diam
nonumm) nibh euismod tind unl ut

laoreel dolore magna aliquam eral volu

tpat. I 1 wisi enim ad minim veniam,
(|uis nosi vw(\ exerci tation ullamcorper

sus( ipit lobortis nisi ul aliquip ex ea

(
1 iiiimodo consequat.
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TYPE HIERARCHY

passage title

Lorem ipsum dolor sit amet

consectetuer adipis cing elit sed diam

laoreet dolore magna aliquam erat volu

tpat. Ut wisi enim ad minim veniam, quis

nost rud exerci tation ullamcorper

suscipit lobortis nisi ut aliquip ex ea

commodo consequat.

subheading

Lorem ipsum dolor sit amet

consectetuer adipis cing elit sed diam

nonummy nibh euismod tind unt ut

laoreet dolore magna aliquam erat volu

tpat. Ut wisi enim ad minim veniam.

passage title

Lorem ipsum dolor sit amet

consectetuer adipis cing elit sed diam

laoreet dolore magna aliquam erat volu

tpat. Ut wisi enim ad minim veniam, quis

nost rud exerci tation ullamcorper

suscipit lobortis nisi ut aliquip ex ea

commodo consequat.

subheading

Lorem ipsum dolor sit amet

consectetuer adipis cing elit sed diam

nonummy nibh euismod tind unt ut

laoreet dolore magna aliquam erat volu

tpat. Ut wisi enim ad minim veniam.

<< On the left, the

size of the type has

been varied to create

hierarchy within the

type. Since the text

in the middle of

the sentence is the

same size as the

subheading text, this

can confuse the

reader at first glance.

The example on the

right uses bold to

denote a subheading

and italic to create

emphasis within the

copy. This results in a

clear way of reading

the text, letting the

viewer know what is

more important

within the type.

OPTIMUM WEIGHTS FOR BODY COPY

The Futura light

(top) is too pale to

be distinguished

from the background

for reading large

amounts of

continuous text. The

bold version of Futura

(bottom) is too heavy

and proves to be

tiring on the eye as

the counterspaces are

diminished, making it

very dark on the page.

The center example

set in Futura Book

has just the right

weight to be easily

recognizable from the

background, without

being too heavy.

Lorem ipsum dolor sit amet consectetuer

adipis cing elit sed diam nonummy nibh

euismod tind unt ut laoreet dolore magna

aliquam erat volu tpat. Ut wisi enim ad

minim veniam, quis nost rud exerci tation

ullamcorper suscipit lobortis nisi ut aliquip ex

ea commodo consequat.

Lorem ipsum dolor sit amet consectetuer

odipis cing elit sed diam nonummy nibh

euismod tind unt ut laoreet dolore magna

aliquam erat volu tpat. Ut wisi enim ad

minim veniam, quis nost rud exerci tation

ullamcorper suscipit lobortis nisi ut aliquip

ex ea commodo consequat.

Lorem ipsum dolor sit amet
consectetuer adipis cing elit sed

diam nonummy nibh euismod tind

unt ut laoreet dolore magna
_

aliquam erat volu tpat. Ut wisi

enim ad minim veniam, quis nost

rud exerci tation ullamcorper

suscipit lobortis nisi ut aliquip ex
ea commodo consequat.

Lorem ipsum dolor sit amet consectetuer adipis

cing elit sed diam nonummy nibh euismod tind unt

ut laoreet dolore magna aliquam erat volu tpat. Ut

wisi enim ad minim veniam, quis nost rud exerci

tation ullamcorper suscipit lobortis nisi ut aliquip ex

ea commodo consequat.

Lorem ipsum dolor sit amet
consectetuer adipis cing elit sed
diam nonummy nibh euismod tind

unt ut laoreet dolore magna
aliquam erat volu tpat wisi enim ad
minim veniam, quis nost rud.

Lorem ipsum dolor sit amet
consectetuer adipis cing elit

sed diam nonummy nibh
euismod tind unt ut laoreet
dolore magna aliquam erat
volu tpat. Ut wisi enim ad
minim veniam, quis nost rud
exerci tation ullamcorper
suscipit lobortis nislut.

H The light

condensed version of

Helvetica (top) can

be difficult to read as

the lack of space

surrounding the

letterforms makes

it more difficult to

distinguish word

shapes. This is also

true of the extended

and bold extended

versions (center and

bottom), as the more

space a word takes

up, the fewer words

per line, which slows

our ability to read a

comfortable amount

of words per line.
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principles of good practice continued

working with text in layouts

how to choose a

•Me the

^pacing, and

either upper- or

lowe

do not set body

•s—this hinders the

speed at whi in read. A combination

ise letters provides a

•• - rea : it e ;iece of typography. This is

because we recognize word shapes, not

the pattern of ascenders

and des rovides an easier way of

recognizing the words and so aids legibility

How play text is normally only

used in small amounts, you can use upper-

case text successfully. It may require some

extra word spacing or tracking to make it

more visually appealing. Typefaces are nor-

mally kerned so that you can use combina-

tions of upper- and lowercase letters, not all

capitals. As a result, type made up of capi-

tals only can look squashed.

Always use consistent letter- and \a

spacing to produce an even tone of text on

the page. Ifyou increase letter spacing for any

reason, you should increase word spacing or

tracking proportionately. This will result in an

even flow to the text, aiding legibility

For best results, use an appropriate line

length, or "measure." This is normally 8-10

words per line. Lines that are too short or

too long impede reading. Short lines inter-

rupt the flow of text and cause the eye to

tlu k back and forth. qui< kly tiring the read-

is can cause problems, too, in

that as the eye travels over the course of

the line, it ha^ diffu ulty lo< Jting the begin-

ning of the next one.

Use appropriate leading or line spacing

for text type so as not to break the flow from

one line to the next type with too lit tic lr.nl

ing slows reading as the eye takes in infor-

ion from more than one line at a time. To

improve legibility, add 1-4 points of space

between lines, depending on the x-height of

the typeface chosen.

CAPITALS & UPPER- AND LOWERCASE TRACKING

i \l IPSI M lx »l 1 >k SI I Wll l ( < >NSE< I I.I l ER

VDIP1S4 ING MM VENEAN LA< l\l\ M II \ M \<

VTIAEERATEl II RPIS RHON< US NON1 MMY SED

I K.i I \ PI Dl III (,l\l IN I RINGILLA NON, Vl\ IK

PR \l SEN I PED1 < 1 R M'.l I l R

MEXUS I 1 1 \\! liv IDI \ I I mi' » SED V ENENA1 Is

I Dl I PI RJ S DIGNISSIM H )KI< )K \ \ I l.l'l

I \l I PI RUS II I is \l \l QUE II I M'.I.K*

)

PHASI I I
\s lx )| c IR 1 1 IPSI \l < )l IS< )\ l

PI I I I \ l I
m ii

I 1 RNA SI I Wll I GR \\ M)\ S< )l I I' I

III II I I >NSI I II II I

• In.

.1 pii 1 hom u nonum

rra orci

I n lint I'lnni. odio 1 'I

nlpulali pui

Ii mi

mi ipsum iluloi sii .t 1 1 it -1 1 onset tetuei adipiscing elit. Aeneaa

lacinia nulla. Nun< vitac era! eu mi pis rhoncus nonummy. Sed

ligula pcd< feugial in fringilla non viverra nun orci. Praesenl

pedi ( urabitui metus.

Lorcm ipsum doloi sil amel consci t( tu< 1 adipiscing elit, Aenean

lacinia nulla, Nuni vitai eral eu turpis rhoncus nonummy Sed

ligula |" di l' ugial in fringilla non viverra non on i. Praesenl pedcj

( urabitui mctus,

n
shapes

of I' 'mg

mly

ird

shape are hardi

w

X Ini reaslng

reducing the an

and

' words

—

ilso

makes it more

jlffli uii to rei ognlze

hapes and

Ii r reading.
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OPTIMUM LINE LENGTH

Lorem ipsum dolor sit amet, consectetuer adipiscing elit.Aenean lacinia nulla. Nunc vitae erat eu turpis rhoncus nonummy. Sed ligula pede.feu-

giat in, fringilla non, viverra non, orci. Praesent pede. Curabitur metus. Etiam tincidunt, odio sed venenatis ornare, dui purus dignissim tortor, a

vulputate purus felis at neque. Ut libero. Phasellus egestas dolor eu ipsum. Quisque pellentesque, urna sit amet gravida sollicitudin, eros mi con-

sectetuer mauris, malesuada eleifend augue nibh vitae justo. Donee volutpat dui id tortor. Ut mattis. Integer id lectus ut tortor adipiscing aliquam.

Nunc posuere massa sed urna ultrices volutpat. Class aptent taciti sociosqu ad litora torquent per conubia nostra, per inceptos hymenaeos.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit.Aenean lacinia

nulla. Nunc vitae erat eu turpis rhoncus nonummy. Sed ligula pede.feu-

giat in, fringilla non, viverra non, orci. Praesent pede. Curabitur metus.

Etiam tincidunt, odio sed venenatis ornare, dui purus dignissim tortor,

a vulputate purus felis at neque. Ut libero. Phasellus egestas dolor eu

ipsum. Quisque pellentesque, urna sit amet gravida sollicitudin, eros mi

consectetuer mauris, malesuada eleifend augue nibh vitae justo. Donee

volutpat dui id tortor. Ut mattis. Integer id lectus ut tortor adipiscing

aliquam. Nunc posuere massa sed urna ultrices volutpat. Class aptent

taciti sociosqu ad litora torquent per conubia nostra, per inceptos

hymenaeos.

Lorem ipsum dolor

sit amet, con-

sectetuer adipiscing

elit. Aenean lacinia

nulla. Nunc vitae erat

eu turpis rhoncus

nonummy. Sed ligula

pede, feugiat in,

fringilla non, viverra

non, orci. Praesent

ped bitur met.

LEGIBLE LEADING

Lorem ipsum dolor sit amet, con-

sectetuer adipiscing elit. Aenean

lacinia nulla. Nunc vitae erat eu turpis

rhoncus nonummy. Sed ligula pede,

feugiat in, fringilla non, viverra non,

orci. Praesent pede. Curabitur metus.

Etiam tincidunt, odio sed venenatis

ornare, dui purus dignissim tortor. a

vulputate purus felis at neque. Ut

libero. Phasellus egestas dolor eu

ipsum. Quisque pellentesque, urna sit

amet gravida sollicitudin, eros mi con-

sectetuer mauris, malesuada eleifend

augue nibh vitae justo. Donee volutpat

dui id tortor. l
!

t mattis. Integer id lec-

tus ut tortor adipiscing aliquam. Nunc

posuere massa sed urna ultrices volut-

pat. Class aptent taciti sociosqu ad lito-

ra torquent per conubia nostra, per

inceptos hymenaeos.

Lorem ipsum dolor sit amet, con-

sectetuer adipiscing elit. Aenean

lacinia nulla. Nunc vitae erat eu turpis

rhoncus nonummy. Sed ligula pede,

feugiat in, fringilla non. viverra non,

orci. Praesent pede. Curabitur metus.

Etiam tincidunt, odio sed venenatis

ornare, dui purus dignissim tortor. a

vulputate purus felis at neque. Ut

libero. Phasellus egestas dolor eu

ipsum. Quisque pellentesque, urna sit

amet gravida sollicitudin, eros mi con-

sectetuer mauris. malesuada eleifend

augue nibh vitae justo. Donee volutpat

dui id tortor. Ut mattis. Integer id lec-

tus ut tortor adipiscing aliquam. Nunc

posuere massa sed urna ultrices volut-

pat. Class aptent taciti sociosqu ad lito-

ra torquent per conubia nostra, per

inceptos hymenaei

i Lines of type that

are too long make

reading difficult as

the viewer can lose

his or her place. Lines

that are too short

can mean the rapid

movement of the

eye across the text

to digest the

information can be

very tiring. It is best

to aim for 8-10 words

per line.

Leading must be

carefully considered

when setting copy.

Too little leading and

the ascenders and

descenders of the

letterforms can touch,

making it difficult to

distinguish the word

shapes. Too much

leading can mean the

eye loses its place on

the return sweep

between lines.

Lorem ipsum dolor sit amet. con-

sectetuer adipiscing elit. Aenean lacinia

nulla. Nunc vitae erat eu turpis rhoncus
nonummy. Sed ligula pede. feugiat in,

fringilla non, viverra non, orci. Praesent

pede. Curabitur metus. Etiam tincidunt,

odio sed venenatis ornare, dui purus

dignissim tortor, a vulputate purus felis

at neque. Lit libero. Phasellus egestas

dolor eu ipsum. Quisque pellentesque.

urna sit amet gravida sollicitudin. eros

mi consectetuer mauris, malesuada
eleifend augue nibh vitae justo. Donee
volutpat dui id tortor. Ut mattis. Integer

id lectus ut tortor adipiscing aliquam.

Nunc posuere massa sed urna ultrices

volutpat. Class aptent taciti sociosqu ad
litora torquent per conubia nostra, per
inceptos hymenaeos.
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principles of good practice continued

text in columns and paragraphs

use of para-

problems that can arise

when p o columns

•iat legibility is better if

you gged right, type

justified text causes the

ng between words to be altered to fit

Dpy and so results in ugly rivers within

When using aligned left text, try to

eve consistent and rhythmic line end-

ings. Avoid strange and awkward looking

at occur when the default settings

RANGED RIGHT

ipsum dolor sii .in

idipis< in^ elil

u turpis

• (I ligula !>

fringilla non, • >n,

urabitui metus

n.ilis

IHSMIll lot1> l| .1

« | • i *
- I I

nil. i Ml

.Hi- itudin eros mi

i.l.i

ii id tortoi i i

Mr ,|

are used. For best results, a long-short-long

rag shape aids legibility. This can be

achieved by using line breaks within the

text (type Shift-Return) to shuffle the

text around without creating unwanted

paragraph breaks.

It is best to indicate any paragraphs

clearly but take care not to upset the visual

consistency of the copy. Indenting is the

most common way to do this, along with

adding space between paragraphs within a

piece of text. The rule is to indent the text

to the same measure as the point size; 12

point text requires an indent of 12 points.

JUSTIFIED

1 'inn ipsum dolor mi amet, ion

se< tetuei adipisi ing elil tenean

1. 1< mi.i nulla Nun< \ itae erai eu turpis

rhoncus nonumm) Sed ligula pede,

feugial m. fringilla non. viverra non

< ik 1 I'm. si in pede < urabitui metus

l ii. mi inic iduni 1 >» In 1 sed venenatis

oin. iic dui purus dignissim tortor, .1

vulputate purus felis ai neque 1
1

libera Phasellus egestas doloi en

ipsum Quisque pellentesi pic urna sii

.unci gra\ nl.i sollii itudin en « mi 1 on

mi 1 in. inns 111.1lcs11.nl. 1 eleifend

11 nilili \ itae justo I >< »ne< vi 'lnip.ii

dm id 101101 1 1 111. nil-. Integei id le<

ins in 1. irtoi . • 1

1

1 • 1
• ing aliquam Nuni

inn. 1 1 1 Ii 1 1< es \> din

i
item i.i< in w < i' isqu ad hi' 1

1.1 i< irqucnl pei c< mubia n< »tra, pei

ni' 1 mi 11. i' 1

fir) to achieve text without widows or

orphans as they create inconsistent text

blocks and interfere with the flow of read-

ing. They produce pages that look ugly and

ill-considered. By definition, a widow is a

very short line at the end or beginning of a

paragraph; an orphan is a single syllable on

one line at the end of a paragraph. The best

ways to avoid both is to either shuffle the

text around by looking at line endings and

adding line breaks, or to subtly change the

ti.iiking across the text by a minute

mi. nut 1 ins will rectify the problem with-

out affecting the appearance of the text.

RANGED LEFT

1 1 iMin ipsuni d< >lor sii amet,

consectetuei adipiscing elit, Aenean

I.k mi. 1 nulla, \iiin \ itae erai vu turpis

rhoncus nonumrm, Sed ligula pede,

feugial in. fringilla non. viverra non,

oui Praeseni pede. Curabitur metus,

1 n. mi inn idunt, 1 >di< 1 sed \ enenatis

ornare, dui purus dignissim tortor, ;i

\ ulputate 1
hums felis al neque. I ! t

hi >< m > Phasellus egestas di >li >i cm

ipsum, <,)iiis(|iK pellentesque, urna sii

amel gra\ ida sollicitudin, eras mi

( onset iii mi mi, inns malesuai 1

1

eleifend augue nibh vitae justo.

I )( iiic( volutpal dui id tortoi Ui

mi. mis Integei id le< ins nt tortor

adipusi in.", aliquam, Nun< i><
isuere

Mi.iss.i si .1 inn. 1 Minn es volutpat,

< lass apteni ta< iti s< »< ii >squ ad litora

i< irquenl pei ci inul >ia n< istra, 1 « 1

mi eptos li\ mi 11. K os
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LINE ENDINGS

Lorem ipsum dolor sit amet, consectetuer adipiscing elit.

Aenean lacinia nulla. Nunc vitae erat eu turpis rhoncus

nonummy. Sed ligula pede, feugiat in. fringilla non,

viverra non, orci. Praesent pede. Curabitur metus.

Etiam tincidunt, odio sed venenatis ornare, dui purus

dignissim tortor, a vulputate purus felis at neque.

Phasellus egestas dolor eu ipsum. Quisque pellentesque,

urna sit amet gravida sollicitudin, eros mi consectetuer

mauris, malesuada eleifend augue nibh

vitaejusto. Donee volutpat dui id tortor. Ut mattis.

Integer id lectus ut tortor adipiscing aliquam. Nunc

posuere massa sed urna ultrices volutpat. Class aptent

taciti sociosqu ad litora torquent per conubia nostra, per

inceptos hymenaeos.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit.

Aenean lacinia nulla. Nunc vitae erat eu turpis rhoncus

nonummy. Sed ligula peck', feugiat in, fringilla non,

viverra non, orci. Praesent pede. Curabitur metus. Etiam

tincidunt, odio seel venenatis ornare. dui purus dignissim

tortor, a vulputate purus felis at neque. Phasellus egestas

dolor eu ipsum. Quisque pellentesque, urna sit amet

gravida sollicitudin, eros mi consectetuer mauris,

malesuada eleifend augue nibh vitae justo. Donee volutpat

dui id tortor. Ut mattis. Integer id lectus ut tortor

adipiscing aliquam. Nunc posuere massa sed urna ultrices

volutpat. Class aptent taciti sociosqu ad litora torquent per

conubia nostra, per inceptos hymenaeos.

PARAGRAPH INDENTS AND WIDOWS

ii There are three

different ways to

justify text. The most

common is ranged

left, ragged right,

which provides legible

text. Another way
favored by many
designers is justified

text, where the type

lines up along both

left and right edges.

This is often used in

newspaper design but

can cause problems

by creating big gaps

(called "rivers")

between words, which

can be distracting to

the reader. The third

option is that of

ranged right, where

type lines up on the

right edge only.

i Default software

settings may create

awkward shapes

through inconsistent

line endings within

columns of text

(above left). To rectify

this, use line breaks

to shuffle the text

around. This will

result in consistent

short-long-short

line endings, which

aids readability

(above right).

Avoid single words

at the end of

paragraphs: they look

ugly. In the left-hand

column, there is no

clear indication where

paragraphs begin and

end. The type in the

right-hand column

features an indent

equal to that of the

point size of the text.

Lorem ipsum dolor sit amet,

consectetuer adipiscing elit. Aenean

lacinia nulla. Nunc vitae erat eu turpis

rhoncus nonummy. Sed ligula pede.

feugiat in, fringilla non, viverra non,

orci. Praesent pede. Curabitur metus.

Etiam tincidunt, odio sed venenatis

ornare, dui purus dignissim tortor, a

vulputate purus felis at neque.

Ut libero. Phasellus egestas dolor eu

ipsum. Quisque pellentesque, urna sit

amet gravida sollicitudin, eros mi

consectetuer mauris, malesuada

eleifend augue nibh vitae justo,

Donee volutpat dui id tortor. Ut

mattis. Integer id lectus ut tortor

adipiscing aliquam. Wine posuere

massa sed urna ultrices volutpat.

Class aptent taciti sociosqu ad litora

torquent per conubia nostra, per

inceptos.

Lorem ipsum dolor sit amet,

consectetuer adipiscing elit. Aenean

lacinia nulla. Nunc vitae erat eu

turpis rhoncus nonummy. Sed ligula

pede, feugiat in, fringilla non. viverra

non, orci. Praesent pede. Curabitur

metus. Etiam tincidunt, odio sed

venenatis ornare, dui purus dignissim

tortor, a vulputate purus felis at neque.

Ut libero. Phasellus egestas dolor

eu ipsum. Quisque pellentesque, urna

sit amet gravida sollicitudin, eros mi

consectetuer mauris. malesuada

eleifend augue nibh vitae justo.

Donee volutpat dui id tortor. Ut

mattis. Integer id lectus ut tortor

adipiscing aliquam. Nunc posuere

massa sed una ultrices volutpat.

Class aptent taciti sociosqu ad

litora torque it per conubia nostra.

per incepto



the complete guide to digital type

common mistakes
Good typography is one of the essential elements in any piece of graphic design. Being able

to use it well will aid any design and communicate the message more clearly.

A
signers don't under-

:f typography and

so a takes occur that

g down dard of their work

a few pointers, however, these mis-

can be rectified to produce more

i
iy pleasing results. The following

on looks at these common mistakes

shows how they can be corrected. The

^roup looks at often-used punctuation

j numerals.

apostrophe and quotation marks

-sc of primes and apostrophes is com-

mon among people who set type Primes

are a leftover from the days of the type-

e now used to denote feet and

• ey are located on the keyboard to

e semicolon An apostrophe is

used to indicate a missing letter or a word

that is possessive. The proper apostrophe,

also known as the typographer's apostro-

phe, is hidden on the keyboard and can be

accessed by typing Shift-Alt-] on the

Macintosh or Alt-0146 on the PC.

Quotation marks, also known as smart

quotes, are also hidden on the keyboard

and can be located by typing Shift—Alt— [ on

the Macintosh or Alt 147/148 on the PC. It is

possible to automate this procedure by set-

ting the preferences of the layout applica-

tion, such as QuarkXpress, to use smart

quotes, or typographer's quotes for InDesign.

numerals

In the majority of fonts the numerals are

the same height as the capital letters.

These are called lining figures. This is fine

when setting using all caps or within dis-

play text. Using them in conjunction with

lowercase text can cause problems since

they tend to overpower the surrounding

copy For use with lowercase characters it is

best to use old-style figures, which have

numerals that conform to an x-height with

tails protruding as ascenders or descen-

ders. These retain the consistency of the

text. On the other hand, it is usually best

not to use old-style figures with caps or dis-

play copy.

The basic character set of most modern

digital faces offers only lining figures. If

your typesetting involves working with a

large amount of figures, it is probably more

effective to choose a font with an expert

set—an extra font matching the design of

the original with added features. These

SMART QUOTES

"Suspendisse at enim"
OSt'O

quotator

irt«C your

Smart Quotes to

automate this

function and avoid

using primes 'Ante sagitti's magna!
)

)

PRIMES

2'6 II

30' 15"
<< <imes are used

with numerals (for

example, feet and

inches). The two

examples show how
to write two fc

inches and 30

minutes, 15 seconds.



common mistakes

features might include old-style figures,

ligatures, ornaments, fractions, and some-

times even swashes.

hyphens, ens, and ems

Use a hyphen (-) to connect compound

words or to divide words broken by line

endings. The en dash (-) is used (with no

space either side) in number ranges, such

as dates. The em dash (— ) is used (with no

space either side) to denote a separate idea

within a sentence or an abrupt change in

thought. Depending on linguistic varia-

tions, en dashes can also be used in this

way, with a space either side.

Again, depending on language, both ens

ems can sometimes be used instead of

parentheses. In this instance, ens appear

with a space either side and are better

suited typographically to sans serif type.

Em dashes are used without space on

either side and are typographically better

suited to serif typefaces.

NUMERALS

1234567890
1 234567890

i As you can see

above, there is quite

a big difference

between lining and

old style numerals.

The ascending and

descending tails

provide more rhythm

within text if using a

lot of numbers.
The en dash is

normally used without

space on either side

within dates, page

numbers, and other

numerical ranges.

ENS IN NUMBER RANGES

1920-1931

pp. 26-27
HYPHENS

Lorem ipsum dolor sit amet adip-iscing

ENS IN A SANS SERIF TYPEFACE

Lorem ipsum dolor - sit amet adipiscing

Lorem ipsum - dolor sit - amet adipiscing

EMS IN A SERIF TYPEFACE

Lorem ipsum dolor—sit amet adipiscing

Lorem ipsum—dolor sit—amet adipiscing

<< The function of

the hyphen is to

connect compound
words or to divide

words separated by

line endings. Ens and

ems have varying

uses (above and left).

Typographically, ens

are suited to sans

serif faces, ems to

serif ones.



the complete guide to digital type

common mistakes continued

account the setting

agraphs within a lay-

'oblems may arise due to the

e and the way the text flows

:olumn. These conventions

point out the possible difficulties and ways

drop capitals ("caps")

Drop caps are traditionally placed at the

beginning of a chapter. If left with default

settings you may see a large gap between

the capital letter and the following word.

Attention needs to be paid to the spacing

between the cap and the rest of the para-

graph to make sure it integrates with the

text well. For best results, kern the cap and

following text carefully and align it with

the top of the body copy. The standard for-

mat is to place the cap a set number of

lines within the copy.This can be easily con-

trolled within the formats dialog box in

QuarkXpress and InDesign.

hyphenation

Hyphens are used in compound words.

When hyphenation is left on the default

setting, words are hyphenated at the end

of lines. It is preferable to do what you can

to avoid this, as it breaks up the natural

flow of the text and can be sufficiently dis-

tracting as to slow reading.

By setting the Hyphenation and

Justification (H & J) preferences it is possi-

ble to adjust any unwanted hyphens.

Alternatively, place manual line breaks in

the text to avoid unsightly hyphenation, or

edit and rewrite it to eliminate too many

hyphenated line breaks. Unavoidable

hyphenated line breaks should have at

least two letters before the break and at

least three at the beginning of the next

DROP CAPITALS

Z To set a drop cap

inQu= select

Forr *he

Style menu. In the

dialog box. check the

Drop Cap box and set

the Character Count

for the number of

glyphs you want to

Count for the number

ou want •

glyphs to drop do-

> On the near right,

you can see the drop

cap default setting,

where there is a lot

of space between the

capital and the rest

of the text Use the

kerning commands
to close up this gap

and align it with the

rest of the copy for a

more pleasing result

ght)

*l»l H

Suspendisse al enim. In mattis, an u

,u Lai mi. i i onvallis, massa justo

I. inn it tellus, noii ( onset tetuei

purus \i In 1
1 felis, Quisque pellentesque,

\iiih gravida tincidunl nisi. Vestibulum

<|iii^ linn Fuse nulla ante, tristique eu,

\ ulputati d, mi. In tempoi

Mi. mi vel 'in \l.n c< nas aliquet, tellus eu

i i |i
i i~<|in pellentesque, an u ante sagittis
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-.qui n ul tapien In ha< habita i plati .1
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ligula dolor, aliqui 1 nci tin

• idniii id, pn iiiiiii .1 ju i" Nam 1
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1

Moi In moll in I' 'I nihil.

Suspendisse al enim. In mattis, an u

al lacinia convallis, massa justo

taoreet tellus, non consei tetuer

purus velil el l<lis. Quisque pellentesque.

\11111 gravida tincidunl nisi. Vestibulum

(|nis enim. Fusee nulla ante, tristique eu,

vulputate eget, sempei sed, mi. [n tempor

(li.iin vel si in. Maecenas aliquet, tellus eu

si elerisque pellenti sque, an u ante s.i^iuis

magna, in posuere ipsum risus sit amel

mi. \nin ullamcorper, urna vel venenatis

pharetra, lorem 1 isns tempus an u, al

lobortis rlii neque vel lectus. Quisque

I 1 |iii< 1 urn nliini sil ,i!ini. 1
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common mistakes

line. Avoid more than two hyphens in a row,

and avoid hyphenated word-breaks at the

foot of a column of text and at the bottom

of a page.

hanging punctuation

Punctuation placed inside a text block

can create ugly gaps in the copy. Hanging

punctuation is the process of placing any

beginning or ending punctuation (particu-

larly quotation marks) in the margin in

flush left and justified text. This produces

more pleasing visual consistency within

the text, as there are no unusual gaps to

break up the flow of the copy.

Software such as FreeHand and

InDesign has preferences to set this func-

tion. QuarkXpress, however, requires that

you set it manually, either by placing a non-

breaking space before the quote and

adding negative tracking between it and

the text, or using the formatting dialog box

to add a negative indent to the specified

amount of the punctuation size.

rivers

"Rivers" are the negative spaces caused

when using justified text. The justification

process alters the space between words in

order to force the text to fit the measure.

The inconsistent word spacing creates the

appearance of a river of white space run-

ning down through the text. This can be

distracting for the reader. Rivers are more

common when type is set across a narrow

measure or column width. To combat this,

you could set your text flush left and

ragged right so that word spacing is consis-

tent, or if you really have to justify the text

try setting it across a wider measure.

The general rule of thumb is that the

length of the line in picas should be about

twice the point size. So, for example, if your

type size is 8 points, then your measure

should equal around 16 picas.

HYPHENATION

In pulvinar, odio ac vulputate pharetra

sapien arcu tempus nisi, vitae rutrum

enim nunc ut lectus. Vivamus tellus.

Aenean posuedre placesrat quam ura-

bitas dedur sagittisimus orcsssin mettau-

ris.Vivasmus sapien sodales dictum purus-

nteger ac risus. Maecenas porta mi non

sem. Nullam tincidunt elit laoreet vitae

augue. Fusee nulla sapien, faucibus non,

congue in sceler laoreet isque laoreet

pede. Quisque vehicula euismod ante.

i The default setting

for hyphenation pays

no attention to how
the text looks on the

page. When using

justified type the

amount of hyphens

within a given block

of text can be very

distracting. Adjust the

hyphenation to rectify

this problem or add

line breaks within the

copy to shuffle the

text around.

In pulvinar, odio ac vulputate pharetra

sapien arcu tempus nisi, vitae rutrum enim

nunc ut lectus. Vivamus tellus. Aenean

posuedre placesrat quam urabitas dedur

sagittisimus orcsssin mettauris. Vivasmus

sapien sodales dictum purusnteger ac

risus. Maecenas porta mi non sem. Nullam

tincidunt elit laoreet vitae augue. Fusee

nulla sapien, faucibus non, congue in sceler

laoreet isque laoreet pede. Quisque vehic-

ula euismod ante.

Edit Hyphenation & Justification

Name

Mew H&J

@j Auto Hyphenation

Smallest Word: (

Minimum Before:

Minimum After:

Q Break Capitalised Words

Min.

Space 85%

Opt.

110X

Max.

250X

Char: 0% OS 458

Flush Zone: mm

M Single Word Justify

Hyphens in a Row unlimited

Hyphenation Zone: mm I Cancel ) ( OK )

RIVERS

Lorem ipsum dolor sit

amet, consectetuer

adipiscing elit. Aenean

lacinia nulla. Nunc

vitae erat en turpis

rhoncus nonummy.

Seel ligula pede,

feugiat in, fringilla

non, viverra non. orci.

Praesent pede.

Curabitur metus.

Etiam tincidunt, odio

sed venenatis ornare.

dui purus dignissim

tortor, a vulputate

purus felis at neque.

i Rivers can be very

noticeable when
using justified text

and small coiumn

measures (left). They

create unsightly areas

of white spac within

Lorem ipsum dolor sit

amet, consectetuer

adipiscing elit.

Aenean lacinia nulla.

Nunc vitae erat eu

turpis rhoncus

nonummy. Sed ligula

pede, feugiat in.

fringilla non. viverra

non, orci. Praesent

pede. Curabitur

metus. Etiam

tincidunt. odio sed

venenatis ornare. dui

purus dignissim

tortor, a vulputate

purus felis at neque.

the text block, which

can distract the eye.

Increase the measure

of the column or use

range left, ragged

right text (right) to

avoid this problem.
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the position of type on the page
sition of type on the page is as important as the selection and treatment of the

typography. For a message to be communicated clearly, all elements must work in unison.

w:
g how to use typogra-

isiderthed -

e performs It communi-

words. but also the

:e is laid out on the

pag- vey a message or an idea. It

or caption artwc

legibility and readability

oook. both the terms legi-

. will be used In this

jge these two terms can often be

confused and used more or less inter-

changeably, so it is important from the out-

set to clarify their separate meanings.

Legibility relates to typeforms and how

easy it is to distinguish individual charac-

ters or alphabets in certain fonts.

Readability refers to typeforms and also,

more importantly, its sympathetic and logi-

cal placement on a page: that is, how clear

and easy it is to read a piece of text. There

are many factors that may affect this, such

as the choice of font, size, color, the use of

space, and the arrangement of the typogra-

phy within that space. The way in which

the text is presented is also a factor in read-

ability, for example, whethei typography is

viewed on screen, page, or within a dedicated

exhibition space with ambient lighting.

Legibility has sparked a huge debate in

recent years. Some designers argue thai

legibility is a conditioned factor and thai

we read best what we have become accus-

tomed to; such designers cite using Black

Letter as an example of how letterforms

5 in .mother spread

from the same project,

the copy h ni td eably

irdered.On this

double-page spread,

ii the

definition and

" iples of

IV|i")',M|'liv I 01

this reason, the

t

,i" igraphy has ti
i be

easier to access and

read to back up the

subjec t mattei
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the position of type on the page

have changed overtime without any loss of

quality in communication. This is true, but

technology means we are now exposed to

many differing types of lettering. This has

and will continue to affect each generation

and no doubt leaves its mark on the designs

created, along with the subsequent ideas

on what constitutes a legible typeface.

type for continuous text

The use of typography is essential to any

good graphic design. It is the building block

from which all the other elements hang.

Get it wrong and the design will be flawed.

Manuscript typography is very different

from that of text type in a magazine or

newspaper. The typographic design of con-

tinuous text requires attention to detail of

a more precise nature. Nothing should

interfere with the flow of information from

author to reader and the typography

should be transparent in that it should

impart only the written information and

not in some way add to the meaning

through its treatment. Although newspa-

pers on the whole are dealing with large

amounts of typographic information, the

information is broken down into different-

sized chunks. Each chunk is separate in its

own right. These pieces of information

must attract attention to themselves with

bold headlines or subheadings and are laid

out within a distinct typographic grid to

maximize the space. Magazines, on the

other hand, strive to attract attention to

the story or text. In addition, the typogra-

phy is designed with the content of the

information in mind: sometimes the design

is given meaning through the expressive

nature of the typographic elements.

It is for these reasons that the choice

and treatment of the typography for these

functions has to be different. Text type for

books should be invisible in that it should

not draw attention to itself. In a magazine,

the article may be more experimental in its

use of textual information to transfer the

message or idea.

Here the text and

grid structure are

used to maximum
effect to illustrate the

relationship between

insanity and genius.

The treatment of the

type automatically

sets up the tone of

the piece.

O* UUli ft 'en< . ,i> M* . *|

\'4 t»(i ** (>«l(ip>Klf? »1 i>: '

•<M***i*" « •>• W*ft «« '•»*! MM
F'. Kl~* t**tf *< !»* *****

- . IM.H *l tMlimM
* itM»M< •< being corrtfffl n

it wti-« ttnt^in* M.««r <* •Mll.rr ti»it tk* m*n *irti-

mM«r-ith, t^«ifl tM (i*tt w--

tn4 ll II (t1i Mlh J»t«

»>-h)lii hIM
*.<».l«i

t»(» III •

i Ina double-page

spread from a

promotional brochure

for a university, the

image plays a large

role. The copy has

to be easy to read

without any loss of

information. For this

reason, there is a

clear hierarchy and

positioning for the

reader to folio 1
/.

PRINCIPLES OF GOOD
PRACTICE

THE TYPOGRAPHIC GRID

VISUAL HIERARCHY

CONSTRUCTING A GRID
IN QUARKXPRESS

30

44

46

48
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the typographic grid

A typographic grid adds structure to the resulting design and allows the designer the

flexibility to put together professional, well-ordered pages with ease.

^ms for

.

(bo- I illy look

illy

ng when they

proportions of the

doc gd
bottom

d also

/OU

Cry page design

olumns of

• g r,d

>n a

page They are about the or> n of

objects in space and involve di

about proportion an ;

'•nt

is generally a

column widths, while the horizontal lines

are determined by the space that a line of

type occupies.

Designers use grid structures because

they are practical, especially when produc-

ing multi-page documents such as books,

magazines, and newspapers. They make

the production process quicker and build in

a visual consistency, bringing order to a

page and imposing structured thinking on

the design process.

There are four basic elements involved in

a grid structure.

margins

A margin is the space around the grid

structure that govern' hi i
lose the text is

placed to the edge of the page. If the grid

uses small columns, one or more can be left

blank to give a consistently large left or right

margin; alternatively, large margins can be

part of the grid trui ture, Extremes of all

he page mi ire visually dramatic.

the column and the field

«int, illy, the page is .[ilit Into margins

and columns. Vertically, the page is spill

.) baseline grid with top and bottom

margins. In addition, the page can bedivnl- -I

al units to form fli

These fields can be used to line up ele-

ments on the page such as photographs

and Illustrations with 1
1
ilumns o\ texl 01

headline, fexl can Mm ai rosi a ilumns to

itinganrl dynamic pages.



the typographic grid

2 For magazines,

newspapers, and

other documents, it

may be necessary to

have several columns

for the text to follow.

This four-column grid

serves many design

purposes well, but can

prove inflexible.

yen numbers of

columns often do not

provide a designer

with enough

flexibility. An odd

number of columns

offers the opportunity

to leave a column

blank to give a page a

more dramatic look.

the baseline grid

The baseline grid is a series of horizontal

lines running across the page. Each line

represents a possible baseline of a line of

type. The baseline of type is the line on

which the bottoms of capital and lower-

case letters sit. Two factors determine the

space between baselines: the size of the

type and leading.

In order to develop a system that gives

maximum flexibility, the unit of the base-

line grid is usually smaller than the mea-

surement from baseline to baseline of the

text type size. Normally, the unit is divided

into three to give the designer a degree of

flexibility when setting text for such ele-

ments as captions. Most layout application

software allows you to specify the incre-

ments forthe baseline grid within the pref-

erences and to snap text to the grid. Text

which all conforms to a baseline grid is

more esthetically pleasing and ordered.

X An other way to

achieve more drama

within the design is

to have margins that

are not evenly

measured. Here, the

left and bottom

margins are greater

than those on the

right and at the top.

STFieie more columns

you have across the

document, the more

flexibility you have

within the design. You

can take text across

two or more columns,

while allowing

captions to occupy

only one column.

i aid the design,

many designers use

fields along with

columns to align

elements on the page.

Fields' horizontal lines

create rectangular

spaces into which

text or images can

be placed.

Qu.rkXF,*,, Fik Edit Pag* Uyoui vwt U<"'<i" wmflow ft Htlp it at b '« n it

Si meliora dies, ut vina, poe-

mata rcddit, scire velim,

chartis pretium quotus arro-

get annus, scriptor abhinc

annos centum qui decidit,

inter perfectos veteresque

referri debet an inter vilis

atque novos? Excludat iurgia

finis, "Est verus atque

probus^ centum qui

annos."

iajir. aon (irtM n n

Si meliora dies* ut

vina, pocmaia reddit,

scire velim, charris

pretium quoins arro-

ger annus, senptor

abhinc annos cenrum
qui decidit, inter per-

fectos veteresque

refern debet an inter

vilis atque novos?

Exc'udat iurgia finis,

"Est verus atque
probus, centum qui

perficit annos."

«/lHe<4 Here, the baseline

grid is set to 8pt. On it

are placed 8pi, i6pt,

and 24pt text, set

solid. Notice how even

though they a-e all

different sizes, they all

;re the baseline

grid is a series of

horizontal lines, which

represent the baseline

of a line of type. In

page layout software,

you can control the

intervals of these

lines by setting the

measurement in

points. It is also

possible to make the

text on the page snap

to the baseline grid

to make sure it all

aligns perfectly.

conform to the

baseline grid. It is

always best to set the

measurements of the

grid based on the

point sizes of text you

will be using.
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visual hierarchy
Important in every design, visual hierarchy is a way for the reader to navigate around the

information presented in a logical and linear order.

W ,rchy. most infor-

d become chaotic,

designer uses a grid,

.vould not know where to

formation

hierarchy

ne visual arrangement of ele-

a graded order from most to least

• designer must consider this

en designing any piece that

• /pographic information. The

•es a tone of gray on the page Any

'one will make elements

sackground or appear to

come forward into the foreground. You can

use lighter or bolder text, smaller or larger

point sizes, and reverse text out on a colored

background, with graphic elements such as

underlining and arrows to achieve this visual

direction. All these lead the reader's eye

around the page in a particular order.

symmetry vs. asymmetry

The grid grew out of a logical approach to

legibility. Since we read from left to right,

each word should be separated by an equal

word space, and this automatically pro-

duces asymmetrical ranged-left, ragged-

right typesetting.

The most visually stimulating designs

tend to be those that employ asymmetry

as a design criterion. Asymmetry lends

itself to greater exploration of the visual

potential of layout. The freedom to use

space and scale dramatically has produced

great beauty and dynamic tension in the

work of designers, such as Jan Tschichold.

His designs still look as fresh and modern

today as when he designed them in the

early part of the last century. Asymmetry

ii ai hi< ved in the number of columns

used within a layout—three or five, for

example—and in their positioning on the

page with larger left or right-hand margins.

_ •- —

k^I'M

n?

a ini this centered

layout there is a clear

hierarchy but the

design does lack some

visual dynamism.

3 Mi

an exh gram

i Jan

old design The

asymmetrical design,

typogr.iph,

su< h ,i'. (olorcd

shapes and rul'

!<. ,i dynamic

and esthetic .illy

pleasing piece.



s u a I hierarchy

» Oneie of the easiest

and most effective

ways to draw

attention to a piece of

text is to make it

bigger and bolder. In

this example, the

name and title copy

have been given this

treatment and so

stand out above the

rest of the copy.

In ti this example,

the name is the

biggest element on

the page but since

it is set in a light

version of the

typeface, it is not

the most prominent

component. The bold

text underneath

generates a darker

tone on the page: it

draws the eye in first

and so plays a more

dominant role.

» A.i other way to

create dominance on

the page is to use

visual devices such as

colored boxes with

the text reversed out

of them. In this

example you can see

that the title text has

been enlarged

considerably but the

name still commands
attention because of

the prominence of

the black box.

10 trpl-ll Oil

Andy Ellison
U mollora alo;, ut vim.

poemata reddle

~zzazszzr^* .- • ... -...

r.s=r

JJO*m*MKCh><u

w OOUIK '««4f

Andy Ellison

Si melion dies, ut vmi.poenua reddtt

»>pi-li Ot

—urn m- fnlu. -.««

C*4qif*|iiWmiB'

•i -»
Andy ClUson

»£««

re' 00 44 16 ' 23 4567

—.
' AM.

»>(.!) I 0<1

Si meliora dies, ut vina,

poemata redd it :

»' 00 -M 6

Si mehora dies.i

± In 1In this example,

the tint of the

typography has been

used to make large

text appear less

prominent. Although

the name is much

bigger than the

other elemen+
s, the

choice of a paler tint

means it does not

"shout" off the

page, creating

visual harmony

Bbtle use of

typography can

produce some very

interesting results.

Here, size and weight

have been used with

restraint. Attention is

drawn using bold type

at small sizes to

maximum effect.
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constructing a grid in QuarkXpress
A grid is relatively simple to construct in any page layout application. The introduction of

master pages enables the user to design a variety of grid structures.

M rages a' . item

: age appears on

ev«f. the master is

• you can name master pages

any page within your doc-

produce a range of grid

be used throughout the file.

producing a grid in QuarkXpress

i master page, locate the

Document Layout palette At the top of the

nd an A-Master A icon Doubleclick

to display the master page within

ow possible to modify the

m»»- r
i in

I* is—
.15—

_ 'Mki I

3
you begin a new

proff"

t tog box v.

appe..

column gi.

° ° Page Layout

a j ®M\B
Q Duplicate A

v

number of columns and the margin guides.

Select Master Guides from the Page menu.

The dialog box shows the margin measure-

ments—top, bottom, left, and right—along

with the column guides and the gutter

width. Key in the values you require and click

OK. These values will now be applied to

every page created with the master page. To

create new master pages, select the blank

page icon at the top of the palette and drag

it to the master page area. It is then possi-

ble to rename and modify this new page.

QuarkXpress allows the user to place

margin and column guides on any page. To

Pjge Layout CI/hen creating a

multi-page document

i.iy be necessary to

create several grid

structures for different

needs. Master pages

are very useful as any

elements you place on

them are duplicated

on every page you

create using it. They

arelocat* i.ige

Layout palette.

^ ^ Page Layout

LI" j
ft 3

aA-Master A
B-Mwter B

create fields the user must pull down

guides on the master page from the rulers

and position them to the correct place.

The baseline grid will automatically be

set to default. To change the measure-

ments for the increments and also the posi-

tion on the page from which it begins,

locate the Measurements command within

the software Preferences. This will control

the start and also incremental measure-

ments in points. In the Formats palette in

the Style menu, you can lock any type to the

baseline grid. Any text created will auto-

matically snap to the baseline grid.

| Layout View Ui MllUI Luldtl

Column Guidtt

Column* 1

9

Gutitr Width 3 mm
i.'.mnwiprr

XI

MAigln Guidtt

Top 1* mm

Bottom 30 mm

Display

ln»id« 30 mm

Outitdt 15 mm

( bud) ( OK )

« y

i T<M

Sleet tin

page by clicking on it

hen selei tthi

duplicate icon (th<

middle symbol ol two

overlapping pages).

You will see a new

master page appear

called B-Mastei

can renamr thl

i in km); on 1 1

.< name
and typing ovci it

i change the

number of columns

and add guides, select

Master Guides from

the Page menu. This

will bring up the

Master Guides dialog

box, where you can

change the number of

i iiliimrr,, tlir (Mittrl

width between them,

and also set the

margin guides.



constructing a grid in OuarkXpress

BASELINE GRID

| Utilities

Fit In Window

50%

7SX
Actual Size

200%
Thumbnails

Hide Guides

wiffiirciiiamr
/ Snap to Guides

Hide Rulers

Show Invisibles

Window <

380

Kl

OF6

f7

OF7

XR
X\

z The baseline grid

in OuarkXpress will be

set to default. In order

to seethe grid, use

the Show Baseline

Grid command in the

View menu.

| File Edit

About QuarkXPress"

Services

Hide QuarkXPress

Hide Others

Show All

SCH

X3CH

Quit QuarkXPress 36Q

* To ii change the

settings for the

baseline grid, you

need to alter the

preferences. In the

OuarkXpress menu,

select Preferences.

Z Che

Paragraph Attributes

loose the

Paragraph option in

the left-hand window.

In the right-hand pane,

set your start point

—

normally the same

measurement as your

chosen margin. Set

the increment amount
in points. This will

depend on your chosen

point size and font.

Preference*

Application leading

Innractiv*
Auto Leading 201 V Maintain Leading

Save Mode «* Typesetting ~ Word Processing

XTefltiorti Manager
avenue quark Baseline Grid

Default Pain Start |5 mm Increment 8 pr

Full Res (-review

Index Hyphenation

Placeholders
InttrnjMOAAl English t>uindtrj

fraction, Price

PtO)««

XML Import

Print Layout

General

Measurement!
Paragraph

Character

Toots

Tupping
Quaik CMS
Layers

L
L,»«l >

«""<

Tab*

5 Orop Caps

Character Count

Line Count

_ Keep Lines Together

All Lines in 1

Start End

Left Indent mm

First Line 4 mm

Right Indent mm

Leading 11.5 pt

Space Before mm

Space After mm

Alignment Left

HAJ Standard

_ Keep with Next 1

'V'Lock to Baseline Cnd

|

Apply
| < oiO

A1 Or)nce you have set

the measurements for

the grid it is possible to

make the text lock to it

so it cannot be out of

alignment. In the Style

menu, choose Formats.

In the dialog box, check

the Lock to Baseline

Grid command. All text

will then snap to the

guides without the

need for positioning

each line manually.

w, QuarkXPress filt Edit

mr.ty
-EL,

fiqr uvoui vim

!*

M...,M...,M....,M...,M....,m..

Window g. Hdp

pto|«U Layout 1

Si CO Tw it 01

1 Ifyfyou double-click

on the master page

icon, the master page

will be displayed on

screen for you to add

elements to. You can

be sure you are adding

to the master page by

the chain link icon

displayed in the top

left-hand corner of the

page. Drag down
guides from the ruler

bars to place on your

field guides or any

other guides you may
require. These will then

appear on every page.

,',n '.v.i
„

;i,

09 •! I

ll_ '

Si meixra die?' V i'ju

poem*** reddd, »care

veiim, charts purtwn
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nter pertecfee veteroqtc referri

ld>et *n infer vits ifcj'e no vco '•
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liiao* " . 'lil 'i'u !-jTXut nunor
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« You can then begin

to add in elements

such as text boxes

on the guides you

have created.

t
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type management
Fonts are a crucial part of any design. How to store them and manage them can be a

problem for many users. Too many fonts can clutter up the hard drive.

M the

of fonts and

g them and stor-

on some future occasion.

ie to have a selection

.ou can use at any time to

need, too many of them

d on your computer can take away

rn the operating sys-

Jown your computer.

A solution to this problem is to use some

management system, which

allows you to organize fonts into categories

and load only the ones you need when

^eed them. Not only does this speed

• e operating system but also it allows

you to locate fonts quickly and easily

and load them according to job. client, or

•veral pieces of font software

but the two main con-

Adobe Type Manager Deluxe

fusion. Both of these

ible for the Macintosh and PC

ough. Adobe Type Manager

doe :ort MacOSX.andat the time

Joes not seem to be any

ase

^nd. supports all plat

any

operating pr

•
. on

omputr i place other

The application

alio.

f»on Fonts

s m <H M-

<_*
Mm » Date Modified Size Kl

•Cungseouche dtont 13 Septemb 003.04 11 10.2 MB A
1 Macintosh HO

•HeadhneA dtont

•PC myoungjo dtont

13 Septemb 003.04 11

13 Septemb 003.04 11

1.2 MB

9 MB

otsco ±
tpilgiche dtont 13 Septemb 003.04 11 4.5 MB

— ' AJBayan ttt

' AJBayanBold ttt

IS Septemb 003.03 12

IS Septemb 003.03 12

80 KB L
80 KB

B Desktop AmericanTypewnter dtont 18 Septemb 003.0106 524 KB

^ «6
Gt\ andy hand 19 August 2004. IS SS 4KB

andyh 19 August 2004. IS S4 24 KB

afMB Applications
Apple Chancery dlont 18 Septemb 003.0106 328 KB

Apple LiSung Light dlont 13 Septemb 003.04 18 8.4 MB

l^t Documents
Applt Symbols ttl 18 Septemb 003.0106 188 KB

AppleMyungjo dtont 13 Septemb 003.04 11 US MB

tjlM| Movies
CT1 Anal

01 Arial Black

19 October 200S, 12 43

19 October 2005. 12 43

312 KB

60 KB

n Music
T Anal Narrow 19 October 200S. 12 43 260 KB

T Anal Rounded Bold 19 October 2005. 12 43 44 KB

{~\ Pictures
* AnalHB ttt IS Septemb 003.03 12 40 KB

AnalHBBold ttf IS Septemb 003.03 12 40 KB

7 Attic 27 April 1993.21 02 108 KB
' Ayuthaya ttf IS Septemb 003.03 12 296 KB
" Baghdad ttt 15 Septemb 003.03 12 88 KB

Baskerville dlont 18 Septemb 003.0106 420 KB
' BellGotBTBIa 30 Novemb 1990. 17 47 32 KB
' BellGotBTBol 9 November 1990. 23 16 32KB

BellGotBTRom 2b Novemb 1990.20 23 32 KB

T BtllGothic Blk BT 20 Novemb 1990. 17 58 36 KB

T BellCothic Rm/Bd BT 20 Novemb 1990.17 58 64KB
BiauKai dlont 13 Septemb 003.04 18 13.2 MB

BigCaslon dlont 18 Septemb 003.0106 140 KB

7 bus and pieces lSDecemb 2005.20 10 16KB
7' Brush Script 19 October 2005. 12 43 48 KB

7 canice sansbold suit 11 Oecemb 2005. 17 49 16KB

7 canice sanshght suit 11 Decemb 2005. 17 48 16KB

7 canice sansregular suit 11 Oecemb 2005. 17 49 16KB

Chalkboard ttl 18 Septemb 003.0106 160 KB
" CharcoalCY dtont 15 Septemb 003.03 12 68 KB

7 ChollaSansScreenFonts 11 October 2004. 12 48 80 KB ]

i9/ Items U 49CI JvaiUb
,

i temporarily add fonts as they see

hese temporary fonts will then be

;ded on the i up.

the operating systt" read-

ing all the fonts stored ot I <lnve at

to be

used elsewf >mputer

running at optimum speeds. It also means

you can categorize you i fonts <ind also pre-

view them at any tunc withoul havin

load them e.i' htime. Ifyou are using lot! fi

fui differenl job it
I

.nlvisable- and

tunc effective—to invest in some fonl

management software



type management

ROO
all fonts

= no

Network

Macintosh HD

DISCO

ii Without any type

management system,

the Fonts folder in the

System Folder, or in

the case of the Mac,

the Library, is full of

font files. These files

do not allow you to

see what the fonts

look like or categorize

them. Too many fonts

in the System Folder

will slow down
your computer.

E Desktop

fttf ae6

:

A Applications

-i Documents

Movies

Music

Pictures

Name

I
astigmatic fonts

bitmapped faces

* bustream typefaces

coputer arts fonts

decorative

dingbats

,
distressed fonts

fonts folder

fonts from system folder

* foreign

graphics course fonts

• handwritten

historical fonts

kris font

.
letraset

my fonts

ORNAMENTS

other

Retro fonts

sans serifs

scripts

serifs

stencil

techno fonts

vicki's fonts

»• weird

NewsGothicBT-Bold

ABCDEFGHIJKLMNOPQRST...
abcdefghijklmnopqrstuvwxyz
1234567890!@#$% ~ &*()

49 CB available

• NewsGothicBT-Boldltalic

ABCDEFGHIJKLMNOPQRSTU. .

.

abcdefghijklmnopqrstuvwxyz

1234567890!@#$% " &*()

Date Modified

14 Decemb 2004. 20 48

S December 2005. 11 17

Today. 15 2 3

ZZ August 2004. 16 41

13 March 2005. 23 27

13 March 2005. 23 00

Today. 15 23

Today. 15 24

29Septemb 003. 16 53

13 March 2005. 22 51

25 June 2005. 01 36

13 March 2005. 23 26

13 March 200S. 22 5S

13 March 2005. 22 3S

20 April 2005. 13:50

11 Decemb 2005. 18 35

20 April 200S. 13 59

Today. 15 25

20 July 2005. 17:1S

10 May 200S. 14 34

7 December 2005. 15 31

13 March 2005. 23 25

13 March 2005. 23 25

13 March 2005. 23 17

Yesterday, 23 18

Today. 15 24

• NewsGothicBT-ltalic

ABCDEFGHIJKLMNOPQRSTU. .

.

abcdefghijklmnopqrstuvwxyz
1 234567890!@#$% A &*()

• NewsCothicBT-Roman

H This is a shot from

Extensis Suitcase

Fusion. In this

window, you can see

the font chosen and

also any other

variations within the

font family, providing

a quick and easy way

of viewing the font,

along with a means of

storing it until needed

by the system.

J

ii Here, the files are

sorted by category on

the hard drive but it is

still difficult to know
what they look like

and to be able to use

them effectively.



type management continued

The first font management software we will

be looking at is Extensis Suitcase Fusion. It is

currently a new system on the market and is

available for both the Mac and the PC.

The software provides the user with a

font management system that reads fonts

located on the hard drive and loads them

into the system software as and when

needed. To gain the full benefit of the soft-

ware it is best to move all fonts other than

system fonts to a separate folder. To allow

the program to access these fonts simply

open the software and drag and drop the

individual fonts or folders into the fonts

pane on the lower left of the interface.

The font set window, on the top left of

the interface, allows you to organize your

fonts by whatever criteria you specify. You

can activate or deactivate these fonts as you

need them.

The preview window allows you to com-

pare fonts to each other visually before you

activate them. The top toolbar contains

icons for the most commonly used com-

mands, such as creating a new set, add

fonts, remove fonts, and also the color cod-

ing to denote which faces are currently acti-

vated or not.

To create a new font set, click the New

Font Set icon and name it. Select your

appropriate fonts in the dialog box and click

the Add button. Alternatively, you can click

and drag faces from the fonts pane directly

into the font set to be used. Once the set

has been defined the preview window will

display the fonts included.

When activating or deactivating fonts,

there is no need to restart your computer.

Suitcase Fusion allows you to specify one of

three modes for the font: activated (green),

deactivated (red), and temporary (yellow).

These modes control whether the font is

available to the system permanently, tem-

porarily, or not at all. To change the status of

a font, simply select it and choose the

appropriate color-coded icon in the toolbar.

This function allows you to specify fonts

that you may use the majority of the time to

be loaded on every start up. The temporary

function allows you to use fonts that will be

deactivated on the next system start-up.

%M

, Extensis Suitcase

Fusion is one of

the newest font

management

systems available.

About Suitcase Fusion

Suitcise Fusion
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Z Wl/hen opened for

the first time, the

following window will

appear. On the left are

the font sets and

suitcases, on the right,

the preview window,

where you can view

the fonts. To begin a

new set, click the New
Set file icon at the top

left of the box.

I



A tie

-
lew folder will

appear in the Sets

window, which you

can rename by typing

a folder name.

Z Che

I lh<le font files you

have added will

appear in the suitcase

window on the

bottom left-hand side.

You can see that if

you click on one it

appears in the

preview panel.

—

Tick the Add

button to attach font

files. In the dialog box

that follows, locate

the font files to be

added and click the

Open button.
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fonts available to tr

system, simply selei

them and then did

the Activate button

A yellow dot will

appear next to

them to tell you th;

these have been

temporarily activati

see
•CMW

Itafei

NOW
-TiultC.

nibble to u»
q nuht IVm i

up

S«i
:

:
::.

fi ap0kut>oni

iitjBl* Mtn lime

»- * (onu Icy bock l?

Suncue Funon

I I I —1—1
ABCDEFGHIJKLMNOPQRST...

T

abcdefghijklmnopqrstuvwxyz
1234567890!@#$% * &*()

M#lf V

Tools window Help

K If you hold down
the Option key while

you click Activate, the

fonts will be added

each time Suitcase

starts up and so will

appear with a green

dot next to them. It is

also possible to

manage the fonts in

the System Folder by

choosing Show
System Folder Fonts in

the View menu.

Set Pane Columns

View By Font

View By Suitcase

• View By Family

Next View

Hide Font Pane

Hide Sets Pane

Hide Preview Pane
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sing the drop

down menus on the

preview panel it is

possible to change

the point size of the

text previewed, in

addition to the

message shown.
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type management continued

m is ATM

th many peo-

: is now

of date with

onager Deluxe works on

-.case Fusion. This

e confused with Type

Manage which is a type utility

:mg PostScript fonts.

ATM WYSIWYG (What

What You Get) principle,

-oothes fonts and makes sure they

-rectly.

ATM Deluxe locates font files on the

hard drive and activates those required by

the system, depending on the set specified

within the interface. In essence, it manages

the font folders for you, taking the respon-

sibility of having to locate and load fonts

manually into the system folder. It allows

you to specify font sets, activate and deacti-

vate them, and organize them according to

job, style, or any other criteria you specify.

The interface is relatively similar to that

of Suitcase Fusion and works on a series of

tabs rather than icons. The Fonts tab

enables the user to view all the fonts

installed on your system. You can add fonts

into existing sets or you can start new sets.

By double-clicking a font, you can view it in

the sample pop-up window to check it is

the one you require. To add a font to a set,

simply drag and drop it into the required

font set.lt is possible to set temporary fold-

ers that can be either deactivated or even

deleted by the software on restart.

The beauty of font management pro-

grams is that not only doyou free up mem-

ory for the operating system but you can

add fonts for immediate use, without the

need to restart the computer.

Act be TypeManager Dduxe 4.5

'«!»«» Uru.krtna.W la«ar«ay. Dan Finn. Strr*. rrawa.. Rooarl Oacroa, Ora Holm.
IknJMM, Ttaanaahta rr.r, r-lactay . Marta rta<nm<«. Jac* MoDonial. Cric Muliar, M«*>*o
ha 'aaalOtaiaxi ', J^ 0** . t>» <>*•*».****! fhMvt . Shimr, Rot*H . Ku4i SUrry , One*
•WvaAar ^MfMK' TfiaaM I. »* Vay*». Natoor. Vhrtnty. AftOVav Yartwowqr,

• .'•« Aajafca. <•» Moo. 109a .
Mota T/pa Managar

vail «t l a« MaXf, raaaaa, *mrym#* All B+.H P.|~ ..-]

-I *•-• 9,030.101. 9.109 Jll. 9.2X>7«0, 9JOIJU.
9 _7I7.it I 9,790 .197 l»aaaMa a~ar*

when sta"

.nage

your sets of fc-

first time, there will be

only one set, entitled

Starter set. To activate

or deactivate fonts,

select a file and check

the box next to it.

] Window Help

Activate :

Deactivate *D
Create Multiple Master.. 38M
Verify 38E

Report 38R

Mark as Undamaged

(out Set Properties...

Add Fonts... :«: =

Manage Duplicates...

Copy Font/Set...

Find Font-

Find Next Font

Sort List Contents

Add Fonts

CI Garamond, ITC f]

GarmdlTCltCnBT

'..ii mil 1
1

1 LtNr/BdNr BT

1. .iim.lil' 1 11 hi

'..11 lll'l in 1 It'll hi

'..11 m.l 1 1' 1 in nit IM

i,flimdll( Ultlt hi

Add all fonts within

"Garamond, ITC"

38L

88F

KG

MOo,install fonts

onto the system you

need to select

Add Fonts. You can

add fonts to the

existing set or begin

a new set.

5 Cheloose New Set

and name it in the

dialog box. Check that

Activate Set now is

checked to avoid

having to restart

the computer.

New Set

Name: untitled Set 2

On restart: Activate

Activate Set now

Cancel
]

Desktop
I

[ Cancel )

It
Add

Jl

Add All

Activate fonts when added to ATM Deluxe

Add to Known Fonts u

« ill Ithe window on

the right-hand side,

find the fonts you

wish to add from the

hard drive

ZJ

OK



type management

Vol)u can use the

file from its current

position without

moving it to the

system folder. To do

this, click on the Add

Without Copying File

checkbox. Any fonts

you have selected

should be added to

the set. To add any

further files, simply

select the set and use

the Add tab to choose

further typefaces.

Character Cache Size

51 2K Suggested siz*

S12K Current size

Preserve

® Line spacing

O Character shapes

Smooth Font Edges on Screen

D On Disable Smoothing at Screen Font Po:r

Precision Character Positioning

Enable Font Substitution

Enable Auto-activation

O By Application Q Global #Off

• Changes to the marked items will take effect only at restart

Cancel OK

Preferences

|
Printing D

Sample Header

Font : { Times ZJ Size: [TF

• Alphabet text
Sampler text

Fountain text
Font Index text

cys

Lvwxyz
1234567890 $%&(.„ :»!?)

Size: [jj~

Verify, Report and Status pr

Font : j Times

4/AsAs with Suitcase

Fusion, it is possible

to change the sample

text viewed. In the

Settings tab, choose

the Advanced mode
and edit the text how
you want. Any fonts

added will become

immediately available

to any software

running without the

need to restart the

software or the

operating system.

leckfor duplicate

fonts when adding

files to ATM and show

system fonts in the

Known Fonts Set by

checking these

options. Select

Activate Fonts

when added to

ATM Deluxe.

Preferences

Settings 3
Alerts

Warn after launch if ATM Rasterizer is not active

Settings

I I Cheek for duplicates when adding fonts to ATM Deluxe

0Show system fonts in Known Fonts list

f~l Activate fonts when added to ATM Deluxe

Cancel n OK

Sample: Gill Sans Light plain SB
n f

Known Fonts t]
|
Gill Sans Light

5» I
Oil' Sans Light

ID: 16194 TrueType

T) tOGD

Gill Sans Light

Technology TrueType

PostScript Name GillSans-Light

Version 00 1 . July 1992 . Classic set

Font Suitcase File GUI Sans Light

Copvri^liMQ 1992 Monotype Corporation pic Alb vh' reserved

abedefgh ijklmnopqrstuvwxyz

ABCDEFGHIJKLMNOPQRSTUVW
234567890 $%&(.,;:#!?)

While the basic shapes of letters have not changed much in hundreds of

years, there have been thousands of variations on the theme. There are

special types for telephone books, newspapers and magazines, and for

the exclusive use of corporations. Some typefaces have a leisurely look

about them while conforming to everyday typographic expectations.

'double clicking

any font in the set a

sample window
should appear, where

you can view it.

t
1

THE DIGITAL ACE 22

TYPE FORMATS 24

PRINCIPLES OF GOOD
PRACTICE JO

GENERATING FONT FILES

AND USING FONTS 186





Manipulating type is nothing new, but recent advances

in software such as Photoshop, Illustrator, and FreeHand

have made it simple for the designer, illustrator, and

typographer to experiment with effects on their

typography It allows them greater control and

enables them to add to the feel or atmosphere of the

typography This manipulation may in turn enhance the

message transmitted from author to audience, giving

subtle clues as to meaning. This chapter is concerned

with the various forms of manipulation open to the

designer. Here, we will demonstrate effects, giving you

practical pointers on how to create them.

gm I
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type on curves and circles

letting type on curves and circles is a way for the typographer to guide the reader's eye

around various pieces of information, in a particular order.

Tmputer and soft-

er. FreeHand. and

h as QuarkXpress

ibled the designer to

to typography to

around the page. The

o it is sometimes

ng hierarchy and

make the reader follow the

I particular order. Rather

g blocks of type horizontally,

on a set angle, text can be

• owing curves that lead from

• rmation to the next: the

typography becomes a branch connecting

the separate strands of information. It can

create a more dynamic composition with

added visual interest.

it is more commonly used in designs like

beer labels, bottle tops, and information on

CDs, where the text has to run around a cir-

cular or oval shape. With a few moves in

one of the software packages it is possible

to flow text around perfect circles or other

shaped paths.

Adjust your tracking and kerning appro-

priately: text left on default settings can

look poorly spaced and bunched together

as the tops or bottoms of letters intersect

or overlap when placed on the baseline.

Similarly, text tracked too loosely can be dif-

ficult to read as letter spacing becomes

confused with word spacing. Small type on

sweeping curves gives the most visually

pleasing results. Large text on tight curves

produces ugly, poorly set results.

If you are placing text in a perfect circle,

don't start the text at the top but on the far

left. Since the majority of us are condi-

tioned to read from left to right, we auto-

matically look for the first word in a piece of

text in that position.

^

£

^

X
°'U DIES.*

6.

O

^
A^

a rext i in
i lr< les

and curves is easy

to achieve in most

software packages

and if done with

care can add some

dynamic tension to

any composition. The

placement of Ie1

guides the eye.

i Type on curves can

look great but you need

to let the reader know

where to begin. Since

.'/: ICI.I Irlt li) MJ'lll ll

is always better to start

on the left, rather than

in i he center. The bullet

acts as a focal point to

reinforce this fact.



type on curves and circles

LLUSTRATOR QUARKXPRESS
<^y

'^I^J

*-

%T|03l

y j.

V UsUsing this text

tool, click on the path

then type your copy.

put text on a

circle, first create the

circle using the Ellipse

tool. Hold down the

Shift key while

dragging the shape to

make a perfect circle.

Once complete, use

the Path Type Tool

again to place the

text on the shape.

the same way as

in Illustrator, click and

drag the desired

shape. Here guides

are used to help to

generate a circle.

Another way is to

use the Freehand

Text-Path tool. This

works like the Pen

tool in Illustrator, in

that you draw the

shape and the tool

calculates where the

anchor points and

handles should be.

Freehand Text-Path tool—^ '

fmply draw out

the shape and the

software automatically

treats it as a text path.

Use the Content tool

again to generate

the text.

PRINCIPLES OF GOOD
PRACTICE

i t SHADOW EFFECTS

i * MAPPING TYPE ON
A SHAPE

30

90
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outlined text

of the main advantages of using vector software is that you can treat the typography

as a series of shapes, rather than text.

V'ator and

Jity and

.oossible with

^s Vectors are

: tions on spe-

. reated from out-

ted by points and Bezier curves.

Beca ely on bitmaps, it

,- and the points and curves

.n be manipulated to produce

d FreeHand have the ability to

: nd outline it simply by using the

•roke function in the toolbox. If you

• ner outlines, you can do so

• Path functions. Using the Outline

Path or Offset Path function enables yon to

draw around any existing path. This takes the

original paths and provides you with an out-

line of the stroke width placed on that letter. In

effect, you outline the outline. You can then

proceed to change the width and color of the

new path.

Alternatively, select your chosen text and

copy it to the pasteboard. Stroke your text as

normal using the toolbox and add a small

stroke weight. Paste your copied text behind

and then color the stroke, changing the stroke

weight to be greater than the first. For maxi-

mum impact, combine this with other effects,

such as drop shadows. This function is cur-

rently unavailable in QuarkXpress, although

InDesign has it—Adobe tied it in to

Illustrator's operations and amended it to

tackle page layout.

overlapping outlines

Once you have mastered using outlines in

Illustrator, try creating other effects, such as

overlaying. By copying and pasting you can

build up text that has multiple offset out-

lines. This can also be achieved in Photoshop

by placing a stroke on selected text. This can

be duplicated through the layers and moved

to the desired position. For a psychedelic

effect, try blending solid text with mis-

aligned outlines and vary the color and point

size slightly.

tog

logotype

eed

to create eye-

typog'

out ot



outlined text

OUTLINE EFFECT

d<4 Select your type,

then select your

outline color from

the main toolbox.

•r In-i the Window
menu, select Show

Stroke to see the

Stroke palette. Select

the required weight in

points or millimeters.

Object Type Select Filter Effect View Window He

Transform

Arrange

Croup 3€G

Ungroup 09€C
Lock

Hide

Expand...

Flatten Transparency...

Rasterize...

Slice

Blend

Envelope Distort

Clipping Mask

Compound Path

Crop Marks

Graph

Join

Average.

Outline Stroke

Offset Path...

9€J

•V3SJ

Simplify...

Add Anchor Points

Divide Objects Below

Clean Up...

cjirphlifi

«s In I[the Object

menu select Path,

then in the submenu,

choose Outline Stroke.

You can change the

stroke width of the

outlined path using

the Stroke palette and

also change the color

using the swatches.

t

i

SHADOW EFFECTS 64

GRADIENTS 72

SCREEN PRINT EFFECTS 96

CREATING OUTLINE
FONTS 178
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misresistration effect

In the printing process, the colors cyan, magenta, yellow, and black overprint each other and

by mixing together, create every color within a print.Mi at refers to

nent of the

olor printing

correct registra-

3 give the correct

ey are not in the cor-

the image will have a

nost evident on

u are using small point

: one plate is only slightly out, you

ee an outline of cyan, magenta, or yel-

the colors) depending on

•.he correct position.

to replicate this effect in

•iere are two ways of doing

:. because Photoshop splits the

°to channels, these can be

ordingly. By placing your

type rpropnate mode of CMYK you

appropriate color channels.

econd way is to use the Layers palette

8y copying your piece of text you can

md color it using the Type

tools, filling
•

n cyan, magenta, and

yelk he Layers Blending option to

Multiply and every color placed on top of

the other will have the "additive'' effect,

that is. when all the CMY colors are added

together they produce the color black. You

can make the text look like it has been

printed poorly for graphic effect, by slightly

moving the text on the relevant layers. This

is only possible with black text.

Misregistration is an

effect created when
the printing plates

are deliberately

misaligned. The

separate colors of

the three color

plates, plus some
colors in between,

become visible

around the edges of

the black letters.



MISREGISTRATION EFFECT IN PHOTOSHOP

1 Generate your type

in Photoshop. In the

Layer menu, select

Duplicate Layer to

create a second,

copied, layer. Repeat

the command one

more time so you end

up with three layers.

] ,,,, I,, K...L....K

New
Duplicate Layer..

Layer Properties...

Layer Style

New Fill Layer

New Adjustment Layer

New Layer Based Slice

Add Layer Mask
S .

D" S '0M- 2" Add Vector Mask

'^r>^ 'magenta. Ci.

.K...K...K...I"....K...L;...I-.'...K..K'...I-:

misregistration effect

510. CMYK/8)

1 lr...l-.-...l^...l-.-...L:. ..I-.. .1:

:

mno

o o
•

Liy.ti Chi»n.H P»lhi

No:mil T) °0'«» [<">
»'

Mil .tO '

0.1 a I a <D. J

H,
\ii~9h as l

S 100 ' a 8i

B S9 v b IT"

R 227 CO %

; C M iocTI*

b iii~] Y:fo |x

# [5o07B
K ° '>

9itSelect one of the

layers, then double

click on the Type Color

box in the top menu
bar to bring up the

Color Picker dialog

box. In the color

values on the right-

hand side, set

magenta (M) to 100

percent and all the

other colors to zero.

* Per?rform the same

action for the other

two layers, choosing

too percent yellow for

one and 100 percent

cyan for the other.

Using the Move tool

or the arrow keys on

the keyboard, move

the layers slightly out

of alignment with

each other and set

the layer options

to Multiply.

_ Only Web Colors

<S» r\ f\ -, Untitled- 1 (a) 33.3% (yellow. CMYK/8)

F'....l'....l'....K...IV..>....K...I-....l'....k...k'...l--...

r

—

lv...lv...l....l.

efghijklmno
Doc U.SM/4 6i e:

Layers Channels Paths I

Multiply >?) Opacity: 'lCu *'

Lock + Fill: 100% \*\

9 J

T magenta

E yellow

i o.i a i
-i

i o.ii ii
i
9

OUTLINED TEXT 60

SCREEN PRINT EFFECTS 96

CLOW EFFECTS 98

OTHER EFFECTS 112
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shadow effects

Shadows are an easy way to add some depth to your work. They work well visually and are

an instant way of creating a focal point in the typography.

A
-old, pov.

ogos.

it the

e articles or

typography,

the rest will

-elf by appearing to

i

shadow consists of copy-

d offsetting it behind

floating. This is still the

easiest way to create an effective shadow,

and can be achieved in any software that

uses type Illustrator and FreeHand also have

the capability to produce soft shadows

along with hard ones. They do this by apply-

ing a Gaussian blur filter to the shadow.

Once you have selected Drop Shadow from

the menu, you can control the distance it is

offset, and its opacity, color, and blur.

Software manufacturers have recog-

nized that their applications can be used

fbi purposes othei than those they were

originally designed for. Photoshop, for

example, now has enhanced type and layer

options to take this into account, With the

click of a mouse it is possible to create a

drop shadow on any text. As with

Illustrator, you can set the distance from

the original, the opacity and the angle. You

can also se.

Once you have created a drop shadow,

you can still manipulate it by using the Free

CREATING SHADOW EFFECTS IN PHOTOSHOP

*f»- Ifctf TOUR

Lay*' x»e
Oop
cop-.

ladow

Q.ttr.i. the f dit menu.

.nsform,

then Flip Vertical

.vill turn the

jpsidedown.

then be

manipula'

-

'

Undo OuptKJIr Uy*r

Mrp B4(h»*ia

Fmd and n»pi.

r \!r.'FT.

IGTOVR

• rvtK*'d VhorKutl

Ag«in

fcotair

Q Mihfvt

< > inflate

(9 twin

1 i!„loose the W.iip

text command from

the l.iyci menu I lom

the ili. ill ij:
l mix, select

the Shell I l|i[iei optn m
i in

.
will make the

)>[••. ol lln lellei I urns

Inline outward.



shadow effects

Transform tools in the Edit menu. This

allows you to shear, distort, scale, or even

add perspective to the shadow to make it

look as though it has been generated by a

light source and cast against a plane. You

can exaggerate it by moving grouping

points together and moving them on an

angle to make the effect more extreme.

You can create shadows inside type

using the Inner Shadow function in

Photoshop. This makes the typography

seem to be debossed into the paper or the

image it lays on top of. The software allows

you to control the depth, angle, distance,

and blur of the shadow.

You can obtain drop

shadows very easily

in Photoshop using

the Layer Style

commands in the

Layer menu. This

allows you to control

the opacity, distance,

spread, size, and angle

of the shadow.

DFRGTWR
H Usese the Transform

command from the

Edit menu to scale the

manipulated layer

and then place it

underneath the

original, untouched,

letterforms.

Z Frorom Layer Style in

the Layer menu, use

Gradient Overlay to

fade the shadow.

Adjust the opacity of

the layer in the Layer

palette for a more

convincing result.

i --..
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• GRADIENTS 72
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the complete guide to digital type

bevel and emboss
You can now create simple but eye-catching 3D-style effects for your type in Photoshop to

take your work beyond using basic drop shadows.

Tjpplied to type have a

ny of any

• ey become a focal point that imme-

ider's attention.

Photoshop has several simple features that.

useo ime imagination,

. our typography stand out.

However, be aware that these effects will

vork on display type, not body copy.

By using the layer effects in Photoshop, it is

very easy to create slight three-dimensional

effects without the need for specialist soft-

ware, such as Adobe Dimensions. To get

going, use Bevel and Emboss. This command

adds depth by generating shadows and high-

lights on any type to which it is applied. There

are several options to choose from including

Inner Bevel, Outer Bevel, Emboss, and Pillow

Emboss. Each of these has its own personality,

i Bevel makes the inside of the letter-

forms look raised from the background.

Outer bevel keeps the characters flat but cre-

ates a shadow that makes the surface they

sit on look elevated. Emboss raises both the

surface around the text as well as its inner

shape. Pillow Emboss makes the type look as

though it has been set into the surface.

outer bevel

•esa

shadow around the

glyphs, which makes

•of

the letterforms
look raised from

background

Up r f";r

ypqrrc,To
inner bevel This effect

i reates highlights

and '.hadows within

the letterforms

in mselves to make

the glyph look three-

clmiensional on a

flat ba< kground.

embo« : tion

and shadows along

theedgf-

letterfor r*

them loo*

thebackgrour

does not beve

instdeoftheg

r rsr ; rVV7XY2

n p !

r hii

pillow emboss I Ins

i ommand creates a

i m J shadow

an mini the i'il(;rs

ill Ihr li II' I d s,

Wlllk I
i in; ' .1 I iin <

dimensional <)u.ility

hi Ini Idi i
'i

thi
|
lyphi



BEVEL AND EMBOSS FILTER IN PHOTOSHOP

bevel and emboss

DOC 2.31M/6S4.4H

. Generate your

text, select the Layer

menu, then Layer

Style. From the

submenu, select Bevel

and Emboss.

Vol5u can control

the depth, direction,

size, and how soft

the emboss is, along

with the angle and

shading. Each of these

options produces

different effects.

New
Duplicate Layer...

Delete

Layer Properties.

Layer Style

New Fill Layer

New Adjustment Layer

Layer Content Optioi

Type

Rasu •

New Layer Based Slice

Add Layer Mask

Enable Layer Mask

Add Vector Mask

Create Clipping Mask StG

Release Ciippim

Arrange

Align Linked

Distribute Linked

Lock All Layers in Sc

Merge Down 3«E

Merge Visible OStE

Flatten Image

Matting

(opqrstuvwxyz. CMYK/8)
L I' [io

Blending Options...

Drop Shadow...

Inner Shadow...

Outer Clow...

Inner Clow...

[>>
I. ... I ... . 2

Bevel and Emboss.

Satin...

Color Overlay...

Cradlent Overlay...

Pattern Overlay...

Stroke...

>tyle

Past* to Linked

the dialog box

you can choose

from a variety of

options: Inner Bevel,

Outer Bevel, Emboss,

Pillow Emboss, and

Stroke Emboss.

Layer Style

Clobal Light...

Hide All Effects

Scale

Btvtl and tmbost

_ Out*' Clow

U'OW

V e«v«l and Imbosa

Contour

Ttxturt

Q Satin

_ ColOf Ova' av

i.i Overlay

Owwr Nvil

'
fcmbois

Icchnique.-j hllow fnbon

Depth; -^^^^^^^^^
to '•*

i r> Down

"I"

Is ~>Hit

• |o
->

OK 3

Shading

120

3 Um Clobai Light

L2
Layer Style 3

Blending Options Default

Drop Shadow

Inntr Shadow

Q Outer Clow

'_' Inner Clow

V Bevel and tmboss

J Contour

J Texture

Satm

Co-r>' Overlay

Cradicrtt Overlay

Pattern Overlay

_ Stroke

Bevel and tmbois

ttiboii

TechniQue fEK^ESE^M
Chuei Hard

t>«P,h: Chuel Soft

Direction ^^.i^^^^W

*

~l«

>».. .

,

->°

Shading

l»

l«

AnoH; ^^^ |120

AJt.tudt:^-

—

'
|j

Clo«i Contour ^dW _ *»-*•"•

Highlight Mod* Scr««n

- 1

Shadow Mod* Multiply :

c Cancel )

New Style...

& Preview

_i'l

Cancel )

( New Style

^ Preview

SHADOW EFFECTS

CUT OUT AND CUT
UP EFFECTS

LIGHTING EFFECTS

TEXTURE EFFECTS
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88
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the complete guide to digital type

roughen, round, scribble & tweak, pucker & bloat

lustrator is an extremely versatile piece of software. It allows the user to manipulate

typography with ease and provides certain effects not possible with other software.

ABCOEFGH
ABCDEFGH
A6CDEFGH
ABCDEFGH
ABCDEFGH
y^K /c "^ y*T r^ r< ^^^\

ABCOEFGH

Vu-based software means that any

text can be turned into a shape and

manipulated. Work with the Filter menu in

Photoshop or the Effect menu in Illustrator

to see the available options.

applying effects

Typography generated at small sizes

i enlarged reveals some attractive

qualities m that the lines, which appear

smooth when small, show all the imper-

fections of the printed page when large.

This can be replicated with the Roughen

Edges hi: the edges of the

typography and adds points, moving the

set to provide a suitably lough shape. For a

le effect, keep the movement distance

very small This produces only a small dis-

tortion, making it appeal that the contours

lie paper have been blown up. This

tends to work more effectively on display

at larger point sizes.

When creatmi', types foi logi ners

often want to modify existing type to

give a differenl feel to the letters. The

Round Corners command In the Stylize

submenu is a useful tool to remember

here. It rounds ofl letti rs and make; them

more friendly.

ribbli ' Iweak and Pui kei & Bli ia1

also work by moving, adding, 01 subtrai ting

poitr : addsa gothii lool by moving

am hoi i" lints i iutward to look like horns,

wiiile Bloat bevels thi straight lini s

reen am hi >i pi lints outward



roughen, round, scribble & tweak, pucker & bloat

ROUGHEN EDGES ROUND CORNERS

J View Window Help SE

Apply Drop Shadow

Drop Shadow...

•OXE review)

Document Raster Effects Settings..

Convert to Shape

.!uuj».*j;.imij.,i

Path

Pathfinder

Rastenze...

Stylize

SVC Filters

Warp

Artistic

Blur

Brush Strokes

Distort

Pixelate

Sharpen

Sketch

Stylize

Texture

Video

Free Distort...

Puckers Bloat.

Scribble & Tweak..

Transform...

Twist...

Zig Zag...

d<4 Begin by selecting

Create Outlines

from the Type menu,

then select Distort

& Transform from

the Effect Menu.

Select Roughen

from the submenu.

Roughen

» The

Size it:

f? Relative

Detail

Absolute

I

10
1

"n
<*.

Cancel

3 Preview

r
Points

Smooth '' '.... .

ne bigger the Size,

the more distorted

the final shape. The

more Detail, the

rougher the line. The

Smooth and Corner

commands control the

corner anchor points

and the effects

between them.

SCRIBBLE & TWEAK, PUCKER & BLOAT

Scribble & Tweak

- Amount

Horizontal: |10 \%

Vertical. |10 |X

© Relative Absolute

d

Cancel

M Preview

Modify

5? Anchor Points

| In" Control Points

| Out" Control P<

Scribble & Tweak

and Pucker & Bloat

are also located in the

Distort & Transform

menu item. By varying

sliders and checking

different buttons

you can produce

new effects.

Pucker & Bloat

Pucker •:. Bloat t OK *

Cancel

& Preview

j| View Window Help m H
Apply Drop Shadow

sSett

OXE
XOXE

ngs. .

evicwi

Drop Shadow...

Document Raster Effect

Convert to Shape

Distort & Transform

Path

Pathfinder

Rastenze...

Add Arrowheads...

Drop Shadow...

Feather...

Inner Clow...

Outer Clow...

44 Select Stylize from

the Effects menu,

then Round Corners

from the submenu.

TOHTBB
SVC Filters

Warp

Artistic

Blur

Brush Strokes

Distort

Pixelate

:<-]IM.M.!..!UMH

Sketch

Stylize

Texture

Video

Round Corners

Radius: 10 pi c OK 3

.r Ih,

^Prevtew Cancel

nis command
allows you to round

the edges of glyphs

by changing the

radius of the corners,

measured in points.

The greater the point

size, the more

rounded the corners.

44 Alt

(W?

iter Pucker &
Bloat in percentages.

Small movements are

best. Pucker moves

the anchor point out

from the center. Bloat

moves paths between

anchor points out

from the center.

t

1

t
BLENDING IN
ILLUSTRATOR

CUSTOMIZING
LETTERFORMS

AMENDING EXISTING
TYPEFACES

CREATING HYBRID
FONTS

9*

94

160
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blurfunctions
Blurt t can add the dimension of depth to your design work. When it is used

appropriately, it can look sophisticated and modern.

Oere has been

earing in

. th a

eappro-

oduce some

attention to

ng and adding

:ography. By layering and

you can make your

type appear to be n the foreground

nto the screen.

I n types of blur:

Motion, and Radial. All three are

:oth Photoshop (in the Filter

•rte Effects menu).

Gaussian Blur

a
Fltaf Gallery

Liquify

Pattern Maker

AnuiK

Brush Strokes

Oiion
None
Pixelate

:er

Sharpen

Stylize

.ire

. tm
Other

Dtgwnarc

XF

\XX

OXX
\OXX

Average

Blur

Blur More

Gaussian Blur.

Lens Blur

Motion Blur

Radial Blur...

Smart Blur

,

blur effects

The Gaussian blur produces the same

effect as if rubbing petroleum jelly over the

lens of a camera. On screen, it diffuses the

pixels in feathered clusters, spreading them

out over a set distance.

Motion blur makes the image look like it

was taken with a moving camera, spread-

ing the pixels out in straight lines, creating

a streak effect.

Radial blur has two types, Spin or Zoom.

Spin rotates the pixels around a central axis

within a selected area. Zoom streaks the

pixels out from the center, giving the effect

of a photograph being taken while a zoom

lens is being pulled into focus.

Gaussian Blur

Radius 4.0 pixels

Rastenze the type,

then choose Blur from

the Filter menu. From

the submenu, select

Gaussian, Radial, or

Motion Blur

1 _.jussian Blur

allows you to control

the radius of the

pixels. The bigger the

number, the more

diffused the blur

Another way of creating blurred type

without diffusing it is to select Median from

the Noise submenu in the Filter menu. This

is designed to remove noise by averaging

out the colors in a selected area. VisualK. it

blends the background into the text, mak-

ing it appear distorted and out of focus

while retaining a solid shape. This can pro-

duce a dreamlike quality.

A similar effect is produced by the

Feather effect in Illustrator. This works by

averaging out the colors across the edges of

a selection and so again diffuses the shape.

Overall, you can add real depth to your

work by using blurred text as a background

or to add meaning to a piece of typography.

z Milotion Blur allows in pixels and also the

you to control the angle of the direction

distance of the effect of the effect.

Motion Blur

( Cancel )

Preview

1001

Angle 28 M
Distance 20 pixels



blur functions

Radial Blur

Amount

—A
14

Blur Method.

© Spin

Zoom

Quality:

C Draft

© Good

D Best

42. Rac

OK

C Cancel

Blur Center

I

?oom produces an

effect similar to

focusing a camera.

Use the slider and

Quality buttons to

control the effect. The

better the quality, the

more memory required.

a Radial Blur allows

you to choose

between a Spin or a

Zoom effect. Spin

affects neighboring

pixels in a circular

motion. Use the slider

to control the effect.

Radial Blur

Amount

A_
25 ~] I OK

The blur filter can give

the illusion of depth

to a flat piece of

typography.

I

Blur Method

Spin

Zoom

Quality:
~

Draft

@ Good

; Best

Cancel

Blur Center

: s
\ i

.N.S. V. \ "\ \ \ I

I I I I / / / .

/ :

t t / /s ss.

/
I I \

I

\ \WW
\
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gradients
•efined as a progressive graduation of colors that fade into one another, a gradient is a

way of adding subtle color to your typography.

T-oited
ng mid-

can have as

ave to click to

ts and drag your cho-

ant handles.

are possible in all pro-

ugh some have a greater

3n others. Currently,

in only produce simple

-ias been changed to pic-

It is best to be restrained with the gradi-

ent tool by not applying too many colors.

Keep the number of colors to two or three

at the maximum. Consider where it would

be best to place the midpoint of the fade

and also the direction of the gradient fill

It is also possible to make type look as if it

has faded to nothing by choosing a color and

white when placed on a white background.

Depending on the direction of the gradient,

the fill will obviously depend on how the

completed type looks, whether it fades from

top to bottom or left to right. With some

care, it is possible to get some effective look-

ing typography. Make sure you choose your

colors carefully, along with the right type of

fill. Radial graduations from the center out

rarely look good in typography unless using

emely bold or black text.

Combining elements may help to obtain

convincing results. For example, a drop

shadow with a graduation may help to

make the type look more lifelike. Also, using

gradients on outlined strokes can add some

depth to the type, making it appear more

three-dimensional.

GRADIENTS IN ILLUSTRATOR

J r»e Window
idient

Choose your type of

•adial

•

color

to appear

Choose your color

from the swatches

and drag it to the new
pointer To change the

midpoint of the

gradient, move the

diamond on top of the

bar to the left or right.

Transparency ^* GVracfcent \

> _
Angle.

Lin t-

-88 41

i

* 6 -^

1*1

» ilioduce your type

on screen then use

Create Outlines In the

Type menu to change

the glyphs from Type

to Shapes. Select all

the glyphs you want

to apply the gradient

effect to. Choose the

Gradient tool then

click and drag in the

desired direction

across your type.

l_a. iMdlj

i:.

•A,



gradients

GRADIENTS IN PHOTOSHOP

d
oo

You can have as

many colors as you

want in the Gradient

palette, although it is

usually more effective

to use a few rather

than a lot.

\t Cakx N^ Attributes
'

ft

IZl^^flBh^B^JBJtaJ
Stroke i GraAent •

^^_

56 :

1 Type: Linear J J

Angle: -90.74 Location:

d

oo

oo
JTcoior \ Attributes \

|
Stroke N $ Gradient T

Type: Linear "*")

Angle: -90.74] Location: |25.84!%

Create interesting

effects by using

gradients with other

effects. This is a

gradient of black and

burgundy on an

extruded drop shadow

to create emphasis.

t. /.-.

oHrla add a color,

simply click on the

graduated bar at the

bottom of the palette

to show where you

would like it to be.

J Swatches \_w
iigLk

or
\

* a m i j i

t Cotof
"
^Attributes \

Cr-
M r

V r

Ik r

Stroke ™ J GraoWnt \^ w
I Type:

' Linear i j )

Angle:
J90.85 I" Location: |o.56 |%

A
\

1 Mcfoveyour chosen

color from the Color

palette to the square

slider you have

created on the

Gradient palette by

clicking and dragging

with the mouse.

This example is

used to better effect.

The gradient uses

complementary colors

and so creates a more

subtle piece of type.

4i Be careful not

to add too many
elements. This is a

gradient with outline

type and a drop

shadow. The contrast

in the gradient creates

too much conflict.

• SHADOW EFFECTS 64
FADING TYPE USING
MASKS IN PHOTOSHOP 8o

LIGHTING EFFECTS

METAL EFFECTS
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perspective
raphic effects such as perspective used to be costly and time consuming to generate.

Now, software allows designers to create convincing results quickly and easily.

e needed to

the

>'e.

jpplica-

gesthat

\ such as

ndustry-

>n go a long way to

too. One of these,

ailed Perspective

to place any object or

th one or

ts As ts now standard,

bize and the

PERSPECTIVE IN FREEHAND

color. You can then place your type on the

grid using a combination of the Perspective

tool and the cursor keys. The left cursor key

places type on any left grids, the right cur-

sor on any right grids, and so on.

It is also possible to obtain perspective

effects in both Illustrator and Photoshop. In

Illustrator, this is achieved by selecting the

text and choosing Distort & Transform

from the Effects menu. Select Free Distort

from the submenu. This allows you to

reshape the typography by moving the four

corner anchor points. In Photoshop, once

the text has been rendered, you can either

use Transform or the Perspective function.

Here, moving one of the corner anchor

points moves the corresponding top, bot-

tom, left, or right anchor to create the effect

that your type is disappearing toward a dis-

tant vanishing point.

The advantages of using the Perspective

tool in FreeHand over the Transform or

Distort tools in Illustrator or Photoshop are

that it conforms and snaps to a set grid.

This allows you to make your work look very

credible. In other software, you need to do

this process by eye, which can be time con-

suming and frustrating.

.1 From the View

ABCDEFGHIJKLM

palette, select

Perspective Grid and

Define grid.

)KGF

B

o
\

e
A
a

1s~

iPtrsptciivt



perspective

Free Distort

st the cell size and

also the number of

vanishing points. Use

the Perspective tool to

drag the edges of the

grid to obtain your

desired perspective.

Generate your type,

then, using the same

tool again and holding

down one of the

cursor keys, drag your

type to the grid. The

left key will place the

type on the left grid

and soon.

1

if |)fc

iiii'iij

:,fVr

LDJHS.DKGF.

PERSPECTIVE IN PHOTOSHOP

B Imag* Uytr

j Undo Move

Step Backward

Select

MZ

Titter View Window

§ Untitled -!(» 100%
J

Cancel

Reset

«l Preview

4T Oik

44 In Photoshop,

create your type and

render it by using the

Rasterize command

in the Layer menu.

In the Edit menu,

select Transform,

then Perspective.

Fill...

Stroke..

Free Transform

Define Brush...

Define Pattern.,

Purge

Preset Manager...

Thi

Scale

Rotate

Skew

Distort

Rotate 180'

Rotate 90* CW
Rotate 90" CCW

Flip Horizontal

Flip Vertical

sis produces a

box with handles

around the text. By

dragging one of these

handles outward, the

corresponding angle

on the same side will

also move out by the

same amount.

t In I

nee complete,

you can see that the

size of the text box

remains unchanged

and can be moved

around the screen

as before.

lustrator, create

your type. In the Filter

menu, select Distort,

then Free Distort. In

the dialog box, drag

out the handles until

you achieve your

desired effect.

GHFVU

GHFvu
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106

no



the complete guide to digital type

halftones
printing technique that allows less ink to be used. Commercial printers can

r costs down while still creating the illusion of a wide variety of colors and tones.

and

'eatethe

•ogether.

•urther apart.

imple. if you

• :herthan

use only

k dots are close

ear red. where spaced fur-

^ appear lighter and give the

ive used this

'oduce a much more

experimental approach into their work.

Letters that have the halftone effect can

look very effective.

To some extent, both Photoshop and

Illustrator have the ability to produce this

effect on screen, but for best results, apply

the effect to large typography. Photoshop

has the most effective functions for con-

trolling the effect.

applying the effect

Generate your text on screen. Then add a

little Gaussian blur to obtain a more pleas-

ing effect In the Image menu, select Mode,

then choose Bitmap from the submenu.

Bitmap gives you the opportunity to set the

halftone screen, the number of dots per

inch (dpi), the direction of the dot angle,

and the shape of the screen you require

—

in this case, round. Once applied, you will

see that your typography is made up of dif-

fering dot sizes that generate the shapes of

the letters. This image can be used as a

background or, if the text is big enough and

the halftone screen fine enough, as titles or

logotypes. For inspiration, look at the work

of Vaughn Oliver of V23, who, in the past,

has generated traditional halftone screens.

>

1 lalftones can be

i loadd some

Inten st to display

type. Thee' !

produi es .1 distorted

look with "i losing

Inn nun h I' nihility



halftones

:H Once you have

generated your type,

use the Blur filter to

add a slight Gaussian

blur to the text.

This provides a

better result in the

finished piece.

^ n ® 2 Untiiled-l (a) 50% (abfijsio. Cray/8)

1

°
' ' ' >• r '• •

' i- I" i'° »- w. '. i* if. i-.- i-..

Gaussian Blur

Bitmap
Radius "> pixels

Resolution

Input: 300 p ixels/inch

Output: 300 pixels/ inch ;
!

Use: Halftone Screen... Jl

Custom Pattern »

-A-

f OK )

( Cancel j

1' Unmled-1 @ S0% (abfijsio. Cray/8)

....I' R I". I:...,.. ...I'.
6
..

Dot 1.26M/1.S9M

J Untitled- 1 @ 50% (Bitmap)

« Ini order to create

the halftone, change

the Mode in the

Image menu from

RGB or CMYK to

Bitmap. You may
have to go through

Grayscale first. In the

dialog box, select

Halftone Screen as

your Method and set

your Resolution. For

a more accurate

effect, choose a

higher resolution.

*< In I[the Halftone

Screen dialog box, set

the Shape to Round.

To obtain more dots,

choose a higher

number for the

Frequency and Angle.

I SHADOW EFFECTS

BLUR FUNCTIONS

CUSTOMIZING
LETTERFORMS

CLOW EFFECTS

64

70

94
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autotracing and drawing over existing type
The Autotrace function can be used to trace around letters and give them a deliberate

rough, computer-generated quality.

B^tions.
\ I

retween

is set up

"iey could be

nages have to be

PS format for it to work

:
• perty C c of : ne tool's flaws is that it can

add extraneous anchor points where they are

the shape of the letter-

ed up by moving or

I

an generate a curious effect

:oes not exactly replicate the shape

you have • *en The distortion that results

*.ed very creatively Designer Neville

Brody exploited this in his Autotrace series of

typefaces. He merged some existing sans

serif faces using Fontographer to produce

what he termed "a Univers for the digit.il

age." He then traced this font to create a dis-

torted set of glyphs. The resulting face was

again traced to create an even more

deformed typeface. He repeated the process

with each resulting font until the final face,

Autotrace nine, bears little resemblance to

the original typeface.

The Autotrace facility in FreeHand is dif-

ferent. It can be used to outline images as

well as any other vector artwork within a

specified area. As a result, whole glyphs or

sections of letters, words, or even sentences

can i i These can be scaled, colored,

and maneuvered at will. With some imagina-

tion, you can use Autotrace to produce frac-

tured, fragmented, and multilayered typogra-

phy that creates a complex and engaging

atmosphere in piece of graphic design.

It vol i want to geneute text from typo-

graphy that only exists as hard copy, use the

Pen tool to draw over existing letter shapes.

With a little practice, the Pen tool can be

used to create paths of characters that can

be applied within artwork. If you want to

generate a more handcrafted kind of glyph,

try using the Pencil tool and drawing around

the letters freehand. This will give a more

emotive and low-tech atmosphere.

AUTOTRACE IN ILLUSTRATOR

a Lock the image

m place and choose

vtotrace tool

•toolbox. In

Illustrator, import the

artwork by selecting

the Place command
from the File menu

K its

edge of the shape-

tool Will automatic .illy

1 Lft.l I III! IMI. I|'/

and delete it.



autotracing and drawing over existing type

AUTOTRACE IN FREEHAND

:N In FreeHand, use

Autotrace to produce

a progressive effect by

tracing a character

created by the

Autotrace function.

> Thlese anchor

points can be given a

fill or stroke to

produce opaque

shapes or outlines.

1 Ihle other way to

trace glyphs is by eye

using the Pen tool in

Illustrator. Begin by

clicking and dragging

anchor points as you

go around the glyph.

^-Generate your type

and then select the

Autrotrace tool.

3« Bycl:licking and

dragging with the

tool you can trace

whole glyphs or just

sections. Once

complete, the outlines

will be shown as

anchor points.

derate smooth

curves by having the

least amount of

anchor points possible

Another way is to

draw around the

glyph freehand using

the Pencil tool. This

requires patience and

a steady hand for

good results.

REVIVING HISTORICAL
FONTS

CREATING HYBRID
FONTS

CREATING YOUR OWN
FONT FROM SCRATCH

CREATING A FONT
FROM FOUND OBJECTS

1 56

160

164

174
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fading type using masks in Photoshop
1 introduction of layers in Photoshop, it became possible to add typographic effects

that were subtle, sophisticated, and looked great.

Aele-
om each

ampulated with-

tion.

n be

ging the opacity.

e a level of

•hat is sepa-

of legibility, such

•nple

possible to make

Die.

More comple- ts can also be

achieved by using the masks for each layer.

By masking out the top layer and showing

the one below, type can appear to fade

from solid to transparent. A combination of

the Layer Mask and the Gradient tool

achieves this result accurately.

The Type Mask tool allows you to create

selections in the shape of your text to mask

out. You can also paste in other elements.

This function makes creating masks simple.

When combined with imagery, it is possible

to make the type appear semitransparent

by "screening back." This is done by adjust-

ing the levels affecting the contrast of the

image to make it appear lighter or darker, or

alternatively, to make the typography

appear lighter or darker. This is easily

achieved using Adjustment Layers.

Foi further ideas, you can also set the

layer option to Difference to make it appear

negative over darker areas and positive over

i er ones. This produces subtly presented

typography that appears to come out of

the image as a paler (or darker) version of

the background

USING LAYER MASKS IN PHOTOSHOP

-~M

o. j j e. ii i

3 ottom of

J.s.

tr-h

o
elect

Gradient tool from

the toolbox and

make sure that

background/

foreground colors are

set to default black

and white Click and

drag acre,

image I in-

foreground image—in

type will

be masked only where

thewl are

H fay

one- '.illy

masked where black

ones are gener..

OumitH Path* Layers <9
• Normal

|
Opacty:

DinoJv* " »

Darker

Multiply
kfghijk

Color Bum

LIMIT BuTl

ground a

Lighten

Scraan

Color Dodge

Lawar Dodg*

Ovarlay

Soft Light

Hard Light

VrvtdUo/it
-> ' al *

Unaar light

Pnbgrtt O
£ick.uon

at—afiu can also be

atlve with the Layer

Ma options to generate

Saturation subtle effei ts with
Color

Lumnotity
the type to overlay or

|ii.i i into in |;,itive

(1 Ultciriuc)



fading type using masks in Photoshop

abctiefghij
Channels Paths Layers I

Normal t Op : I . >

Lock: J y-f a F : 100* >>

- y

Irnalages can be

placed within the

type using the simple

Paste Into command
in the Edit menu. You

will need to render

the text to begin and

then select it using

the magic wand tool.

Image layer Select I

Undo Magic Wand 36Z u

1

*>

Slep Backward tXZ

Cut XX
Copy xc
Copy Merged oiec
Paste wv

Clear

Fill...

Stroke...

Free Transform

Transform

86T

Define Brush...

Purge

Preset Manager...

Jpenyour image,

choose Select All, then

Copy. Use the Paste

Into function in the

Edit menu in your

original file to paste

your chosen image

into the type. Once

it is pasted in, you can

edit it, scale it to fit

and soon, using the

Transform command.

•

|

Layer 1

abcctefgr- jk

| |
Background 2

O. £1 -i
: €.11 a 1 9 I

5u will see in the

Layers palette that

your image is on top

of the type layer with

a layer mask in the

shape of the text.

t

1

i

<

BLUR FUNCTIONS

GRADIENTS

IMAGES IN TYPE USING
MASKS OR A
CLIPPING GROUP

I LIQUIFY

70

7*

82

108
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mages in type using masks or a clipping group
h the introduction of masks and a clipping group, it is now possible to use text in

ting ways by combining it with photography and drawn imagery.De rest in

ustrative

: e should be a

• nany

vhen considering

cmporary designs

ies of distorted and

zed the graphic

•lotoshop in particular

to treat typography

.e approach. Text can be

: ulated element within the

t of a pictorial design, rather

.vhich conform to

Masks make it poss; ize nugery

in such a way as to pla> ie letterforms.

The application does this using the layers. By

generating layer masks you can conceal the

uppermost layer to reveal the contents of the

layer below.

This capability can be applied to a variety

of different design elements on a page or

website, from logos and headlines to type

that appears as in integral part of an illustra-

tion. It helps to use large, bold, or even extra-

bold, text that has been tightly tracked and

kerned. The reason for this is that the letters

will have larger stroke widths that may be

touching, allowing more of the image below

to be seen within the glyphs.

One of the more subtle applications of

this effect is to make text appear to be semi-

transparent when placed on top of an image.

By copying the image and placing it above

the original and using a layer mask to mask

out the text. you can subtly alter the contrast

of the image and make it appear lighter or

darker. By also adding a drop shadow, the

transparent letterforms appear to be float-

ing above the original image.

Adjustment layers are also useful

because you can give the typography a sub-

tle quality It is possible to directly affect the

color ( hannels thai nuke up the image to

ke text appeal on the image as a slightly

toned shape on the ba< kground.



mages in type using masks or a clipping group

CLIPPING GROUPS IN PHOTOSHOP

d

2AP-CNGITYPL IMAC1YPI-03 JS2SXIXQPCI. RC.8/8)

-i. iv I',-. I-,-, w. H
Generate your

text, then double click

on the background

layer in the Layers

palette and rename

it. Click and drag to

move this layer to the

top of the palette so

it sits above the

typography.

" I- I'.-. I'

+ » M-tioBTB

* J

n Uv*r

Q]XQK.. ,>

l*JIa a ©.II ai I a I

)ld down the Alt

key and move your

cursor over the line

that separates the

image from the type

layer. You should see

an arrow icon appear

with two overlapping

circles behind it. This

is the clipping mask

icon. Click to mask

the image outside

the boundaries of

the type.

•2AP-DICITYPE-IMAGTYPI-0} g> 2SX(Uy«r 1 top». RC»/8)

I'-... .....I-.'. -tn .

uM >

Cor:py the image

layer by dragging it

onto the page icon in

the Layers palette or

by selecting Duplicate

Layer in the Layer

menu. Drag this layer

below the type layer.

By adjusting the

Layer Options of

the top image layer,

the type will appear

more visible on

the background.
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type as a texture
As with all illustrative elements within graphic design, type can be generated that is not

meant to be read, but rather appreciated as a decorative element.A: ography

el or atmos-

• can act as a

it element that adds

e and so supports the

: Typography

nonoccurrence,

i take depends on the

,ou want to create. Most soft-

ws you to either overlay lots of

opaque color or create an array of

-l as transparent, or faded,

type The latter is available in Photoshop.

e beauty of the more recent versions

of Photoshop is that you can create your

2 Select the Marquee

tool from the toolbox

in theOpti

setef

the option and

to more than

2.SOO i 2,$oo p .

me
a bra

HOiom the Edit

menu, select

<• Brush

own brushes using scanned images. These

brushes can be typographic in not

Providing the image (or portion of text)

measures no more than 2,500 x 2,500 pix-

els and is in grayscale, anything can be

defined as a brush. The brush you create

can then be used like any other to add tex-

ture to images or typography.

creating patterns

Photoshop has the ability to generate pat-

terns from imagery. This function would

normally be used for creating backgrounds

or repeating elements within an image. As

with most commands, it can also be used

] Imiyr Uy*f Srl»<t Filwi

H Undo Rciungular Maiuur* UZ

Slrp hKkojrd X«Z

Copy »C
CopyM»fo»d 0«C

<h«k Sprlkno,

Find <nd RrpUir Tru

' i» Pjllrrn

PU>Q*

Prrtrt Mjn*g«r

X a

to create typographic patterns. Start by typ-

ing some text in Photoshop. Small point

sizes work most effectively. Using the

Marquee tool, define the area you require.

Then in the Edit menu, select Define

Pattern. Using the Cloning Pattern tool, you

can choose your new pattern and then use

the layei options on Overlay, Screen, or

Difference to generate assorted effects.

his works best over images. Alternatively,

type some text and then in the Layer menu

select Layer Styles, then Pattern Overlay.

Here you can control the size of the pattern

and also the layer option (Overlay, Screen, or

Difference), as before.

'dialog box will

appear, showing you

a thumbn.nl <>t the

I
will

also ask you to name
the bfu'.h

Brush Name

j«

1 Hi 1

Name Sampled Brush #4
Cancel

thi Brush

palette you < an now

elect the type (or

pari -
t a letti itorm)

you 5( I' <
i<i| .is a

brush to palnl with



type as a texture

ajajaja

BE**"

Select Filter View Window Help ££

New

Duplicate Layer

Delete

Layer Properties.

New Fill Layer

New Adjustment Layer

New Layer Based Slice

Add Layer Mask

Add Vector Mask

Croup with Previous

M It i

Layer Style

Blending Options...

Drop Shadow...

Inner Shadow...

Outer Clow...

Inner Clow...

Bevel and Emboss...

Satin...

Color Overlay...

Gradient Overlay..

V Pattern Overlay..

Stroke-

Copy Layer Style

Clear Layer Style

Global Light...

Create Layer

Hide All Effects

Scale Effects ...

'is possible to set

type as a pattern to

use over the top of

other design

elements. In the same

way as you defined a

brush, you can define

a pattern. Use the

Marquee tool to

define the area you

want. Then select

Define Pattern from

the Edit menu. Place a

new layer above your

pattern and fill it solid

white. In the Layer

menu, select the

Pattern Overlay option.

:.!'

!_ Oreo Shadow

_ \rtwr Shadow

Ouw Glow

•mm t-
1
n

Bev? ana Emooss

_ Contour

Tenure

Sum

QVariay

_ t>adi*nt Overlay

-'p*i.UrnO»trUy

i Stroke

Pattern Overlay

Bend w&cte

Opacity

Pattern

Salt

Ovorlay

f

.

Snap loOngm

3 Unk «rth Layer

OK

Cancel

' New Style...
"

'

H Preview

Merge Down
Merge Visible

Flatten Image

Malting

•03CE

6drdialog box will

appear where you can

select your Pattern,

control the scale of

the pattern and also

define the layer

options, such as

Overlay or Soft Light.

BLUR FUNCTIONS

FADING TYPE USING
MASKS IN PHOTOSHOP

IMAGES IN TYPE USING
MASKS OR
A CLIPPING GROUP

70

8o

82

108
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combining and overlapping type
allow you to corr:

key tool for mar ig'yp'

i

Ove*tapc .

:vw

I

I

I

I

experimenting

iB6fl>EF
ACffiUJE

MERGING TYPE

oo
-rv-~ *.,:- ,-ror >

*J -J 3 J 3) El

.vtarngr«J.



combining and overlapping type

COMBINING TYPE CROPPING TYPE

1

T J

- K text and use the

::— ;-; Z.f zz

:-e er.e =

o
Transform Align Pathfinder \(^)

Shape Modes:

Q'P Q) Expand

Pathfinders:

d
and place a shape

over it. Here, we have

used a simple square.

Select both shapes.

oo
Transform Align Pathfinder \(0

Shape Modes:

fj P B Q| Expand

Pathfinders:

S%) 3> Q |B [Q \P
\

•

OO
Transform Align

|
Pathfinder \Ct)

Shape Modes:

Q
1

1
^ 1] 9i

|

ExPand

Pathfinders:

% ^ Q> Q %> P

2
r- :- :~e -3-.-- -;

row) to unite both

letterfbrms into

o o
Transform Align Pathfinder \C*)

Shape Modes:

Q P *
1 Ql 1

Expana

Pathhnders:

9a^elect the Crop

::: " : e -a: " ::

palette (third from
- z". :~ ~~z : :--.~- -zf

row). This will crop

z.z'rr -g ; ~~.; zt

the uppermost shape.

:e=: -g ; :~e
.-.;..- z~z r.~
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cut out and cut up effects

ating effective contemporary display type is about knowing when and how to break

Society is now visually literate, so typographic boundaries can be stretched.

^parent letters

•ture

• he Layer

s Layer menu

er shadow. This

appear three-dimension-

nsional plane, they

appear to be carved out of the background.

pend on the color of

:olor of the background. If

•ype appears in a contrasting lighter

ook as though it has been

ved comple almost the

e background, it will look

,• •; a set depth.

cutting up

You can also cut up and explode your type

,ed look.

W' :e has been rendered in

eated like any other pixel

re, can be cut up and

jge By taking sections of

gthem.you can paste

ove' nen move them

•ured letter-

select parts of the

id move them out of their

nal pos • e Lasso and

quee toe

Repeating the procedure several times

the piece as

• has not

1 perfer

CUT OUT TYPE IN PHOTOSHOP

• n« :'u*n.i*d iJiinmuii^i. ftcrii

. Generate your

background and text.

Choose inner Shadow

from the Layer Style

command in the

Layer menu. Control

the angle, distance,

size, and opacity of

the shadow in the

dialog box

Mill
H

-«-. « ,

"Z-jt _

—

—

i By using a simple

command in the

Layers menu it is

possible to make

text look as though

it has been cut

away or carved out

of a background



cut out and cut up effects

CUT UP TYPE IN PHOTOSHOP

>1

*"» *3 UUnmled-l ii« 33.3X<wskq. RCB/8)

>..:ir~;;^~:;.:i>:;..\< i....r....i. ...i- r.,.,i-.. . i-.-. . .~n:-

Generateyour

typography then

rasterize it by

selecting Rasterize

from the Layer menu.

ii .iM—m i, i. .l'.-...l-'...l'>...k'...

ll.JW |
OotTOIMll'M P]

Unlilkd-1 3i.i*l«Mkq. RCB/81

..l'....l-°.-..l-J...I-.'-...h.'...l'\..l»...

sleet the

Marquee tool from

the toolbox and select

the shapes to be moved

in the type. This tends

to work best if you

draw long slivers.

f»
« ^ ^ ^'Untitled -1(5) 33.3% (Layer 1, RC8/8)

I .... l-.T. K I'. ... I'. ... I'. ... \". ... I'. ... I'. ... ft . .
1'°. !'. .. h- ...[;... 1^ .. I-. ... !:

.

.

!•
. .

.
l-.».

njj " mmjTnmjjrm

•gssmm

to r\ r\ ->Untitled-l@33.3X(Uyer2. RCB/8)

.

.

.. I . . . ,K.,,K ,,,!<. ... |-. .. . I'. . I-. ... I". .
.
.I'T.TI'f.". ,T')T. ."P.*,.

".¥!'.'.
. I

1

!

4""
, I

1
.'. ..I'?".

.

.1'.'.
. . I'?7."

.

!

"
' Jytl m itoa

'

* sehelect the Move
tool. Use either the

mouse or your

direction keys on the

keyboard to move the

selection, pixel by

pixel, until you obtain

the desired effect.

(4 Yoi

.

lo u can build up a

grungy effect by

adding layers to the

piece, selecting small

slivers or huge chunks

of the type.

L,,,.. OunntH Piihi

lodcg

!l»« '" '•

!Lsl*|aj «|»2JB
• ]-...»» | Lmr 1 *
» J Q""" o
• EO-

IO.IOUIO.lla \9\/,

SHADOW EFFECTS

BEVEL AND EMBOSS

' TEXTURE EFFECTS

i METAL EFFECTS

64
66

110

116
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mapping type on a shape
i the past, it has been difficult to create type on computer-generated objects and make it

•ok realistic. Only 3D packages such as Adobe Dimensions or Maya could do the job.

N •ator,

-implethree-

ders,

Jobe introduced this

I
6 and placed

•he 3D Render fil-

bend and distort shapes

em onto simple objects Since

•iree-dimensional

and you are mapping two-dimen-

nly possible to place

Die part of the object.

•Jobe Dimensions functions

: orated into Illustrator. In

TYPE ON A SHAPE

| . >< A ntfomr H«ip

. 'vm Xf

X>

\ '-• X '

1

«ct

»»•#- Wi.r

t

Otien

MtfM
f >r«tt

»

v.. »

Cioudi

Ofltftnt* ClOvKJl

l.ghtmg EfT«m

1
1: le your oose 3D

the Effects menu you will now find three-

dimensional options. As a result, it is now

possible to extrude, revolve, and rotate two-

dimensional artwork to make it appear as if

it sits on a three-dimensional plane.

This will produce more convincing and

authentic renderings of typography on

objects. Again, though, if you use this func-

tion with a sense of playfulness the com-

mand need not just be used to place text on

an object, but rather to manipulate the

typography to make it appear as if it is trav-

eling around corners. You can also distoi 1 its

shape to make it appear as if it is contained

in a bubble or another object.

EH

EH 1 abcdef

±^M„ie dialog box

<ou choose a

cylinder, cube, or

sphere shape 1

md
Dolly Control t<

the shape and

vmdow

'

EH

*>C«H\

N4-JHU

7t
Vde*

t.r« t l
I

'»•"'«• m hi

is technique

practice. Type

can only be rendered

, n p.irl 1 1! tlic (il)|ci t.

not all the way around.



mapping type on a shape

3D TYPE

, After generating

your text, select 3D

from the Effect

menu. Choose Rotate

from the submenu.

Vi«w window Help

•H..M

Document Raster Effects Settings...

Convert to Shape

Distort & Transform

Path

Pathfinder

Ra steriie...

Styllie

SVC Filters

Warp

Artistic

Slur

Brush Strokes

Distort

pimm
Sharpen

Sketch

Stylize

Texture

Video

Extrude & Bevel

Revolve..

Z One

ne dialog box

allows you to control

the rotational angles

of the horizontal and

vertical planes as well

as perspective angles.

View Window Help

Document Raster Effects Settings..

Convert to Shape

Distort & Transform

Path

Pathfinder

Rasterize...

Stylize

SVC Filters

Warp

Artistic

Blur

Brush Strokes

Distort

Ptxeiate

Sharpen

Sketch

Stytue

Texture

video

« Toj

Rtvolv*

Routt..

1 give the

typography some

depth, go back into

the Effect menu and

select 3D again.

This time choose

Extrude & Bevel

from the submenu.

H Thiis dialog box has

controls for Extrude

Depth and Surface

Quality, in this case,

Plastic Shading.

Clicking the More

Options button allows

you to control the

direction of the

lighting on selected

text. The final

rendered 3D type is

shown on the right.

ice complete,

notice that the

selection guides

—

normally in blue

—

remain the same as

they were before, only

the text now flows

out of the box.
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blending in Illustrator

itor has some very useful and underused commands within its menu functions. One

of these commands is the Blend tool, which transforms objects.Bie shape

imber of

shapes

tails the

jdes the

-ir form. This

ed to change basic

squares or stars, but

ihape including text,

-ated outlines from it

'he possibilities are

ess because you can control

•eps between the objects

as well as the distance those

Dm the original. You can also

between the colors.

By selecting two contrasting typefaces it

is possible to create some great intermedi-

ate ones e qualities of both of the

but look nothing like them,

difference between the

more interesting the

resulting hyt ire

using the tool

use Just select the

"> you v. then choose

-Mend to ] m the tool-

box with the A / rrace 1 ick on an

• the cor-

responding anchor p rrtra ting

'me-

ie is

shapes

•eps

ABCDEFG
ABCDEFC
At)C0*Fi
abcdef
abcdeSg

e steps cannot be manipulated and as normal. You only have to ungroup I hem

need to be turned into ou 1 nessotl rl they to move them around individually. Using

can be treated as any other object within you can produce some unex-

•-vare. By using I
ind com- pected letterforms, which (.in be turned

ma' menu you can change Into a typeface in their own right. This will

m be discussed in the next chapter.



blending in Illustrator

3 Select the Blend

tool from the toolbox.

xiL

9Double click on the

tool to bring up the

Blend options dialog

box. Here, you can

control the number

of specified steps

between your chosen

shapes and the

orientation.

Blend Options

Spacing: Specified Steps C
j J3

(

OK )

Cancel )

_ Preview

Orientation ,***+*+ l^rt^

* Generate youi text

in two different fonts.

Here, we are using

one uppercase and

Blend tool on the first

piece of text then

click again on the

second piece. The

one lowercase. Select program will add the

both pieces of text.

Click once with the

Expand

intermediate steps

between the fonts.

Expand

5? Object

0Fill

Stroke

( Cancel j

Expand Gradient To

Gradient Mesh

255 Objects

i Sol3o that these

shapes can be moved

and separated from

the originals, select

Expand from the

Object menu. This will

break the shapes away

from their grouping

and treat them as

outline shapes.

ABCDEfvG
abcdefg

Type Select Filter Type Select Filter

Transform

Arrange

Croup

iOUP

Lock

Unloi

Hide

All

Transform

_u Arrange

Croup

Ungroup

c
see

Expand Apr

Flatten Transparency...

Rasterize...

nent Mesh...

Slice

Path

Blend

Envelope Distort

Text Wrap

Clipping Mask

Compound Path

Crop Area

Graph

Lock

Unlock All

Hide

Expand...

"

Flatten Transparency...

Rasterize...

Create Gradient Mesh..

Slice

Path

Blend

Envelope Distort

Text Wrap

Clipping Mask

Compound Path

Crop Area

Graph

blect the

Ungroup command
from the Object menu
to move the shapes

around independently

of each other.

A A a a
ROUGHEN. ROUND,
SCRIBBLE & TWEAK,
PUCKER & BLOAT

CUSTOMIZING
LETTERFORMS

EXISTING TYPEFACES

CREATING HYBRID

68

94

152

160
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customizing letterforms

lOftwar? can be used in a variety of ways to manipulate typography. With a little creativity,

you can quickly produce your own uniquely customized letterforms.

abcdefg
Tup. added to. sub-

ed with, rounded

jghenec name but a few),

in limit you.

have additional charac-

d ligatures Swashes are

s added to char-

r pairs that have

be optically more pleas-

vere used to add mdi-

emgset You can use

n for manipulating type.

Few i swash characters for

amoder it simply by combin-

ing- nderin^

a vector pro^ id adding to,

• lowever,

', such •

• t They

look gOOd. U'

•lore

contemporary by rounding them off or

deleting parts. Garamond, for example,

could be updated for a modern generation

in Illustrator or FreeHand by converting to

outlines and manipulating, adding to, or

subtracting from the anchor points and

Bezier curves that make up the letterfor ms.

It is also possible, as demonstrated in

Creating Hybrid Fonts (see pp. 160-163), to

combine elements from completely opposing

•forms to become hybrids. Designers

such as Jonathan Barnbrook have used this

"sampling" approach to design new type-

faces It is feasible to take elements from

particular faces and combine them into

one font. The Unite Pathway command is a

way of performing this oper ike a

look at some hybrid fonts that demonstrate

procedu' is Dead History I

Jonathan

Barnbrook. B NO or more 1

| Select Filter Effect

Font

Size

Blocks

Wrap

Create Outlines :im
|

Find/Change...

Find Font...

Check Spelling...

Smart Punctuation...

Rows & Columns...

Show Hidden Characters

Type Orientation

2 To customize

typefaces, Instrui t the

software to treal the

texl as shapes. To do

elect 1 reate

( )utlines from the

Type menu.



customizing I e 1 1 e r f o r m s

\
*.

ft

2ACUnen select the

Pen tool from

the toolbox.

* VOL

y

«

iii

/-

^
a

•-
jy

*:•

bL

_i

rO„

*

5u will notice

that the anchor

points and Bezier

curves that make up

the letterform are

now visible. By using

the Pen tool, it is

possible to add or

subtract points,

thus manipulating

the outline.

ab
ii By ily removing

anchor points you

can change the

appearance of the

glyphs. This can also

be achieved by

manipulatingthe

direction of the

handles of the

Bezier curves.

g? *Uri s possible to

completely change

parts of the glyphs, in

this case, the tail on

the lowercase "g."

ABCDEFG
>ECC EIC
ABCDEFG

H H

Ship* Mod*)

=
. 4- -J J J. '

Tramfunn *\ Mm ] Prthtafrr \W
ihape Mod*.:

4, Jj J, J J, .'

\B0\B
6J-Aplice glyphs

together by creating a

box and positioning

your type over the top,

making sure the

outside edge

intersects with where

you want the glyph to

be cut. Use the

Pathfinder toolbox

and select Minus Back.

i NeNew characters

can also be created

from two different

fonts using the same
method to slice them

up. They can then be

united using the

Merge command in

the Pathfinder

toolbox to become

one glyph.

I ROUGHEN, ROUND,
SCRIBBLE & TWEAK,
PUCKER & BLOAT

• COMBINING AND
OVERLAPPING TYPE

AMENDING
EXISTING TYPEFACES

CREATING HYBRID
FONTS

68

86

152

160
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screen print effects

Good typography does not always have to look slick and smooth. Excellent creative results

can be achieved by distressing your work.

I

rig software to generate slick

x>th graphics, try using it to re

at are rough and dis-

en printing. The

bea en process, as typified

by a- Andy Warhol and Robert

Rauschenber

.

ess than per

The ile to see the build up

of solid colors and the occasional misalign-

ment of •

You can us- "or and FreeHand to

,;h the com!

if command ussed previ

ousi

.

A good digi'

nof

This

prod

However, it is best to use Outline text for

the silk-screen effect as this achieves a

more convincing outcome. Originate your

text and create outlines of it. Leave the fill

transparent and place a stroke width

Use the Effects menu to roughen up the

^raphy. It is best to select a very low

•ntage—otherwise the result looks too

contrived and the authentic look is losl

Once you have completed these i

mat I the original

type >g the stroke to None and the

fill to a tpaque color. Using the

arrow keys, move the solid type .1 frai

.•a with tl

calligraphy brushes

Another wa, II typogra

look iphii

Silk sc reen punting

uses bold colors to

reproduce aitwoik As

with ,inv h.imli Lifted

piece, Inai ( uracfes aie

part of the look. For

example, the screens

may misalign causing

misregistration, an

effect that can be

generated in FreeHand

and Illustrator.

brushes rhese are located in the swatches

m Illustrator, Once used, these can change

the stroke on your objei I to approximate to

that of a calligraphy pen, with thiik and

thin lines if used sparingly and In the coi

re< 1 in look fairly cred-

ible As with many 1 -mm. mils, it works best

when combined with other effects to cre-

ate interesting typography. To obtain the

best results, experiment with the angle,

roundness, and diameter of the brushes

The ni< r • -Ireini 1 1 1< . 1 r 1

>
; I <

• ,ni«l Ihr \nyyy\

the brush, the more prominent the effi '

and vk e versa.



screen print effect s

View Window Help

Apply Last Effect

Document Raster Effects Settings.

Convert to Shape

Distort & Transform

Path

Pathfinder

Rasterlze...

Stylize

SVC Filters

Warp

Artistic

Blur

Brush Strokes

Distort

Plxelate

Sharpen

Sketch

Stylize

Texture

Video

. Type in your

desired text. In the

toolbox, select a

stroke color with a

background of None.

Free Distort...

Pucker* Bloat..

Scribble & Tweak..

Transform...

Twist...

Zig Zag...

Select Distort &
Transform from the

Effects menu, then

choose Roughen from

the submenu.

S In 1i the dialog box,

set Size to a small

percentage only. Then

select Detail in inches,

again to a small

number. More detail

creates jagged edges

when we want a

relatively smooth

result. Once complete,

copy the text and

change the stroke to

None and the Fill to a

solid color. Use

Arrange, then Send to

Back, to place the type

behind the original.

Then offset it slightly.

Points

© Smooth

Roughen

Options

Size:

1

l» 1*
A

© Relative

Detail:

_ Absolute

[4~ /in

( Cancel )

'^ Preview

Corner

Styles Swatche; Brushes Njbots \,®
i \ - •

25 so

^ '•30
- • /

35

•

# • — -

45

• •
65
•
ss 75

•

f H 4 + 9
zs?_^~—m^>"

— A

»

! nan

± Outjtline effects can

be generated using

Brushes. Select the

text then choose a

calligraphic brush.

Different sizes and

shapes will give

different results. Flat,

angled brushes are

best to give an

uneven outline.

OUTLINED TEXT

MISREGISTRATION
EFFECT

HALFTONES

CREATING OUTLINE
FONTS

6o

62

76

178
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glow effects

e are times when you want to fake an effect, such as neon light. Making objects look like

they are glowing is now relatively easy in Photoshop.

Tthis
mi\ the\

•nm-

.eryday envi-

eating the glow

• signs. Type can

outer glow, as well as a

Photoshop's Effects menu

— mand precisely for creat-

T he outer glow is similar

:ow. although instead of

producing a dar- ^ed copy behind

brighter one, making

• is though it is backlit. By

•>r glow again produces an

•er diffused tone, this time

•n how to outline text earlier

n (see pp. 60-61). You can

•ion of neon light by

• command with the

md also copying the

another layer using

such as Multiply or

a halo effect around

best if you

nvincing

•0 obtain

t of ton-

•lore

NEON GLOW

J Type in your

desired text in an

appropriate typeface.

Here, we have used

VAG rounded

# ( hoose

Load

choose th«

hannels

tab a^ 1 new
alph.i

ABCDEFG



glow ef f e ct s

RQ im*j( Live; StlKt Fillet View Winder- Help

undo n« Channel XZ J S'^=L W.-i-l

'
Vtp tetltwjrd XMZ

Cut

COPY

MX
KC

Mfli Into

(Ml

XV
f/KV

Check Spelling .

find jod ttpUce ir-i

Fill.

fn( Irtniform

Tr*n»'(>fni

"T
,

Define •mth

Pu-9« >

Pf»lM Mtmqti
.

n*on.trt> Jia*<AtCDtfC.Meni 1>

Channel Alpha 1

r 1

v/

, ...

Options

Z Z
S*Pr«Vl«W

34

5 Cli.lick back to your

layers in the Layers

palette and create a

new layer. In Select,

choose Load Selection,

choosing the alpha

channel you created.

I o>
I

±»JrfHect Stroke from

the Edit menu and

choose an appropriate

stroke width. Here we
have used 20 pixels.

Ilending

Mod* FWmaJ

Flfillin
1 the alpha

channel, add some
Gaussian blur of

between four and six

pixels. Select Curves

from Image &
Adjustments and give

the curve a distinct

spike to produce a

solarized effect.

Choose a color and

use Fill in the Edit

menu to color the

loaded selection. Copy

this layer by dragging

it to the page icon at

the bottom of the

palette. Select a layer

option of Overlay or

Vivid Light.

INNER GLOW OUTER GLOW

I

1 Select Layer Style

from the Layer menu,

then choose Inner

Clow. In the dialog

box, control the color,

size, and opacity of

the inner glow effect.

Uyer si vie

^•to "*1 0. 1

fnauow vw Cancel

New Mvle

tf Prcvww

e r n

aUrnm**

3
iff

(MM
_ He Oil

ABCDEFG

An outer glow is

created in the same

way as an inner one,

by using the Layer

Style command
located in the Layer

menu. The dialog box

has exactly the same

controls as for Inner

Clow, but the effect is

generated outside,

not inside, the type.

abedefg
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wood block style

e has been a renaissance in the popularity of the handcrafted look. Many designers are

ow s -eking to give their work a more organic, emotional, and less technological look.

W ^ has a unique

j of ink

he quality and texture of

nfluenceon the final

jme De is Vmce Frost and

g have used this traditional

production method to its best advantage in

own designs The drawbacks to this

production method are that you need to

havt- ) wood block characters and a

' ng press that can accommodate

3Stly and impractical.

though, there are ways to

raft By analyzing the

qualities of a piece of printed design

possible to replicate it. Photoshop has the

ability to use images scanned in grayscale

to be used as brushes within the software.

By defining an area of an image no bigger

than 2,500 x 2,500 pixels, you can simply

use the Edit menu to Define Brushes. All

you have to do is name your brush and it

will appear in the Brushes palette.

Alternatively there are plenty of free

Photoshop brushes available on the internet.

By scanning all manner or marks, from

ink splats to roller lines, the letterpress

characteristics can be recreated. The main

way of a< hleving this result is to generate

the typography and then use several

juely crafted brushes to distress the

ome. By overlaying the brushes it is

possible to produce the same results as

wood block printing, where the ink does

not print uniformly on the page.

The texture of real paper can also be

replicated by using scanned examples of

textured papers as overlays on the typo-

graphy. A Clipping Group or the Layer

Blending modes can be used to merge

these examples and produce authentic

looking printed results.

J can of a

. Doard. which

and . ire

The contrast has been

ng the

Levels command in

the image menu and

Adj .

ce you have

decided on your

area, select Define

Brush from the Edit

menu Name tin-

brush in the

dialog box.

the

Marquee tool. <;

'•a to be made
into a

Setec

the tool or. 1

setyc

to a maximum of

2.500 x 2.500

' ''.

1 il,

,

ic new brush

'h 'MM ..['i 11 tin

Brushes palette



wood block style

$Untnkd-l g 33 3KIAKDEFC, CMYK)

Z CerGenerate your

typography, then

rasterize it using the

Layer menu. Select the

eraser and begin to

use your new brush

to remove parts of

the letterforms. You

may need to use

several brushes to

obtain a more

credible result.

E
t*. Photoshop File Edit Image Layer Select Filter View Window Help

& *| fc-f. * *j Mod. Brian JT) *nv lull 7l f\=- 101/. >) ;*J, &wTeM*lvy

«^o :;—
$ Unllll«d-1 £> 33J* (ABCDEFC, CMVKt

i Specialist brushes

constructed from

scanned artwork have

been used to distress

the typography. This

replicates the effect

of letterforms printed

with a letterpress.

With some practice

it is possible to

produce some very

convincing results.

~kfi

*.

t.T.

Ota

ABCDEFG ;you build up

the effect, the type

looks like it has been

printed using

a letterpress rather

than created using

computer technology.

t
MISREGISTRATION
EFFECT

CUSTOMIZING
LETTERFORMS

AMENDING
EXISTING TYPEFACES

62

94

'5*
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distortion filters

Many pieces of software allow the designer to distort typography. Photoshop is one of the

most effective, and a variety of effects can be achieved using the Distortion filters.

Eges and

to dis-

that are

•^d.aswe

havrr • can

rography with excel-

menu are

ids as Twirl. Shear. Pinch, and

>e commands work by manip-

e typography sits on.

Ice placing the type on a piece of

moving the fabric around

you get the result you want.

sequence for the movie The

Van Castel distorted the text

to make it appear as if it was being viewed

through a crystal ball, magnifying and

beveling the type. This was achieved

through a mixture of traditional photo-

graphy and computer-generated text. With

the filters in Photoshop, it is possible to

attain similar, but less complicated, results.

You can manipulate the text so that it

appears to have been pulled in or pushed

out from a central point using Pinch; it can be

mapped as if lying on a plane that has been

pulled sideways using Shear; or placed on a

convex or concave surface with Spherize.

Along with these filters, Adobe have

introduced the Warp Text command, located

in the Layer menu under Type. This func-

tion/command takes many of the distor-

tion filter options and adapts them specifi-

cally for typography. It is possible to war:

the text in a variety of ways, such as in a

vertical or horizontal arc. arch, wave, 01

bulge, to name but a few. You can contro

the amount of distortion and transfei

between horizontal and vertical axes tc

achieve a multitude of variations.

These functions, coupled with filters

allow you to change the look of the typo-

graphy drastically, making it look as if it has

been twisted, curved, or even photographec

with a fish-eye camera lens.

ABCDEFGH .»o»h<P



distortion filters

»nn ^ Untitled-l (ffl 33.J%<ABCDEfGmjKLMNOP. CMYK)

ABCDEFGHIJKLMNOP

1 After generating

your text, rasterize it

in the Layer menu.

Then select the area

you wish to apply the

distortion filter to.

sleet Distort

from the Filter menu.

Select from the range

of options, in this

case, Spherize. In the

resulting dialog box

you can see a preview

of the effect and can

control the amount

of distortion, either

positive or negative.

This wiil make the

effect come forward

or recede.

ABCDEF

i. w,arpText has

several options, such

as Bulge. This option

expands the text and

increases its size in

the center to make it

bulge outward.

II

v/t 8»">o* :
I

«Hori*onul vtn*tt

>

C*«»l

Una .SO

Momenul Oil ton ion

Wrimi Oiiiomon

± Am

«*» It.T

E Tw»l

*.

HWifOMjl DMUM1

V.llltil OlMart«n LI

X Another option in

Warp Text is Twist,

which, as its name

suggests, allows

you twist and bend

the type.

nso try the

commands Arc Upper

and Arc Lower, which

distort the text by

making it bulge across

the top or bottom.

©1

t

1

- SHADOW EFFECTS

PERSPECTIVE

WAVE, ZICZAC,
AND RIPPLE

LIQUIFY

64

74

104

108
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wave, zigzag, and ripple

nave looked at some of the filters Photoshop has to offer but there are several other

ways in which you can distort your typography.

k»^ «; the Liquify tool. In the

mmand are the Wave.

notions. Whereas the

re pp. 102-103) acts to

- type on curves or arcs, these other

;w liquid effects to be added

to your typography. These effects are more

e and replicate the distortions you

see when you view objects through slow-

mc. . d.

ZIGZAG

The Wave filter allows you to control the

number of wave generators, the amplitude

of the wave, and also the type, by choosing

Sine. Triangle, or Square.

The ZigZag and Ripple filters affect the

typography by making it appear as if it has

an undulating surface. ZigZag distorts the

text both horizontally and vertically to pull

the characters in different directions around

a central axis. This forms concentric ripples

which makes the type look as if it is lying on

. The ZigZag filter

r.asa var.etyof

I

determine the final

effect You can control

the Amount and

fridges using •

sliders The tr
\

we have used

Around Centei

a watery surface. You can control the type of

zigzag by selecting settings such as Pond

Ripples, which is like a droplet falling on a

smooth surface, or Around Center, which is a

rotation around a central point.

Ripple is the less sophisticated of the two

filters. It can be set to make the characters

appear as if they were at the bottom of an

undulating pool.

Using these filters can be time consum-

ing and if not used with some thought, they

——--—-—

fck-Lhe Pond Ripples

style replicates the

effect of a droplet on

smooth water. Also try

the Out From Center

setting, which has a

similar effect.

abccfef



wave, zigzag, and ripple

can provide relatively contrived results. They

need to be experimented with and practiced

so that you understand the kind of results

you can achieve with them.

They do not have the degree of control

the Liquify command has, but they do pro-

vide a large array of results. These need to be

used in conjunction with each other to gain

the best effects.

There may betimes

when you want to

make your typography

look as if it is being

viewed through

some kind of liquid, as

if it is at the bottom

of a swimming pool.

If used with a little

thought, the wave,

zigzag, and ripple

filters can provide

this kind of

distortion effect.

WAVE RIPPLE

JH The Wave filter

makes type look watery.

Set the Number of

Generators, the

Wavelength, the

Amplitude, and the

Scale. Use a smaller

number of generators

for a more convincing

effect. There are also

different types of

wave—Sine, Triangle,

and Square.

Numb*' of Ont>*<0'i * Q.

IHn Mu

Sul*

Horn

10

HO

* 51

*/V<fc?/

- ^

'" B-P.JI lUll. Rttb

*& The Ripple filter

ripples the solid edges

of the typography

rather than working

from a central point.

bnplr

. « )|
,„.,„ 1

M
to*

ftMWM -is; x

ROUGHEN, ROUND,
SCRIBBLE & TWEAk,
PUCKER & BLOAT

PERSPECTIVE

DISTORTION FILTERS

LIQUIFY

68

74

102

108



the complete guide to digital type

ghting effects

Creating and controlling lighting on objects is a feature usually associated with 3D

software packages. However, Photoshop can also produce some lighting effects.Ale the

-ated

go some

ice.

^hop uses allows

ent light

ach of these

:>l the intensity, posi-

.nd color of the light, along

of the surface on

ejected As we have seen

es. you may want to

focus additional light sources on them to

make them appear more realistic. Your

results can also be used in conjunction

with layer styles such as Drop Shadow and

Bevel & Emboss to further the illusion of a

three-dimensional object.

Lens Flare is one filter that you may

want to make a note of. Although photo-

graphers usually go to great lengths to

avoid this kind of reflection appearing on

their photographs, this filter adds halos

and "hot spots" that mimic light bouncing

off a camera lens It has limited uses but it is

a credible effect when used along with

other filters, such as Lighting Effects.

We have already seen how Outer Clow

works (see pp. 98-99). When used on typo-

graphy, text appears to be lit from behind. If

the typography is the same color as the

background, the effect can have more

impact. Combine this with Bevel & Emboss

and a very subtle gradient using the glow

color and the type color as a way of creating

a convincing piece of typography.



lighting ef f e c t s

£t Photoshop File

Auio S«l«t layer

Edit Image

Show Bounding Bo.

Layer

r:.p...

A, 7.

-.•
.

J.

'

H -

1°.
. . . I'.

Select

j

View Window Help

, I',. ,,
!•
,, ..I

Extract...

Liquify..

Pattern Maker.

Artistic

Blur

Brush Strokes

Distort

Noise

Pixelate

xnx

xoxx

RC31

...i-.'...i-?...i\t ...iv...r.'...i?...K 1

30 Transform...

Clouds

Difference Clouds

Lens Flare...

44 Generate your

text, then rasterize it

using Type from the

Layer menu. Then

select the Lighting

Effects command in

the Filter menu.

Doc 7 38VI/1-J9M

Photoshop File Edit image Layer Select QQI Vievv window Help '••v.. r. & <~Vrvi |( .

UiMr* W«i.

WfU XGII-4WI

n-

!./• i ,t. •*»<**• _m
80*

-^. to M

....
— n

r" .... »„

_M "-" ~—

,._- «.. i Ow

™_«. ..... i ~»-

SI

w

» inli the dialog box,

it is possible to

choose from several

light sources, their

direction, the material

the light falls on, and

the exposure. There

are several styles of

lights to choose from,

including single and

multiple sources. You

can also change the

color of the light.

This filter effect can

take some practice

to master, so plan in

advance what you

want to do.

l»-#hother popular

effect is to use Lens

Flare, which gives the

appearance of light

being reflected off

a camera lens as it

takes a photograph.

This is also found in

the Filter menu.

Wi1Zith this filter, you

can choose from the

type of lens it mimics,

the brightness of

the flare, and the

center point.

Cancel

Lent Type

© SO- JOOmm Zoom

* Apply the same

Lens Flare effect to

the background as

well. This unifies it

with the type

—

placing the flare

on the type alone

may not look

as convincing.

• CLOW EFFECTS 98

• TEXTURE EFFECTS no
* OTHER EFFECTS 112

• METAL EFFECTS 116
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quify
.iquify filter allows you to give a sense of movement to your designs. It enables you to

twist, warp, stretch, and generally distort any layer.Lnal
Deen trans-

d allows

ty of ways,

ety of useful

e the effect in a

.iso freeze part of

m distortion and

ifeas. The other tools

and are Freeze. Thaw. Warp,

: Shift Pixels.

CLASS EFFECT

The benefits of using this particular fil-

ter instead of the other distortion filters are

that you can immediately see the effects

full-screen and can use different tools on

the same piece of artwork simultaneously.

This allows greater control and flexibility

and produces very credible results.

glass

The Glass filter produces a life-like effect

and works best when text is placed over an

J •
•

best over an image

Here, we
have used an image

from New York Create

your • .a

okJ

H ....jphcate the

background layer and

move it above thet <l

layer. Select Displace

from the Distort

command in the I liter

image. Thanks to the clipping groups and

Bevel & Emboss, the effect is easy to

achieve and looks very authentic.

In effect, what you are doing is copying

the image, distorting it, then viewing it

through a clipping group with typography.

In other words, by using the Displace filter,

you are able to place a distorted image

inside typography and then add depth to it

by using the Layer Styles to give an inner

bevel. The shadows and highlights can be

set to specific layer blends, such as Multiply

or Screen, to complete the effect. This makes

the type appear raised and translucent.

menu. In the dialog

box, locate the

Photoshop 2 file you

saved The software

will use this text to

displace the image.

.new

Load your text layer as

a Selection at*.

Gaussian blur to

softe' H be

used tod

image in a Photoshop

2 format

« CrrFeatea clipping

group between the

displaced image and

the text by clicking and

holding down the Alt

key on the line that

eparatesthe layers.

Use the Layer Style

mi nu toadd an inner

bevel and drop shadow

to the text. Finally

adjust the levels on

III. lll',|ll,ll Cil llil.ll'l

to make it appear

slightly lighter.



liquify

$f ""•*"** dies, ut vina, poei^sS&JlPdcftc, scire ,,/,>,;, cfiar&spsetium quotus
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The Liquify filter can

produce a watery

effect on your text.

The variety of tools in

this filter means you

can distort the text

but exercise a degree

of control not possible

with the wave, zigzag,

or ripple filters.

LIQUIFY

-* Phoiothop File EOit image Liver '.«'*( r QO VH
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Ex trie
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»'Si m*l«x»dm, ui
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!'...V.l

Et, scire velim, charlis pretium quoins

» [entum qui decidit, inter perfectos

at(|ue novos? Exrludat iui^ia finis.

lerficil annus." Quid, qui deperiit
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an quos et praesens el post era respual aetas? Isle quidern veleres inter

[xmetur honeste, qui vel mense hrevi vel lolo esl junior anno." I tor permisso.
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annis miraturque mini nisi quod Libitina sacrt ^

o
$. JJne filter provides

a variety of type

effects, such as

Pinching, Twirling,

Smudging, and

Waving. You can also

3 Liquify works best

with large portions

of copy and can be

rendered over images.

Generate your text

then select the Liquify

command from the

Filter menu.

|9

A
1

freeze certain sections

so they remain

untouched. You can

produce some very

interesting results

with this filter.
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texture effects

here may be times when you want to make your typography look as if it is made out of

something other than printed ink.

D
looking for new

• rticularly

>ing, or on web

jally stimulating

e more to stand

vpography involving

woe can be used in a way

designs sometimes can-

say something new about the

website or product.

WOOD EFFECT

There are several different ways of pro-

ducing textures. The traditional method is

to take a photograph of the appropriate

texture and then scan and apply this in

software such as Photoshop.

With looming deadlines and perhaps no

access to the relevant texture, this is not

always feasible. Software developers have

recognized this and Photoshop now has

the capability to fake textures quickly and

easily with some degree of credibility. The

effects are more believable when they are

subtle. Textures can be applied to the back-

ground or, if it is bold enough, to the typo-

graphy itself.

Using an combination of the Noise,

Render Clouds, and Texture filters makes it

relatively easy to fake a number of appear-

ances. Brick, wood, and slate are all attain-

able with the software.

1 ng the Filter

menu, apply Add

Notse on a new layer,

then use the Blur

commands to give the

Notse a Motion Blur

To give the texture

more of a wood grain

look, add a Wave
distortion filter. This

gives a more natural,

less linear, look.

M- 14

( o.

l«Mr«*r* 21 UK
**

U0MM

'
tfCo4o.„.

xize the menu it takes some
to obtain the

correct hue, saturation,

Adjust m the Image and light'

-i

—

e—t—b

—

r,..r ,r i i i i— i . . . .

i

-. .

i

-. a- i- r >>

M M« <M |

•»» m m
i NvwUyt*

| I-. .-. m

*

Q̂
-Jype in your text

and move the layer

with the wood
texture above the

text. Hold down the

Alt key and click on

the line that separates Use the Layer Style

your text and wood
effect to create a

clipping mask. The

texture should appear

Inside the letterforms.

menu item to control

the Bevel and Emboss

function. Add a drop

shadow to create

some depth.
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SLATE EFFECT

J
lotoshop

Create a new layer

and use the Render

filter to create clouds.

In the Image menu,

select Adjustments,

then Posterize from

the submenu. This

commands flattens

the tones of the clouds.

File Edit Layer Select Filter View Window Help

Mode

Stftf CwIjuIi ty

u..

T>Uqhl Typ* Orw.

gOn
r

full

69

Mine Shiny

flJItPC
Mtttntt

Metallic

Ur«J*.
Exposure

" Over

Negative
Ambient*

1 —-

Texture Cn*nn*. AJphj 1 5J

fitf White >i Mcjr.

Hriffhl "*'
19 Mounuinooi

I

1

....!'. ..I' . .A'.. .1-.
. I'... I

s
.. I-....I'....!'... I'. ...I: ...I ....I.-. I ..I- I". .I'"...!- . I

1

".
. .

|->.
. . I-

i Select the Lighting

Effects from the filters.

Choose Omni in Light

Type and position it

where you want it. Set

the Texture Channel to

Alpha i. This uses the

rendered clouds you

generated earlier to

act as the texture onto

which the light source

is projected. You can

also set the Height of

the texture here, either

Flat or Mountainous.

Relatively flat is best.

Hue/Saturation

Hue 209

Saturation 7

Lightness -n

Cancel

,,„

^Colorize

5? Preview

Channels Paths '

ESS > «-

EH at

HJjoc X2

-

WgM - S3

EH »>*•< K4

1 Usising the Blur

filter, apply a Gaussian

blur to soften the

texture. Use Select All

and copy this. Select

the Channels palette

and create a new
channel. Paste your

copied texture into

the new alpha

channel. Use this later

to create the texture

for the slate.

M As<Is you did with

the wood effect, use

Hue/Saturation to

colorize the texture

and give it a slightly

blue cast.

i

1

i

i

BLUR FUNCTIONS 70

LIGHTING EFFECTS 106

OTHER EFFECTS 112

METAL EFFECTS 116
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other effects

There are several other effects that are easy to produce. However, use them with caution-

used on their own, they may not always be credible.

perforated edge

p is a good

. e look that

wor» Dff effect can be

:ious when using

ake the edges of

jnd undefined,

jse very bold sans serif char-

are too fussy and have

es to allow you to achieve

• properly. By using paths and mak-

^m brushes, you can stroke the

edgr ath in a consecutive manner

)k serrated. Couple this with

to complete the look.

PERFORATED EFFECT

J
I

Generate your

type, then with the

lyer selected,

load it as a Selection

using the Select

menu. In the Paths

palette, select Make
Work Path. Keep the

Tolerance low—about

0.5—to make it as

close to the original

as possible. You will

see a vector pathway

created around

your type.

-

•5 Untitled- 1 *1IH ubc. CMYK)

.i'....K...r....i»....i»....r»...r.v..iv...r.v..i\'...r.'...iv'...iv. i"

•I l«U H.U

nn".?!lJ1H

Palette Options



other effects

o
Layers

Normal J j
Opacity: 100% ;!

!-• ' J J + & FM:|100* H

* > |i
\**~

9
1 T |*«

[
Background 2

o. a |
a 1 ©. a %

Brushes

o
± Create a new layer

in the Layers palette

to generate the

perforated edge.

Brjsn Presets

Brush Tip Shape

_ Shape Dynamics

Scattering

• :ure

_ Dual Brush

_ Color Dynamics

0:h*' Dynar»vcs

Moise

'.Vet Edges

Airbrush

_' Smoothing

|
Protect Text'-'e
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•
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•
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•
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45

•
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•
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•
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•
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X, H i ft It i
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13

Angle: |0"

Roundness:
1

100*
|

Hardness

o
too

*4 Spacing 1S1-*

TT-

• •

a l * l

4 Crereate the brush

necessary to complete

the effect. To do this,

open the Brushes

palette and select

Brush Tip Shape. Set

your diameter to 12

pixels, hardness to

100 percent, and

spacing to about 150

percent. An example

of how this will look

appears at the

bottom of the palette.

Select the Work Path

you created in the

Paths palette and

select the Brush tool.

In the Paths palette

drop down menu
select Stroke Path.

A series of dots will

appear around

your text.

Photoshop File Edit Image Layer £ [| Filter View window Help «9

©

B

» — a

9 txt^TUV a

<< In tthe Layers

palette, select the text

layer again and load

the text as a Selection.

Click on the layer with

the dots and fill the

required color. Load

the Selection again

and create another

new layer. In the Select

menu choose Modify,

then Contract, from

the submenu, and set

it to 10 pixels. This will

create an inner shape

on the text. Fill the

selection with a color

of your choice. Here,

we have also added a

background color and

an inner gradient and

drop shadow.
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Other effects continued

rough textured surfaces

.eto

iters are

startling

'i filters and

such as Bevel

vou can

nal surfaces on

:-m \ \

HAMMERED EFFECT

abci

3
and.

menu, apply Add

d»
andchooiet

fron

add-

N

Smooth'
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other effect s

three-dimensional depth

Photoshop's filters offer this function. By

using the Motion Blur filter to a consider-

able depth you can induce a large drop

shadow with a soft edge. Changing the

curves on this drop shadow so that you

have a very sharp cut-off solidifies the

shadow into a hard-edged shape. Use the

curves again to clean up the edges. Paste

the original text on top in any color other

than blackfor a three-dimensional shadow.

THREE-DIMENSIONAL EFFECT

(A r\ r\ 3D Depth.tlf @ 33.3% (ABCD. CMYK)
:

I I', , . .

!' K .
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I

1 -

I

7
. . .

1" p. |':J
, . . 1: . . . I>, . . I I'.-. . . 17. . . I

°.
. . 17. . . I'

1

.

5
.

- ABCD
Layarj _.«
Normal T) »«.. *

' • ;J / + a

Ij
J jABfOtop,

• >Prrt*oco

» |L
BJCMgroved a

Curves

c i-annel CMYK i
|

I
OK |

L^nfel

Loid

( Sm.... )

( Auto )

Options

1 1
Output 100 *

|/|/|/|

34

j....r....K...i'.

Doc 9.84V-

, Generate your

typography in a

suitable font. In the

Layers palette, copy

the text layer and

rasterize the text.

Move this below the

original text layer. This

will form the shadow.

».l a I
a

| cm a *

O
Using the Motion

Blur filter, blur the

shadow layer in a

suitable direction.

Here we have set the

Angle to 55 degrees

and the Distance to

225 pixels.

- lOOti BCD. CMYK)

.i'....r. ...i'....i-:...r.' .1 ....I.- . I'.'.. 1. 1'.'... I'.'... 17

ARC1*
,,.. fl

>W» >

s IM

Angle

Distance

i"t
—

O
22i pixels

3<4 To make this layer

more solid and less

translucent, use

the Curves in

Adjustments from

the Image menu. To

sharpen the edge,

the curve needs to be

almost vertical at the

beginning. Repeat this

step to solidify the

type completely. Then

move your text layer

to the correct position

and set the color.

r- <> BEVEL AND EMBOSS 66

LIGHTING EFFECTS 106

TEXTURE EFFECTS 110

METAL EFFECTS 116
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metal effects

As the number of commercial websites increases, designers have to make their logos stand

out above all others. As well as wood and slate effects, metal finishes also work well.

Trnmunicate an

mting at the

•i Without realiz-

atters to

be presentee .ular ways. Adding a

.pography can give clues

. re of the message being com-

the text or the nature of

ubject matter Type involving aerosol

nmediately gives a "street" look.

Type involving big round plastic letters indi-

e target audience is children.

To create that all-important texture,

Photoshop is the most effective piece of

software it can recreate a large amount of

:ures with relative ease.

Metal finishes can make typography

imposing and different types of metals

have their own personalities. In the 1970s,

designers used airbrush techniques to get

a stylized chrome effect. They built up

images with painstaking detail to achieve a

smooth, reflective surface. Photoshop can

achieve the same effects without the need

to build up numerous color layers.

With a mixture of a Gradient Overlay and

Bevel & Emboss you can obtain a chrome

effect in minutes. This can be improved on

Uing other layer options such as Satin.

Inner Bevel, and a small amount of distor-

tion. It is also easy to create other types of

metal effects, too. Using the qualities of the

metal as inspiration, you can create smooth-

brushed aluminium textures using Noise

and Motion Blur filters. Rough cast metal

can be recreated using Noise, Relief, and

Bevel & Emboss commands.

1 hese textures can then be accentuated

with Lighting Effects and layer options to

provide a three-dimensional effect on two-

dimensional typography, The effects can be

very convincing.

The chrome look was

very popular in the

197c .vas

achieved by applying

several layers of paint

, an airbrush

Now. it is easily

.i?d using

software

as Photoshop



metal ef f e ct s

CHROME EFFECT

i Generate your

type. Here, we have

used Mistral. In the

Layer Styles menu,

select Gradient

Overlay and choose

the blue and brown

gradient. You can

customize the

settings by clicking on

the gradient bar and

moving the sliders.

li
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A.... K .

.
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Name Chrome

CradientType Solid % I

Smoothness 100 ~*\%

d

I
Cancel J

( Load... )

( '"* )

1 c

:

StyU:
J

Urwtr
~
*") ^ Abon *.'h Lj,»i

-o

Cancel

New Style

^ Preview

5 Gnjve the text more

depth by applying the

Bevel and Emboss

Layer Style from the

Layer menu. Set the

style to Inner Bevel.

SbftAng Optwu Oalult

- M '--

S*W1

CottrOxrW,

f^l.ifi 0.0*,

st ,i. t-n.r b, ,^ ; 1
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Cancel

Nf« Style

5? Preview

LJyi- Style
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"O" t* i,.(*** L^M

Ouirtv

5

rt in-riOwtiCMLVe,.***™.

3c
Cintel

n*w Style.

1 Aceccess the other

layer styles in the

same palette. Activate

the Drop Shadow
option and apply a

small drop shadow

to the text, along with

a slight amount of

Satin to bring out

the highlights.

. r. ... k ... p. ...i*. ... p. ... i'. ... r. ... i». ... p. ... i?. . . iv . . . r.-. . . i ?. . . i-. . . k. . . k' . . . iv. . .
k«.

•

u + a »!«»

•

*

1 I n-.-irft rrrbwyHl

i [
1 crdrrinrwSMlHrjt.

* ISttl
^''> s "'n

<Xa/] - ''- -

• ! a

_ „ .o.,a -, e.xi-

—

XWsePse the Create

Layers command in

the Layer Style menu

to turn each of these

effects into separate

layers. You can

now adjust them

individually by adding

filters. Select the

Gradient Layer and

apply a Wave filter to

it to soften its strong

horizontal line. Finally,

apply a Gaussian blur

to blend the colors.
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metal effects continued

CAST METAL EFFECT

d

:>se

lenu

-—about 10-15

es the

lumilW-IJliUlUyii l.RC»l

f r. f. r....i'....i'....i'?:..iv. 1- 1 r- r- . tv .1- r<

Smooth nesi

A

Light Dir Top left

a to.1 obtain the look

of cast metal, select

the Bas Relief filter

from Sketch in the

Filter menu. You can

control the Detail,

Smoothness, and

Light Direction in the

dialog box.
Ok 7 it*

Hit' Sty*

llrwtwi

tap*

DMMta-

M*l

,,,

MW»»w* :

: * •

:

Dm*

-

•

A*taj

ta»r

1*"im(M*

M
kw •,

««•> ^1

*L_^ y. add s r

Effects to the

edge of the type to

ok more

^ere. we
'• used a Spotlight

xus. To

complete the efl

Drop Shadow.

:.~

-

I

«< re make the

texture appear

recessed, apply a

Bevel and Emboss

layer style. Select an

appropriate Depth

and Size, making

sure Direction is

set to Down. W mmm
Distance 7S pixels

± Loa:>ad the text as a

Selection again, apply

Add Noise, then

rasterize the type

layer. Apply a Motion

Blur filter with a

diagonal angle to

provide the machined

edge to the text.

Contract the selection

by the same amount

as you did before and

delete the inside. To

make the edge look

three-dimensional,

add a Bevel and

Emboss to this layer.



Several filters have

been applied to the

background to make

the type look as

though it has been

cut out. These effects

could also have been

applied to the text

itself, to create an

aluminum look.

The letterforms look

as though they have

been made up from

cast metal. This

effect was generated

through a process

of building up

several filters.

ALUMINUM EFFECT

.r....R...l'. .I'....!'....!'....!'. ..I'... A'.. I ... I .1.1.1.1.1/ ,.i:. ..!.»... I.-.
I i .IK I- I-

.
F. ... I'. ... r. ... f. ... P. I' I

.
I> I.' :.!'. ..!• ! ..I.-...I.-...I:

Distant* 22S pixels

|L

.

3 Fill a layer white

and apply Add Noise.

Then use the Motion

Blur filter to replicate

the polished surface.

Choose an Angle

of zero and a high

pixel Distance.

»• Apty>ply some
lighting effects to

this surface. Here,

we have used a soft

Spotlight with a wide

focus. Set the Texture

Channel to any of the

RGB channels and set

a fairly flat Height.

if*. OK**! :

s

* M

Pmmi
"""** WWr

««,
<». —
-™, «— *.,..

w_ "~" s (Ml

»*™. — T
~ ~~

.
Pititn- Qvfi.»

Layer Style

hw*r Sl**.»

Wfhn

**•:( * .«ClcMWi

| OK |

t JdCll

N P« StVfe

^ Preview

]enerate the type

on a layer above in

white and apply an

Inner Shadow using

Layer Style to make

the text look cut out

of a sheet of metal.

t
CUT OUT AND CUT
UP EFFECTS 88

LIGHTING EFFECTS 106

TEXTURE EFFECTS no
OTHER EFFECTS 112
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editable text using HTML
HTML is the basic tool used for writing and constructing simple web pages. Limited

typographic detailing is possible by using Cascading Style Sheets.

.een

is to

This

tor's end

g is very

basic types

oroportional

^nospaced. These are the

•ney are the only

:ole on every

HTML

crosof

Word doc

construct a ve' .

.

eeds

age

<r brows*

j$a

•gs

cascading style sheets

The World Wide Web Consortium devel-

oped the language of Cascading Style

Sheets (CSS). Its function is to work along-

side HTML in order to give the originator

more control over the typography.

What CSS does is take all the instruc-

tions regarding the font and centralize it. It

offers the designer a way of formatting the

text to refine how it is displayed in particu-

lar browsers. It embeds a set of instructions

in the page that controls letterspacing and

leading. It also allows designers to specify

size, color, weight, case, and line endings

along with the type's position on the page

AIICOI l(.

*T~.' ~iage shows

•bovecoc'

to

body copy, and a web

typeface, size.

. I

copied and pa

These directions then apply to all the

typography contained within the site. You

can apply different styles to "blocks" of text,

thus gaining some control over how the

type is presented. Most browsers support

CSS and any that have difficulty with it just

ignore the coded instructions it provides.

Dreamweaver has been set up to pro-

vide this complicated coding within the

software to try and make it as easy as for-

matting text in any page layout software.

For those wanting to use specialist fonts

and preserve typographic detail there is

another choice—creating text as graphics,

ulm h can then be placed on the page.

mi t*o Otxumtnt

. .Mb WEI -

ABCOEFGH

Si rnclKMl dlt* ut . chufepltt iqUORM

nnpuif rftiii i iquldcctul unci pSfRXKH igMNOJIM rvlcm

nova '

I icIudM

ifUl pCflhll •'<

6 Quid «(ni .Vjviiit miimr imo rikiw I flM HlW
|

,

IJKLMNOP
(ii.l.tiui.' . in«ii' qui vtlanMbnvlvilnoM

in npemtma c* . \cllnonum Jcnm

Lium Ml
tadki • in-" ii in fvn i n

nihil m < mi)

i ii,*-Jtiis simple page

was creati

Dreamweaver. The

text has basic page

formatting. The copy

runs almost .ill the

way across the page.

We have used thi

Return keystroke

to put in line breaks.

ng resized the

browser window to

make it smaller, you

can see it has moved

the "live" text around

ii the window to

make it all visible.

i lowever, the line

have produced

/ formatted text,

wilh l.irge gaps

i it



editable text using HTML

CASCADING STYLE SHEETS

CSS Rule definition for page

Type
Font T*nei New Roman, totes, sent

SIM Mi © P"*H T) We-gtW

Style normal Q

Oetofition underlm ColOf gJBWKilwo

i«m

a Cascading Style

Sheets work in the

same way as the style

sheets in OuarkXpress.

From the CSS Styles

palette, select New
from the icon. You can

then use the left

menu bar to select

the items you want to

apply the styles to.

AW, Cjn,«l Chk I

3u can control

the Positioning of

the text within the

browser window
by using a variety

of measurements,

such as pixels

or centimeters.

CSS Rule definition for page

Category

Type

Box

Block

Box
Border

Ust
Portioning

Extensions

Width 600 |:| pix. :) Float

Height 800 |7) pix T) Clear

Padding Margin

</ Same for all

Top (7) Top.

Right Right

* Same for all

:

Bottom

Left

Bottom

Left

CSS Rule definition for page

Type
Background
Hock TVim '

.'.

1

:

W gr>r 100 m

Top 40 :' ,... T)

Ugh) ' R

MUbHtiy u
MntM. :
Overflow

e

8
1,1, w : ,.

:'

Righl 1 = 1

I

GEE)

'

c"-'
.

: G«3

( Apply ) ( Canctl ) ( OK )

X rheie Box tab allows

you to control the

width and length of

the box in which the

text is sitting.

ft '"> *~\ Untitled Document

j
[ C 1 j

+
f

- nle ///Users/ae6/Sites/vveb/UnMled-4.html Q-

CD Coogle Amazon.co.u VDs & more Welcome to S University Cuardun Unlirrmed Apple Mac »

ABCDEFGH
Si mi-lioi ;i dies, ut vina. poemata reddit.

scire \ 1dm, chartis prctiunt quotus arroj>ct

annus, scriptor abhinc annos centum qui

decidil. inter perfectos \ eteresque referri

debet an intervilis aique nnvns? Excludat

iurgia linis. OEst vetus atque probus.

centum qui perficit annos. () Quid, qui

deperiit minor uno mense vel anno, inter

quos referendus erit? \ eteresne poetas.

an quos ct praesens et postera respuat

aetas?

IJKLMNOP
Olite quidem \ cteres inter ponetur honeste.

qui vd mense hrevi vel tOtfl est Junior anno.

(> UtOf permisso. caudaeque pilns ut

equinae paulatim scllo unum. demo etiam

unum, dum cadat elusus ratione ruentis

acervi, qui redit in fastos et virtutem

aestimat annis miraiurque nihil nisi quod
Lihitina sacravit.

<« Ifyi

QRSTU
Enniiis el sapincs el fortLs et alter llomcruc.

ut crilici dieunt. leviter curare videtur. quo
prumissa cadant et Minima Pvthagorea.

Naesius in manihus non est et menfibus
haeret paene recells? Vden sanctum est

ryou apply these

commands to the text

used above, the

formatted text

occupies a smaller

block within the

window and there are

now no awkward-

looking line endings.

CSS Stylet - Layers

' «l

«?.

I Current

AIIR..Ir»

< stylo

itytel

ifylej

• -PrapenUt for -.iiyl«2'

fnnt firmly Timet New Roman". Ti

it Ibpi

ve normal

color

l.nt height

Ion i weight

t««t iramlorm

tone varum

ie«t -decoration

Wni

te»t- shadow

lOnl-S'ie-ifljutl

lOfll KFtKfl

tfractton

Unicode - to.

»• lickground

T flock

word-spacing

letter-spacing

yertiCJl-jlitjn

Kit- indent

nM»-fpK(

SispUy

lorder

V toi

width 6tm

height

r-oat

'is possible to edit

all of the properties

for a style sheet using

the CSS Styles palette,

by clicking on the

chosen style and

making amendments

to the requirements

as needed.

t

I
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the complete guide to digital type

bitmap and GIF images
Since you cannot predict the fonts installed on a user's system, it is better to use images to

ensure that your typography doesn't default to the fonts used by the browser.Oadd
spe b page

peas

another software

ats that

-ed images. They are

iat developed by

<perts Croup) is

ig photographic images

continuous tone. GIF

ge Format) is better

ges made up of flat color, such

t are

>m

colored pixels as

opposed to an

nose

used

•

two letters abc-.

one'

been getr

Photoshop, and,

although it uses the

antialias function,

the limit on the

number of dots per

inch (dpi) results in

a jagged edge to

the letterform The

character on the

right has been

generated in Illustrator

and has none of

<* problem

Creating your type in an image fon

means you can experiment and present

texts in any font you wish and apply a whole

host of effects, such as drop shadows and

texture fills. You have more control over the

type than pure HTML will allow. Many of the

effects detailed earlier in this chapter can

therefore be applied to web-based images.

The disadvantage of using type as an

image is that every pixel has to be rendered,

which makes it slow to download when you

have several making up a page, even if com-

pression rates are high. It is also no longer a

piece of "live text" that can be copied or

pasted, as with HTML. Search engines can-

not add it to their databases, and you can-

not embed hyperlinks.

With this in mind, use GIFs and JPEGs for

creating title text, headlines, or rollover but-

tons only. This allows you the freedom to

experiment and create eye-catching typo-

graphy where particular attention has to be

paid to the detailing of the text. However,

these formats are not suitable for body

copy—for this, use typefaces that have been

designed for the screen.

± Here you can see a

typical print image at

300dpi. The shape of

the outline is smooth

and consistent with

'•ly good detail.

1 The same image

has been reduced to

72dpi, the typical

screen resolution.

I his version has lost

I I'll III (IH. Ill ,111(1,

when enlarged, shows

jagged edges.



abcde

abcde

Titles and

navigation bars are

the best places to use

bitmap or GIF images.

Here you can obtain

subtle effects not

possible with "live" text.

In this navigation bar

we have used simple

typography and arrows

to click between pages.

When a link is clicked

it becomes the focus

of the navigation by

making it the darkest

element in the bar.The

other links are still live

and when clicked will

also behave in the

same way.

i This is text saved

as a GIF image.lt has

been designed to be a

button on a web page.

By using images of

text for items such as

buttons, title text, and

headlines it is possible

to produce a range of

possibilities. Rollovers

can look like the button

has been depressed by

changing the color

and even the depth

of a simple bevel filter

in Photoshop.

biography typography

c c C

contact editorial illustration

gntzqu
TM

abc dgp

± One of the

advantages of using

GIFs is that you can

always use your own
fonts, such as the one

above, in titles, headers,

or on buttons.

bttfnfh IffWtfll

imlt:l tMmil illvslnltni

contents

i GIF images can

be used to display

modern typographic

designs without being

constrained by the

system fonts.

I
*
i

i

SHADOW EFFECTS 64

BEVEL AND EMBOSS 66

ANTIALIASING 124

ANIMATED GIFS 134



the complete guide to digital type

antialiasin

Some fonts, presented at low resolution on screen, are not very legible. When reduced to

small sizes, their letter shapes are not recognizable and are inadequately spaced.Tt appears

dependent on the screen

user sets the screen

to predict exactly

retype produced

Joes nc* ell when reading

larg- onscreen.

•erence between

an Apple Macintosh and

3 PC. On the Macintosh, a font

jghly the same size as it

• matching a pixel for

a pc .ting 72ppi). However, the PC

displays font sizes larger than they would

appear in print. In our example, this would

create g6ppi. Thus on a PC, 12-point type

appears closer to 16 points.

When a font is rasterized on screen, only

the pixels that fall inside its outline shape

are drawn or filled in. This causes inconsis-

tencies within the font, as fine details, such

as serifs, can be lost in the process. In an

attempt to counteract this problem, a

process called antialiasing can be used.

This function smoothes the jagged

edges created through bitmapping. It adds

pixels of varying shades to the shape of the

letters along curves and diagonal lines, cre-

ating the illusion that the font is more

rounded and refined.

This function is excellent for fonts above

a specific size, notably 14 point. They appear

smooth and legible. At small sizes, though,

antialiased text can be difficult to read, as

glyphs produced with a stroke width of

only one pixel look fuzzy due to the added

tones around it. At small sizes, it is far bet-

ter to use fonts that have been optimized

for screen use (see pp. 126-127).

i
has b» ased

On
theb

ear

Abcdefghijkl

Abcdefghijkl
Photoshop File Edit Image Layer Select Filter View Window Help

1 til 100'X. (Layer 1, Cray)

X *J aa|

Atdju

fit r\ rn

T
I

4
I

5
I'

Vf. ng

bra *
R

1 * ' ' ' * * * * i ' * '

ne antialias

command has several

Si 1 lings—None,

Sharp, Crisp, Strong,

and Smoniii



antialiasing

3Nt^dhtialiasing
works well with large

point sizes. Any text

below i4pt tends

to look fuzzy and

becomes illegible.

Si melioradies,ut vina, poemata reddit, scire velim,chartis pretinm quotus arroget arums.

Si jiil'I>:tj dies, ut viiui, pottniilu nxidiL, .suiro svlird, ehurtis prctium ljuliIuh BRQget annua.

18PT BODONI 18PT TIMES

18PT UNIVERS

4 „± Jype sizes above

i4pt look smooth and

retain more of their

original shape when
theantialias

command is used.

8PT BODONI 8PT TIMES

8PT UNIVERS

R
« Type sizes below

i4pt do not retain

their legibility as the

software adds the

varying shades of

pixels. This makes

them harder to read

on screen.

t'
BITMAP AND GIF
IMAGES

FONTS OPTIMIZED
FOR SCREEN 126

128
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fonts optimized for screen
The constraints of screen resolution mean that viewing fonts at small sizes is problematic.

Specific screen fonts with large, open counters and ample letter spacing solve this issue.

As used to smooth jagged

edges c ^nts for presenta-

olution. Although

ger display type it does

jrk well for smaller body copy.

e problem is that the designer can

never predict the resolution of the screen

be viewed on. It may vary from

to 1.600 x 1,200 pixels

depending on user set up.

• on is to work within the con-

nposed by the screen. Body copy

it look legible at both high and,

Monospaced,

proportional sans

senf and proportional

serif faces. The top

two lines are

monospaced fonts

—

Courier New and

Monaco. Both have

glyphs that are all the

same width, whereas

the sans serif face.

Helvetica (in the third

line), and the

proportional

face. Times New
Roman (in the bottom

line), h.j

of varying w

more importantly, low screen resolutions

are needed. Serif fonts do not transfer well

to low-resolution screens because of the

nature of the pixel grid. This means that

detail is lost at small sizes. For this reason,

most body fonts viewed on the web are set

in sans serif typefaces.

HTML, being a basic language, allows

three types of font to be used within any

site. They are proportional serif (Times New

Roman), proportional sans serif (Anal and

Helvetica), and monospaced (Courier and

Monaco). Working with these limitations

ins the choice of typeface within a site

is crucial for small text. If the user doesn't

have the specified fonts installed, the soft-

ware will default to one of the above faces.

The problem of legibility for the screen

has been addressed a little by the develop-

ment of new typefaces. These have been

designed with how well they read at 72 pix-

els per nit h (ppi) in mind. Internet Explorer

will install these fonts, which have gener-

ous character spacing, larger x-heights, and

open, rounded features to make them more

suitable for online reading.

abcdefghij
abcdefghi

j

abcdefghij

abcdefghij



fonts optimized for screen

On the left-hand

|

side is type set in

Futura and Bodoni, in

varying point sizes.

I These fonts are often

I chosen in print design

for their classical

proportions. On the

| right-hand side is type

!| set in Verdana and

I Georgia, in the same

I point sizes.These

1 fonts were designed

I with screen resolution

; in mind. At small

I sizes, Futura and

I Bodoni become

difficult to read.

I Verdana and Georgia

I do not, as they have

I more rounded and

I open characteristics.

abcdefg abcdefg

abcdefg abcdefg Andale Mono

abcdefg abcdefg
arial

arial black H These are the fonts

comic sans installed by internet

browser software onto

courier new the user's hard drive.

abcd«(£ abcdefg .
They are "safe" fonts

georgia that everyone will

iimiiaaI have and be able to

abcdefg abcdefg
impact

Times New Roman

use. Some have been

designed with screen

resolution in mind and

abcdefg abcdefg
Trebuchet MS

Verdana

so will be better for

rendering body copy

on screen.

abcdefghi

abcdefghi
abcdefghi

i Georgia io~72pt

Although Georgia is a

serif font, the lopt

version (bottom) is

still legible. Although

the glyphs don't look

exactly like the

originals (above), they

retain some essential

characteristics.

abcdefghi

ale-:- ok fchi

abcdefghi

abcdefghi
i Bodoni io-72pt

The lopt version of

Bodoni (bottom) is

illegible and

unrecognizable. The

amount of hairline

serifs and the varying

stroke widths do not

render at such low

resolution, proving

what works in print

does not on screen.

± Verdana io-72pt

Screen fonts are

designed to be as

simple as possible

with large x-heights

and open, rounded

proportions. Even

though theiopt

version of Verdana

(below) is quite

crudely rendered it

still legible.

± Futura io~72pt

Notice how a simple

feature such as the

round dot on the

lowercase letter "i"

becomes a square at

small sizes. All the

rounded qualities

of the font are lost

and the spacing has

been distorted.

t'
• EDITABLE TEXT

USING HTML

ANTIALIASING

HINTING

COLOR AND TYPE FOR
THE WEB

120

124

128
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hint in

Hinting is a process of manipulating a letterform so that it retains its legibility and

essential characteristics when reproduced at small sizes and low resolution.

Wed to small sizes

s and prob-

>ccur because pixels

•jrforms can have

appearance,

ns don't always fit easily

grid. This is especially

ien the stroke widths of the

eel wide, making fonts

•ent and uneven Antialiasing

25) attempts to solve this by

smoothing out fonts at larger sizes by

• other solution is called Hinting. This

e best way to present type at small

reen resolution. It subtly modifies

: resented on screen by mapping it

the pixel grid while retaining the char-

s of the chosen font. It influences

: roportions of the letterforms. includ-

ing line thickness, form, and serifs. It is a

ng that positioning and spac-

ing -

>rm. As a result, it slightly

appearance of the text at

more legible.

:e and PostScript fonts are both

ed as a vector and they are not pre-

gnd So hinting informa-

I within the TrueType or

Post • for the font. The mam,

setcont' : ?s on the letterform to

•heproo

ngesomeofthequai

'orms s luntersj

propor

when made up from only a limited nun

of pixels. This may actually slightly disti irl

or stretch the original letters to fit the grid,

but doing this improves legibility enor-

mously. The letterforms become more rec-

ognizable and have a ui hickness

and form.

When compared with other type with

out hinting you can see why it is so impoi

• irms do not merge togi

when re>

:

•.mall, bloc ky glyphs.

ked back,

blocky image is a

lowercase "u" that has

i« ' 11 1 in Verdana.

When thei harai tei Is

"hinted" to render at

small sizes at 72dp1.1t

has to conform to the

pixel grid (\\u blue

lines) You can see

1i1.1t thei harai tei has

been ad.ipti 'I to lit

Mi. 11-]
1 7 fori mgthe

lefl hand side over to

the light



hinting

The four

characters on the left

are set in Verdana, the

four on the right in

Times New Roman.

The bitmapped

characters are

enlargements of text

tendered at 8pt on

screen. As you can see,

the bitmapped

characters don't have

the same proportions

as the original glyphs.

as
uuuu

abcdefghijkl

abcdefghijkl

abcdefghijkl

abcdefghijkl

abcdefghijkl

1 When the

characters are on the

pixel grid, you can see

how the glyphs have

had their proportions

altered in order to

fit it. The Verdana

characters on the left

have been compressed

horizontally, whereas

the Times New
Roman "a" has been

extended horizontally.

i This type, set in

8-, 10-, 12-, 14-, and

16-pt Verdana, shows

how the proportion of

individual characters

actually changes

across the point sizes.

For the most part,

glyphs with enclosed

counters become more

extended. This is most

evident in the changes

between 10 and i2pt

and 14 and i6pt. If you

look carefully, you can

see that this affects

the letters "a" and "e"

the most.
f

1

1

ANTIALIASING 124

FONTS OPTIMIZED
FOR SCREEN 126

DESIGNING PIXEL FONTS 170

CONTROLLING HINTING 184
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color and type for the web
The internet is viewed on screen, which emanates light. Color type viewed on screen can

have some unusual side effects, making the choice and use of color a major consideration.

W- >mgtypeona page it is impor-

'i adequate contrast

betweer .ndtheback-

groi- on We are familiar with the

" ed page, where text is usually presented

as black type on white paper. This does not

work on a web page due to the nature of

creen presentation. White is made up

of pure light emanating from the monitor.

When large amounts of black text are

placed against it, it can be hard on the eye.

To get around this problem, it is best to

use light text placed on a dark back-

ground—this is less tiring to view. However,

an make the type appear larger and

bolder on screen than it actually is, an

effect sometimes called "blooming." This is

caused by light appearing to seep into the

darker color.

Since many designers view black as too

dark and somber, they try and find other

color combinations that look visually stim-

ulating without hindering reading. This

must be done using the limited 256 color

palette used on the internet.

Achromatics or monochromes can be

combined with color in this instance. These

can help lower the tonal contrast, making

the page easier on the eye. They also pro-

vide subtle color that is unobtrusive.

To guarantee legibility, the designer

must ensure that the contrast between

text and background is neither too strong

or too weak. Contrasts of complementary

colors can work well, providing the intensity

of the color is not at full saturation. This can

cause an optical illusion where colors that

have the same tonality seem to vibrate

next to each other. It is better to use con-

trasting or complementary colors where

one is a lighter tone (for the type) and the

other is a darker tone (for the background).

Alternatively, use a light color for the back-

ground and a darker gray, or other darker

hue, for the text.

These are the different

color combinations

available From left

ght are columns

of contr..

color schemes.

complementary color

schemes, light type on

a >und

and dark type on

a light background.

two columns

ofcomt

of colored type on

>nds

and gray type on

colored backgroi.

abc abc

abc

abc

abc

abc

abcibc
|

abc
|
ibc

abc

abc

abc

abc

abc

abc

abc 1 abcl abc

abc

abc

abc abc

abc abc

abc abc abc

abc abc abc

abc abc abc



color and type for the web

abc I abc

abc abc
* Ph

. When comparing

combinations of black

and white and gray

and white, gray and

white is easier on the

eye. Since a monitor

works by emanating

light rather than

reflecting color (as

happens on a printed

page), expanses of

white on the screen

can cause eye

discomfort. It is

better to use light

type on either a

darker background

or a shade of gray.

otoshop and

Illustrator both offer

swatches that use

web hues. These

can display the 256

colors acceptably

viewed on screen.

Each of these hues

has a HTML code,

which identifies it

for display.

Color Swatches Styli

]ffl
1

1
1
[lw Knr—__

Mllliliiffl

i This simplified

version of the color

wheel shows how the

colors in the spectrum

relate to each other.

Complementary colors

are opposite each

other (for example,

orange and blue)

while harmonious

colors are adjacent to

each other (for

example, red and

violet or orange).

When choosing color

combinations, bear in

mind the tonal quality

of the shades. If they

are too similar, you

may find the colors

seem to vibrate,

causing optical

difficulties. It is better

to choose colors of

varying tones for

effective contrasts.

ere are three

alternatives. By

clicking on the

options arrow on the

right-hand side of the

palette you can view

the various swatches.

Choose either Web
Hues, Web Spectrum,

or Web Safe Colors.

Here, we have

selected Web
Spectrum to show

the full range of

available colors.

Dock 10 Palette Well

New Swatch...

• Small Thumbnail

Small List

Preset Manager...

Reset Swatches...

Load Swatches...

Save Swatches...

Replace Swatches...

ANPA Colors

DIC Color Guide

FOCOLTONE Colors

HKSE
HKSK
HKS N

HKSZ
Mac OS

PANTONE metallic coated

PANTONE pastel coated

PANTONE pastel uncoated

PANTONE process coated

PANTONE solid coated

PANTONE solid matte

PANTONE solid to process

PANTONE solid uncoated

TOYO Colors

TRUMATCH Colors

Visl8one

VlsiBone2

Web Hues

Web Safe Colors

Windows
.
1^—

i

Color Swatches Stylet
!

HI

t Web Safe Colors

only has 216 hues and

uses the colors that

will display safely

without any dither

patterns on screen.

They are more limited

in their range but you

have the assurance

that they will show

the exact same color

on any monitor or

system browser.

Dock to Palette Well

NewSwatch...

• Small Thumbnail

Small List

Preset Manager...

Reset Swatches...

Load Swatches...

Save Swatches...

Replace Swatches...

ANPA Colors

DIC Color Guide

FOCOLTONE Colors

HKSE
HKS K

HKSN
HKSZ
Mac OS
PANTONE metallic coated

PANTONE pastel coated

PANTONE pastel uncoated

PANTONE process coated

PANTONE solid coated

PANTONE solid matte

PANTONE solid to process

PANTONE solid uncoated

TOYO Colors

TRUMATCH Colors

VIsiBone

VisiBone2

Web Hues

MrMMHann
Web Spectrum

Windows

t'
DESCRIPTIONS AND
FONT CLASSIFICATIONS

TYPE AND FONTS

14

28

THE POSITION OF TYPE ON
THE PACE 42

BITMAP AND GIF
IMAGES 122
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embedding fonts

Software now allows you to embed font files in a website so that type can be viewed as it

was designed, rather than using typography in the form of a bitmap or GIF image.

Bnon fonts in

ng a website,

you can adc 1 3 your typo-

grap .ire quite lim-

ethodisfarfrom

on would be to make

available to the user over the web.

Font embedding provides exactly this

service. It allows the user to view the site as

.s designed. The font is sent with the

so the user doesn't have to have

tailed for the font to be displayed. At

ng, there are three main

pieces of software available to perform this

procedure. They are Bitstream TrueDoc,

Microsoft WEFT (Web Embedding Fonts

Tool), and Adobe Flash.

TrueDoc has some drawbacks. Internet

Explorer users have to download and install

an Active X plug-in before being able to

view a site with fonts embedded using its

software. The amount of fonts available is

limited and download times are long.

WEFT provides Embedded OpenType

(eot) files and has none of these problems.

It can embed almost any typeface, it keeps

file sizes as small as possible, has high

quality hinting advice and it works with

Internet Explorer. The only drawback is th.it

it currently does not have a Mac OS com-

patible version, although it will work with

those running virtual PC. This means that

users can neither view nor create

OpenType on the web.

The third and most effective way to

embed fonts is to use Flash. This allows the

designer to embed any font and produces

lightweight vector files that can be viewed

on any machine with a simple plug-in.

FLASH

«• •.ooo. Ml*
• U«M« 1

• 10 "

!

> • •

ft 4 M

-

•

abcdef

2

_J

autor

fonts v.

characters reqi.

aso so

• e beowv-

read and display

them The downside

iltS

m bigger •

/our

2djuiick the Character

button to give spec lfi(
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embedding fonts

WEFT

,H WEFT software is

very easy to use.

Create a simple web

page in Dreamweaver

then open the

software. Using the

Available fonts

command in the View

menu, you can find out

which fonts are

currently installed and

which ones it is

possible to embed.

Those marked with a

red cross will not work.

..a *

New
9
Open Save Wiunl Fonts Add Page Anahvt

o o

Microsoft

Weft

Th« wizard wdl guide you through the process of creating
embedded font object-, for your Web pages This process
consists of the following steps

i

1. Enter your name and emaH address

2. Bm)d a list of your Web pages.

3. Anafyie the usage of fonts m your Web pages.

1. Choose which fonts to embed.

5. Create the font objects and modify your pages.

6. Publish your modified pages

j^Qpen up the Fonts

To Embed tab. You do

not need to embed

every typeface,

because some of

them will be device

fonts found on all

computers. Here, Gill

Sans is a device font

and so is marked in

green. Andy is not, and

is marked in yellow.

\
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"
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Use the 'Embed/Don't embed" button to choose which fonts you

want to embed.

1

3. Family based subsetting

Language

;

1 Per page sublettingwiw ..rm
Font

ify based subsetting

Union subsetting

? Andv(Syntl|S Pawsubsettmg

# Gill Sans h
6 Language subsettmg

p. No subsetting I

<

* Or

« Orn

mly embed the

necessary characters

to keep file sizes to a

minimum. So if you

have used a font for a

title only it would be

wise to only embed
those glyphs you have

actually used.

Phceyou have

selected the required

fonts or glyphs, the

software is ready to

create the OpenType

EOT font object file

that automatically

links to the web page

and allows the user

to see it as it was

designed. Use the

Create Font Objects

dialog box to set the

website location,

from which the

characters can be

accessed. Once

complete, the fonts on

the site should display

without any problems.

t

1

TYPE FORMATS *4

TYPE MANAGEMENT 50
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the complete guide to digital type

animated GIFs
An animated GIF is a simple and effective way of applying moving images to any website.

The advantage of this format is that all browsers support it.T, out and can

be applied to typography, titles, but-

I other page furniture Photoshop

comes with ImageReady software, which

was an application designed for optimizing

ces for the web. it also has the capa-

. to produce simple animated effects

oe saved in the GIF format, ready

for online viewing. The software uses

Photoshop files and allows the user to

modify the layers and add frames to produce

abcde

abed <

abc

abcde

abcde

abcde

abcde

abed

abc

abcde

abcde

an animation. These animations can

include objects that move, fade, warp, or

change in other ways.

The document displays like a standard

Photoshop file. It provides you with an

existing frame in the Animation palette. By

creating a new frame you can manipulate

the image or type as desired. The Tween

command adds new frames in between

your selected ones to complete a sequence.

The file can have several layers, each with

abcde

abec

at

abcde

abcde

abcde

abec

abcde

abcde

something different going on, all at the

same time. The animation can then be

saved as a single file using the Save

Optimized command. This automatically

saves it in the GIF format.

Animated GIFs provide lots of opportu-

nities to be expressive with typography.

They also have the added dimension of

time. Through this medium, typography

can be dynamic and perform in a way that

is not possible with print.

Open the

ImageReady software

by clicking on the icon

at the bottom of the

toolbox in Photoshop.

Many of the

software's features

are exactly the same

as Photoshop but it

can perform functions

for the web that

Photoshop cannot.

h ***

DO
t>&

J Liteither open or

create your type in a

new document.

i» ImagtRtady File Edit Inuge Laytr Slices Select Fill

fc+ _ fen Wul V. . I ..... .

W. /.

I

f> T

% /

.

33-1

3>0

6 r\ /> *unmitd-i# 100

o*i*w*i ; t* « up

abcde

vm • • *» iM



animated GIFs

Op

ft^A

fpen the

Animation palette

by choosing Show

Animation in the

window menu. This

works in a similar way

to the Layers palette

in that you can create,

duplicate or discard

frames with the same

icons that appear in

the palette. Duplicate

the first frame by

dragging it to the

new page icon at the

bottom of the palette.

o o
Animation \ Image Map

abcde

2

sec. - sec. •

Forever t
|
<*4 41

j

Sellselect the first

frame and, using

the Move tool, place

the text in the first

frame at the desired

starting position.

*^7 Untitled-1 @ 100.

&) i=d

Inginal Optimized 2-Up 4-Ud

tOOW t -/- sec fP 28.8 Kbos -98K/ GIF //.

<P.\

^ ^.

^
n
O

y.

.

/

i^id

Original OpUrnzed 2-i)p *-Up

m1

"^ Untitled-1 @ 100.

ol %

Sleet the

duplicated frame and,

using the Move tool

again, place it at the

desired end position.

At the bottom of the

palette, you will see

theTween Between

icon located next to

the New Frame icon.

It appears as four

circles on an incline.

* Ihius will bring up

the Tween dialog box

where you can specify

how many frames the

animation will have.

This can be as many
asioo but remember

that the more frames

you use, the bigger

the file size. You can

also Tween between

the previous frame

only or all frames,

meaning you can do

several animations at

once. By clicking the

Play button in the

palette you will be

able to view the

animation. This file

can then be saved

to be added to any

site by using the

Save Optimized

command located

in the File menu.

MaMaking fading

type uses the same
principles as the

previous steps, but

here we are going to

alter the opacity of

the text. Create your

type as before and

duplicate the frame.

To fade out, use the

Opacity slider in the

iayers palette. Select

the second frame and

change the Opacity

Liym ^ilof> V..:',

~\\ Of:. '. 0«

•

<i> ;; p.. n ii _,
j a i a .;

to zero. Click on the

Tween command at

the bottom of the

animation palette to

create the required

number of frames.

Animation mgeMac Slice

abcde

2f~ IT" 4 5

sec. • sec. - C sec. • sec. • sec. • sec. •

Forever « 41
j

! a - a =i r

|
Plays/stops an matior

j

± ThiThe new frames

will appear in the

Animation palette,

where you can

preview the motion.

Select Save As

Optimized to use as

part of a website.

BLUR FUNCTIONS 70

FADING TYPE USING
MASKS IN PHOTOSHOP 80

BITMAP ANO GIF
IMAGES 122
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the complete guide to digital type

Flash animations
The internet has allowed designers to create interactive content in ways that were not

previously possible. Simple dynamic animations can now be added to any website.

T-ations is

ful appii-

ib design,

jction of everything

" ons to full websites,

ed software, it is seal-

ail, and you can add a

typography, such

and traveling along

. defaces can be

simple addition of a

ontentcan be viewed

- has many built in func-

r be adapted for typography. It

works or o\e principle of specifying

es and using the Tween button to

ecessary in-between movements.

ition can then bepub-

sd as a Shockwave movie for inclusion

Other programs, such as

1 illustrator, now offer the abil-

:he Shockwave Flash

produce simple flick-book

jn be used to create dynamic nav-

.s along with animated ban-

:tions where typography

'ink, or revolve to

-• to the page.

-as advantages over animated GIFs,

'•d content can

be used as buttc I o other parts

'
" ggc

o oo
octoo oCtdc
oCcdc abede
abede abede
abede abede

a In this first

example, we are going

to morph shapes into

text. This method

should work for any

shape but here we
have used simple

circles. Draw a circle

on the stage using

the tool.

- - '- «- —" —•'

«

1 A

s -..w ,

« M •• m M H n m M w m H•iol
|

- -^m
%. .— i •.«!-. S

l

.-

•

%

« Ujispy and paste functions to line

this circle and use the them up and space

Modify and Align them evenly.



Flash animations

o
H Move your cursor

along the timeline

and select a frame.

Here, we have chosen

number 25. Then in

the Insert menu,

select Blank Keyframe.

This will give a

frame without the

original circles in

the 25th frame.

Use[Tie the Text tool

to generate your

typography. For the

software to perform

the morph, the text

needs to be shapes

rather than glyphs.

Select the Modify

menu, then Break

Apart. Boxes will

appear around the

characters. Perform

this command again

to treat the type as

J "lash File Edit Vie* IBffH^ Modify Text Control Wl idow H

New Symbol...

Layer

Layer Folder

Motion Guide

* Until

/ p
i A

Kn
*ilD IS 4f

Bu.1 1 • •

O Frame «

/ y/ t>..Cl
Keyframea 5? £ Sc«n« 1

View

J") Q.

Colors

Scene

'A'
* m
* :

3c* ions

• -

pure shapes. They

should have a dotted

appearance once

complete. Select a

frame between 1 and

25 and move the

cursor to the

Properties palette. In

the Tween field, select

Shape. You should

notice the text on the

stage distort. This has

become one of the

intermediate stages.

h File Edit view Insen MoOily !,

»1Di s 10R is

J urn 1 ) • U . 1
T

4*-i

oC«c

,. this next

example we will

be using similar

commands to create

simple movements.

Again, begin by

creating your text on

the stage and use the

Break Apart command
to treat it as shapes

rather than typography.

Selh Select a frame on

the timeline. This

time, select Keyframe,

rather than Blank

Keyframe, from the

Insert menu. This

allows you to retain

the original type

on the new frame.

Using the cursor, click

and drag around

one or several of

your characters.

File Edit View insert 1

'

** ***

wi f ' >

l

fcJ

.WTOWIVM

Distribute 10 Livers

Rotate 90' CCW

Flip Vertical
"*

Flip Horizontal

g Modify Text Co.

Symbol...

New Symbol... 3CF8

Layer

Layer Folder

Motion Guide

Frame F5

Remove Frames

T^iSuSHHHH
Blank Keyframe

Clear Keyframe

Create Motion Tween

Scene

Remove Scene

T

se the Modify

command to modify

the characters. We
have chosen to rotate

them 90 degrees

clockwise. I have done

this twice to revolve

the text. In the same

way as before, select a

frame between the

beginning and end.

Then in the Properties

palette, select Motion

in the Tween field.

gitnd Omnbutwe

Flash Ftle Edll View in sen Modify Text Control Window
Controflar

T
/ p
t A
O D
• 4
a k

/ o
View

Colon/
« »

Options

>3D
CjL»vwl i

*J*i-a

—

"" e t

£ Scene 1

00soo

•5
H When you play the

animation you should

see the text appear

out of the changing

shape of the circles.

This animation can

then be exported as

a SWF file and placed

in any website.

i whPhenyou play the

animation, you will

see the characters you

defined rotate between

the beginning and

end frames. This

can be exported as

an SWF file to

drop into any web
development software.
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The creation of fonts has long been the domain of the

specialist, requiringyears of experience and, often,

great attention to detail. Using software such as

Fontographer and FontLab, however, designers can

now create and manipulate fonts in a way never

thought possible. This chapter looks at the basics of

font design and how to use software to create fun and

unusual display typefaces. You will find methods for

digitizing fonts as well as a number of functions for

making a font more legible and esthetically pleasing.

J I



the complete guide to digital type

the tools

Typographers, like graphic designers, employ a wide range of tools and working methods.

du can work entirely digitally, or use a mix of hand-drawn and digital media.

Y
produce the

is should

ed to be

300: ou may also

nee,: >s Adobe Streamline.

map images

s You should

software. Many

dividual

-Hand directly, as

trol over the creation

e more basic tools in

• packages You can also

• ned characters using the soft-

not as accurate.

he approach, it is essential to

•ig program for building

•rolling spacing, and gen-

/pe or PostScript format.

re are several software packages avail-

us. and TransType, for

ave emerged as

used: Fontographer and

ide by FontLab. Both are

• Mac and PC.

by far the most popular

eduction in 1986.

• as not been

upgrade: 996 and, as a result, is

becoming ir eweroperat-

. j will run in

Mac OSX FontLa' *he other hand is

ng pop more up-to-date

penTyp'

ng Japanese

Adobe Hlustratorcs2
12.0.0

ih« Adobe Illustrator T«jm.

^ Legal Notices ^ ^ Credits ^

w 1 \.\ I.

character sets containing thousands of

characters. It is not as simple to use as

Fontographer, but is proving to be a power-

ful piece of software.

FontLab has produced a cut-down ver-

sion of the program called TypeTool 2.0.

This still has many of the complex fum

tions, making it ideal for those wanting to

produce a Sf in use it

as professional tool.

Another program produced by FontLab

.vsyou to scan di"

To design a typeface,

either by constn

your own origin. il

type or by working

around scanned

images, you will need

a drawing application,

such as Illustrator.

into the program and export to font-editing

software, creating the outline glyphs in the

process. By naming the glyphs in order, it

places them in the correct position within

FontLab or Fontographer. It is relatively

cheap and takes much of the laborious

work out <it t unsporting characters into

the font software.



the tools

, Fontographer, until

recently, was the most

popular piece of font-

generation software.

The interface is easy

to use and is based on

old versions of

FreeHand. It does have

some shortcomings,

including a lack of

FontLab

Fontographer

Copyright © 1985-2005 fontUb, Ltd,

'^CfKfLAB

guides. The PC version

has stayed the same
for years, whereas

the Mac version now
runs on OS X.

f For)ntLab has begun

to gain recognition

with the design

community. It has a

very similar interface

to Fontographer, but

has many features

that the latter

product lacks. It is

available for OSX and

FontLab
Studio

Version 5.0.1 Mm
Build 2190

Copyright IWt-JOOS FoolUb Ltd. (www.fontlab.
*nd ill ktrniorj UJM Frttrtyp* t*.t lendtring (fr«

Python pow«red (www.pylhon.org).
And.il* Mono font by MTI (monolyptimaging .com)

Caching ATSUI font*

sfifKJLAB

Q
> ScanFont, also

produced by Fonttab,

is a great piece of

software that takes

much of the hard work

out of preparing scans

for the font-generation

package. It is easy to

use and links

seamlessly with

FontLab to reduce

the amount of work

involved with

designing and

creating a fully

functioning font.

is easy to use. Demo
versions can be

downloaded and will

produce four full

working fonts.

W FonlL.b File fd.l V.e« Glyph Tool* W.nd^w

3 33 U ~ ~ "S'-.lii: -
•

eoe Font - Untitled [Hard Drive Library Fonts andyh)

«) "?" Name » IE Imported •
I Ti

OO ©06 Cryprt - I97| t from Unmkd

m
4 a
/ ^
\ T

o n
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i
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3 (lit Edit W\ew Opjftlon tonH Wlnaaw* Htlg

-S—1- olal al
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C 1992-2003 FontLab Ltd. and its licensors.
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version 4
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the complete guide to digital type

the basics—the groundwork
Inspiration for fonts can come from a variety of sources, from old signs to architectural

forms borrowed from buildings.

Remain open n when look-

d look around for

Gothic, designed by

Barry Deck, came from a sign in a laundro-

t had used a stencil to gener-

5 but had not kept within

o creating irregular stroke

•he fonts created for Fuse

magazine have been the result of intellec-

ts based on a given theme, rather

based information.

Whatever the inspiration for a font, you

will have to go through the process of digi-

tizing it. It pays to think about what you

want to achieve with the font and how

complete the character set is going to be.

Should it be a one-off face with limited

glyphs or a complete family with various

weights and widths? This in itself will

determine the best method to digitize it.

Once you have settled on an idea, you

can go about designing the font. Most

gners begin by designing a series of

glyphs that complete a word. This allows

you both to experiment with forms and to

see how characters sit together. The stan-

dard option is to use the word

Hamburgerfonts. This set of letters covers

the basic lettershapes of upper- and lower-

case, the use of ascenders and descenders,

and the differences in character widths. It

also involves both vertical and curved

strokes within glyphs.

Interesting letterforms

can be found in a

wide variety of places,

from old signs to

stencils on a ruler

Once drawn out.

these glyphs can

be digitized and

turned into a fully

working font.

A3CIEFGH



the basics— the groundwork

abc defqhi
i Interesting

letterforms can be

generated from a

stencil font on a Helix characters into a font.

ruler. With a little

imagination, it is

relatively easy these

ZqQ

i This is one of the

first sketches for a

font inspired by the

rounded boxes

available within

most software

and monospaced

typefaces. Some of

the glyphs change

quite subtly from

original inception to

finished font but the

character of the font

remains intact.

o
> Here, the polished

glyphs were created

in Illustrator and

manipulated using

the Bezier curves until

they looked consistent.

nopqpstuvw
Preview/Metrics - canice Regular ETJB

Metrics :A |128
\

[i\ | Hamuiirgerfont

[«—]! r~.R6J—|(H

I 429 J I S24 I 9*7 T 9*0 I 4*9 | 9*0 02* I I 441 1 919

HarnburggrFont

eHbI al 2\ j*W

i The nonsense

word Hamburgerfonts

is often used in font

design, to make

consistent glyphs that

retain the same

characteristics and

personality. It has

both ascending and

descending characters

along with vertical

and curved strokes. As

such, it is possible to

seethe relationships

apparent throughout

all the glyphs.

abcdgfgh
iJhLmnopq

rstuuuHyz
i The finished

lowercase characters

of the font show
regular attributes

throughout the

set. Notice that

certain shapes and

positions remain

constant across the

whole font.



the complete guide to digital type

the basics—character sets

Each letter in a font has particular characteristics that make it unique to the rest. When

designing a font, be aware that not all characters are the same width or height.

Ge based on the three

:he square, circle, and

e based on a circle or oval tend

-an the rest by about

.iracters overlap the base-

o make them look the correct

acters based on triangular

nould overlap the

3p line by the same amount,

ns the size optically rather

mathematically

A full, working font needs a complete set

aracters to make it functional. If you

are planning to design fonts to be used for

purposes other than simple display text.

about additional characters. For

pie. you may need numerals, punctua-

-narks and special glyphs including cur

. symbols and foreign characters.

Should you wish to submit your font to a

type foundry for inclusion in their portfolio,

you will need to produce these characters It

is best to check with the font foundry in

question for their criteria, before you

subr- way you avoid the need to

,^n additional glyphs at a later date if

the font *or your own use, however,

.vill not be necessary.

When designing a character set. keep the

e glyphs consistent They

need to relate to each other and be recogniz-

able as parte Most designers begin

by drawing tl on graph paper,

•• grid to define height and stroke

i keeping the glyphs uniform

ABCDEFGHI
JKLMNOPQR
STUVWXYZ

A •• V

^CEAAAAgEEE
S A •• V S A V • A V ••

IIIIOOO0UUUY
abcdefghijklmn
opqrstuvwxyz
ae ce fi fl J d Q (3 oo

< > ± « »

O / •• A ** V S •• A V • •• A V

TM

i. 5 U 55

{[()]} ,.-.:;<
» © ®

«ii A full character set

of the Bitstream font,

Classic Caramond

Roman. Most fonts

include more than the

upper- and lowercase

characters alone.

Most amateur type

designers overlook

the additional glyphs

needed for a versatile

font. These must

include numerals,

punctuation marks,

ligatures, and special

characters including

accents and

mathematical symbols.

aaaaaageeee 11111

ooooeuuuuy oC #
123456789

t $£¥ %%o+ = *1t
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the basics— character sets

The height and

width of characters

actually varies by

small amounts.

Characters that are

rounded or angled

need to be slightly

larger than those

based on a square or

rectangle in order to

look optically correct.

This diagram

demonstrates how

some characters are

slightly larger than

they appear visually.

3

V*Mfcl<"«-

AiSC««tH'

HlMVWH^

oooqoq

!?&e>$/0r3*^ w :;

F^

f
r
cX

5 Certain glyphs can utilized for. You should

be omitted when therefore make sure

completing a font. You you incorporate

can never be certain special characters and

what sort of "job" symbols, such as the

your font will be dollar and yen.

£$€¥

[]{}()
r \ /v

eeu9
oceae

ii These rough

sketches show

numerals and

punctuation marks for

the font presented on

the previous page. The

uniformity of the

characters should be

retained while

considering the design

of such glyphs.



the complete guide to digital type

the basics—building the glyphs
There are two ways to go about digitizing your sketches, building the glyphs, and making

them into a complete working typeface.

Ttches into an

program. Here you

'nap files and import

e font editor to use as tem-

autotrace Alternatively, you can

Adobe Streamline to trace the shapes

before importing them. These will then

become outlines, saving you the job of trac-

ing them by hand. The second method is to

draw them directly in a vector-illustration

program like Illustrator or FreeHand They

: orted directly as outline

to the font software.

Both methods depend on your skill with

: ackages and the style of typeface you

are designing. If you are producing a hand-

en font it is probably more advanta-

geous to scan and autotrace the glyphs

. ou are skilled in illustration software,

you can use the Pen tool in Illustrator or

<and to trace around your scans or to

•ers directly on a grid The

best s to use as few anchor points

as you instruct the letters. Too

many will take up more memory and are

•o control, causing potential prob-

lems printing the font at a later stage.

automatically scales

importe': •• Combat this by

•hm a box that is

slightly bigger I e measurement

from the bottom of

top of the cap height This guarantee-

•

Overlay Sheet

* b c <A ef 9 k
•

1

•

k / M

K o f 1 r + «- (A V tu X
i *

A B c * F * s, « a J K i rv»

N p Q £ S T u V W X i *

1 % 3 4 r ( 1 & i
> •

SN
<< You can scan

glyphs and save them

as hitmap EPS files.

These can then be

imported into the

font editing software

for tracing around.

You can use the

autotrace functions

imt the software

ti rids to generate too

many points, which

In, mm piohlcm.itK

Liter on.

r

ĉ

* wWith a steady

hand and some

prai in e, it is relative!]

easy to draw around

the hapes.You can

;.;. in I. ili 'In s:l/|ill III

the least numhi i
i

I

point-, pov.ible



the basics— bu i Id i ng the glyphs

a

It is very easy to

place your characters

into the software

package. Simply save

them as bitmap EPS

files. Open the

relevant software:

Fontographer,

FontLab, orTypeTool

and then use the File

menu and Import

command to locate

the file.

P.E
Edit View f i.-iiv-

New Font-

Open Font-

Close

Save

Save As._

Revert

360

US

Preferences... 038P

Generate Font Files-

Export

l«itrtlecl-l:a|W|

l'Htltled-1 :a(97|

H5

h2j

__ Guides

Easa

J3Z J

o
a If you generate

your characters using

a drawing package

such as Illustrator, it is

a good idea to add a

simple grid around

the glyph to ensure

that you can scale

it accurately and set

it on the baseline

in Fontographer.

i Once the glyph

has been scaled and

positioned, click on

the points of the

surrounding grid

structure and delete

them. This overcomes

the problem of

Fontographer not

having rulers for

measuring characters.

is set of glyphs necessary to

has been autotraced. generate the

The software has detail. As this

picked up every detail has been scanned

of the shape and those minor

placed in as many imperfections are

points as it thinks not necessary.

Leaving the excess

points can lead to

problems when you

generate the font file

and use it in a big

point size. This large

character has some

inaccuracies to its

shape, which would

remain unseen by the

naked eye at smaller

point sizes.

Z These glyphs have

been traced by hand.

Notice the smooth

shapes that result

from discarding all

the extraneous detail.

t

1

ANATOMY OF

DESCRIPTIONS AND
I FONT CLASSIFICATIONS 14

THE DIGITAL ACE 22



the complete guide to digital type

creating your own handwritten font
Type designers can spend months creating typefaces. For a more individual approach, you

can create a font from your handwriting in a relatively short time.

U
Lab's

your

t into a full work-

ing font. W your letterforms in

boxes on plain paper They need to be legible

and Jo over the characters with a

make the strokes easy to pick up

n. Scan your image at 300dpi.

.p the scan in Photoshop to make

etterforms darker and more legible.

Adjust the contrast and brightness to bring

out individual shapes. You need to make

sure that the forms are evenly spaced and

/ou can draw a box around each char-

software to read the image it

3

WW*! *ilwr VH

Use the Brightness

and Contrast

commands or

Levels to make your

characters pure black

and white with no

shades of gray This

mayo 1 rove

problematic when
aut©tracing

Wm'W-. » • OlVW J**

Ouotorw

O*0*.mt todvird Color

«eo%»wgt RtaCofcw
Cjfcrfmont Ml Color

1*0*1 W*

LJb Color

•a*mm C m*»*\ * 4 I fern Crunnn
Itlai/Ounn*

Trwi

fMafram AtwonProM*
Comrvn 10 ProMr

needs to be in the form of a bitmap image.

In Photoshop, change this by locating the

Image Menu and changing Mode to

Bitmap. Save it as a TIFF format

Open up ScanFont and open up your

image. ScanFont recognizes individual

shapes once they have been imported. You

can also set up the preferences to import

directly into a font editor such as FontLab,

Fontographer, or TypeTool. The Separate

Shapes command allows you to distinguish

the shapes and to group parts together,

such as the stroke and dot of the letter
"1

" it

also sits all characters on a baseline, ready

for importing. For this to work quickly and

fc-Qnce satisfied, use

the Bitmap command
in Image, then Mode,

and save your file as

.i tiff

k C»*« f 9 k « \ U I m

*tc p r * « h 3. ) k c *t

1 1 }«r<4-j*««o, • '

? & ft t »€ " * K )J<?

fc-Opcn Scanhmi

in the I ile menu,

select Open ai

locate youi image.

smoothly it helps if you name the glyphs so

that the software places them within the

correct glyph window in the font editor. In

the Operation menu select Assign Names.

Type out the glyphs you have produced ("a,"

"b,""c," . . .), including punctuation. Once the

characters are in the font editor you can

adjust the spacing within the Metrics win-

dow and tidy up any characteristics that

are not to your liking.

Name the typeface by locating Font Info

in the File menu. To turn it into a working

font file, choose Build Suitcase from the File

menu and select PostScript or TrueType.

This generates the font file for you to use.

— — •- —-"

•
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, . |. .| ^

1 B * K ..

1
a

l 1

r .i
r
lJ "I'jsssss;^

*,„ III. >
[

.. I
.

J 1
1

.
ill

menu, along the top

.ii the 51 reen, selei t

the Separate Shapes

command You will

see boxes appear

around each of your

1 harai ters on 51 reen

You will nei d to ji 'in

1
, rtaln elemenl

In;., Ill, I Mil h .I' Illl

dot and stroke on a

lowercase "i" in order

1. .I the software to

recognize them as

uric I'Jyph .mil in 'I

two. M11 linn tion

also provides the

hosl software, sui h

as FontLab, with

ml, imation about

the baseline.



creating your own handwritten font

W As:Assign names to

the glyphs. Use the

Assign Names
command located in

the Operation

window. This will

make sure that each

shape is placed in the

appropriate glyph

window within the

host software.

j mt tan vi>- r.^myj i»n» winaowt hh»

Dialed ol

a ezu)^]

WI.ITIMUM

JLj [| Mh
L. L JL_aLffl_ELH_JHL *«
WEB IgBIHmOE DM
h-eulb-R cs m._H_jLa.,gLgu^-

j_a-C8 B n gi m.E_a_o^__^.l

g KB BRB wa
8] B H3fl

-i-u:

[>-- -

O Names Template B8
Inaplitn : ( • *»v • t

)

^e*fg.hijklmnopo£tuyvxyzA6CDEFGHIJKLMN0P0RSTUVWXY2l 25456789

0,."&

•) Apply to all symbols Q Apply to selected symbols

|
Apply Now | (

Get |
|

Open...
| |

Save-.
r^

1 .

± In order for this

command to work,

you need to select the

characters' names by

typing the appropriate

key on the keyboard in

the order they appear

on the scanned image,

from left to right and

top to bottom. When
complete, click the

Apply Now button.

4 file Edit View jj.lUliMil Tools Windows Help

5 ToTo export the

characters into a font

package, first specify

which software to

place them in. Select

Preferences in ScanFont

from the Tools menu.

This will bring up a

dialog box. Use the

arrow buttons to

handwriting scan.pic

locate the Fontlab

server options. If using

software other than

FontLab, such as

Fontographer, click on

the Custom button.

Use the dialog box to

locate the software on

your hard drive to

place the glyphs into.

JBL.fi 1 3i.f.

jBj B_g « I

J5LJ....S fiJLf!

1 flj AJEJSJ

J 1

Options

«\»
|
fontlab Server *

j

Default sidebeannqs values

Left sMtktaruq: [75 I
Rt«ht SMlebearing,:

j
1Q |

Exchange with FontLab Server options

Activate FontLab Server application after placing symbols

Use FontLab Server:

O Default (automatically search on local disks)

TypeTool 1 3 Z

D|ci[o|:0|"iT[

nmm

1

jsl.G e

Enhance Image
Invert

Flip Horizontal

Flip Vertical

Rotate

Separate Shapes
Assign Names

Merge
ipW

Retrace

Show Font

111 rnrna r*r*i

handwriting scan4>ic as

- JLi 3_..fl i.JL_

jk fl..4„.g 3 i.JE.i & a...i..f.

is a_...i5..f_i..s...i...a[j] i is..

i fljjli i i a 1 88l|.

j 1 1.1 f! I 11.J S $ t

f

T." ^UT-T

Q
± Use the cursor to

click and drag around

all the glyphs. Then

use the Operation

menu to select the

Place into Font

command. This will

import the characters

into the correct

glyph windows.



the complete guide to digital type

creating your own handwritten font continued

Owiwnu*» tw*tec• AcutatatyfMtiaMy "««•

see

appe

for- jftware.

Nowyou need to make

I

•?ctry

~ e tabs at

3ttom o*

•ie

ikes

get

ell

worth perseve

^ Open the Metrics

window and type

some characters. You

will be able to move
the side bearing bars

to change how close

or far away each

glyph is to the next.
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Name the font so

that it appears with

your chosen title in

any software you

open up once placed

within the operating

system. Select Font

Info from the File

menu. Fill in the

relevant fields and

click the Apply button.
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creating your own handwritten font

Generate the font

file to provide the

information from

which the operating

system will build the

typeface. Select Build

Suitcase from the

File menu.

.
Nn
Ope

Edit View Operaticn Window Help 4:23 pm :-*-:J lypeTool

QJ
* Font XN
n Font- 110
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* 7
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Print- IIP hyplwi p*rktf sl«h z*ro V- >•<• thru tar 'It* IB *•-.

Plug Ins

• /
[

a 3 <! r £aiidv hand.vfb

Tuscan Condensed.sutt

Universal*!
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1

<

i^Wl
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Q) andy hand
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format
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cancel ||| OK J

2: A dialog box will

appear with prompts

for the file format of

the font. Select a

suitable format

depending on the

operating system and

type of computer,

either Mac or PC,

PostScript or TrueType,

and click OK. This file

can then be placed

within the system

folder and used by

any software on

your computer.

ANATOMY OF
A TYPEFACE

CREATING YOUR OWN
FONT FROM SCRATCH

CREATING A FONT
FROM FOUND OBJECTS
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140
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the complete guide to digital type

amending existing typefaces
There are times when creating a new typeface from scratch may not be necessary.

Logotypes often manipulate existing fonts to create something slightly different.

I-nould check

*'or the font on

rase your design, in

ngement

imber of ways in which

ate an existing font. You

~s away, round it

e advantages of doing this

-ady have bought

• ,o m the font edi-

have been spaced and

' you and there will be a variety of

oose from.

mtographer are similar to

e of very early versions of FreeHand. As

such you can move, merge, or add anchor

points to manipulate glyphs. FontLab's

tools are a little more difficult to use, as

there are two sets that have similar icons

but different functions. However, they both

have the ability to manipulate glyphs.

You may want to take a historical serif

font and update it. Here, Classic Caramond

has been manipulated to produce a more

modern look by rounding off features and

subtracting some serifs. Other options

include making it into a sans serif font, or

shortening some of the ears, stems, and

spurs. You may want to make it into a script

by adding adjoining lines to link the letters

together. These may be thick, horizontal

lines, or perhaps swashes. You are limitei

only by your imagination.

There are a number of typefaces cut

rently available that combine both th

uppercase and lowercase forms together li

one shape. One way to achieve this effect i

to cut and paste existing glyphs into a sec

arate window and manipulate them s

that they overlap. You can then use th

Remove Overlap command in the Elemer

menu to merge the two forms, so creatin

an entirely new font.

By removing some of

the serifs and

rounding off certain

features, a classical

font, such as

Garamond.can

be made to look

radically different.

abcdefghijklmn
opqrstuvwxyz

abcdefghijklmn
opqrstuvwxyz

axtegiv

axtegiv



amending existing typefaces

AMEND TYPE

„ Open your chosen

font in Fontographer

or FontLab. Here, we
have selected Classic

Garamond in FontLab.

The idea is to amend

the font by deleting

some of the serifs.

Double click on an

individual glyph

window and select

the eraser within the

toolbox. By clicking on

particular anchor

points, it is possible to

delete them and

smooth out the shape.

.00-
Glyph - !*>?! if'omCUijKiiOrvnondIT

r
•.v

* \ T

.a Iff,,, .x„„„r„i

v I

rts of the tail on

this lowercase "a" are

removed. It is now
possible to reposition

individual anchor

points using the

selection (arrow) tool.

nlUl..ulC»IP,imt)rwi Bl

o
i Certain characters

may require some
thought as to how to

streamline them to

achieve the desired

look. With the

lowercase "g," for

example, the inner

counter space of the

lower loop is removed

and the anchor points

of the outside

repositioned to form

the new loop.

MERGE TYPE

Another way to

amend a font is to

merge two glyphs

into one. Simply open

up your chosen glyph

window—say the

lowercase "e"—and

click and drag around

the entire character

to select it. Use the

Edit and Copy

command. Open up

the next glyph

window—the

uppercase "E"—and

use Edit and Paste.

This will place the

two glyphs together.

Use the Selection

tool to position

them precisely.

CiYph 169; E >«•" Ctomm Ci'*mo«<S It

?.-* * ei r..\.:.:.t9. ir

" —
;

00
SUuia.-

I2h
=i

J In1 the Tools menu,

select Outline and

Merge Contours. This

will unite both shapes

to become one.

FmtUb F.1* Edit

J 3 -j a 3 O
View Glyph £ ^J Window

o o

- a
7!*

on

a & Guides

Template s

Operations

Multiple Master

Assign Milt .

Kerning Assistance ...

Metrxs Assistance

Transform

Transform Range.

External Tools

Customize.w

Check Connections

Reverse All Contours

Nodes at Extreme*

Snap to Guides

Optimize

Expand Strokes

Make Parallel Path

Delete Inierseciio

-pi To Type 1 Curves

I

iiu

i

eoe
% IK,'.l

Cl»ph ]69| £ l.om CljsiKil t^wmmS M

o

1 v

V -

o
i Above, you can

see the effect of the

Merge Contours

command. This can

then be tidied up

using the Selection

tools to obtain

a smooth,

consistent outline.

.-•

t
COMBINING AND
OVERLAPPING TYPE 86

BLENDING IN
ILLUSTRATOR 92

CUSTOMIZING
LETTERFORMS 94



the complete guide to digital type

combining several fonts (ransom note)

Inspiration for creating fonts can appear in many places, not least the work of other artists

or designers.

Tent at the beginning

. had a distinct typo-

is been reinterpreted

over- . ; .'ing the punk era

movement took an irrev-

-.tablishment approach to

music and fashion. Designer Jamie Reid

app pography giving it a low-

• and-paste look, rather like that of

a ransom note. He took letterforms from

fonts and combined them to

the logo for the band the Sex Pistols,

among other things.

The same effect can easily be achieved

today's software. By choosing several

typefaces, and mixing serif, sans serif, regu-

lar, bold, italic, and reversed-out characters,

you can combine various styles of glyphs

into one face. Open up each font and copy

and paste individual glyphs into a new font

Be random with your choices and the

of individual letters. Since the letter-

forms can be copied and pasted from exist-

ing fonts and opened up in Fontographer or

ab. most of the hard work of spacing

idebeanngs and hinting has already

been done You will need to pay some

attention to spacing, however, and the

placing of italic characters next to roman

ones This may take a little working out

•>. depending on how

tightly spaced you want the glyphs to be.

You may decide that the feel of the type-

'equires a more ha[ ipproach

ii 1 so have more random spacing, too.

.

»- 'ontltb <* S> Tnu

Begin by opening

your font-editing

software and starting

a new font. Then open

an existing font file

from your hard drive.

o o

•

I-I-I- I

-

>. »'

, AP0'«*W-i Vjppon
ft

d.«

• AtKfcO
C

*Uuft)jtHt

«.*.*€« V 1 dynamo*

Cuuvuppon now
. uIo-Hih Mrptaa

lompontnii * ng ..>.. g Mom
II ttUftl Mtno Hfmi Highitj.*

1 OvtktopMm
OtKL.mrniil.on ' lulu'icirom •

.
. Ifffll

F= r=?»- •

'

Open Macintosh Suitcase

Sho* «•• Alt Font Mai

fool nun* rwwGaramondBT Roman

' Opiwnt
l T «" ' •W»">n» manured

:'

fJJQ »•• i~0" »•-•

1 I

!

'

v {& GillSans

a Cill Sans Light

a Gill Sans Light (italic)

a Gill Sans (bold)

a Gill Sans (italic)

a Gill Sans (bold. calk}

o
44 Some fonts may
have several versions

within the family.

Here, Cill Sans

is selected.

' Op«n All
' '

Cane* ^ 'ontl.b Filt EH view Glyph looti Window m
*'

: a h t ~

« liom Cill Sam

» Op,sen up an

individual glyph

window and use the

Selection tool to click

and drag around the

whole glyph to select

it. Use the I dll menu
to copy this selection.



combining several fonts (ransom note)

*_ fOMUb ,„,!, window SB
- - ii'i

Open the

corresponding glyph

window in the new

font and use the Edit

menu to paste in your

copied host glyph. This

may require scaling

once put in place.

o
•i : b tram unnamed 'ont

m l i?fn i ir i r*nMj ;

"
ii.i f I!,' iCi„n 1 jii;<

,i
l i„c? f*?.,i

f» FomLab File
| View Glyph Tools Window %£.

a£cDQ|fg
h/'JklmN
O^q rs t

UEJnxyz

ii Repeat this process

with several fonts.

The second glyph here

is Big Caslon Italic

from OSX.

eoo
» -j i

Preview/Metrics - Unruled

| Mg

tT Auto ':' ab I

13 500 50

!_

a^cf

± For this kind of

font to be effective,

it is best to have

several contrasting

characters—serifs,

sans serifs, bold,

italic—and a

mixture of sizes. The

lowercase "f" is from

Franklin Gothic.

.

.

i Get the metrics

correct. Choosing lots

of disparate typefaces

can cause problems

when placing italics

next to regular

characters. Pay close

attention to the

spacing to avoid

any overlaps.

CUSTOMIZING
LETTERFORMS

AMENDING
EXISTING TYPEFACES

CREATING A FONT
FROM FOUND OBJECTS
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the complete guide to digital type

reviving historical fonts

Hoefler and Frere-Jones Typography, formerly the Hoefler Type Foundry, describes a large

portion of their type design work as "revivalist."

T
began a study of let-

New York, with a

•honty Bus Terminal,

becanru on and basis

tvailable through his

e fonts produced by

'id Jonathan Hoefler are corn-

based on facade signage around

. bring together several ele-

Tguishing characteristics

one font, or family of fonts, which are

J for a multitude of uses in the

. or building it was inspired by.

en from

a 50-year-old type

specimen book The

resulting font has

been manipulated

. peTool to be

•erent. so

as not to infringe

copyright laws

Old type specimen books can be a great

source of inspiration. They tend to include

unusual historical faces that may not have

been digitized and are therefore unavailable

commercially. ScanFont is ideal for digitizing

these kinds of typefaces. It is worth check-

ing that, by creating a font from the speci-

men book, you are not infringing any copy-

right Copyright normally lasts for a dura-

tion of 50 years. You can overcome the prob-

lem by using the letterforms as the basis of

a design, but change them subtly to make

them more personal.

The beauty of ScanFont is that it takes

most of the hard work out of the digitiza-

tion process. It recognizes shapes and, via a

process of naming the glyphs, places them

into the correct position in a font-editing

package, where you can work on the spac-

ing and kerning pairs. Providing you get a

quality scan of the face and clean up the

characters in Photoshop, you can produce a

new typeface in a just few hours. Although

this is an ideal method to use for display

fonts, its success for text faces will depend

on the quality of your scan.



reviving historical fonts

Clean up your

scanned image in an

image-manipulation

package such as

Photoshop, to remove

any inaccuracies

and to ensure that

all the glyphs are

clearly separated from

each other. Any

characters touching

may prove

problematic when
placed in ScanFont.

Once the clean-up is

complete, save the

image as a bitmap file

in a TIFF format.

ABCDEF
GHIJKLMNOPQRS

TUVWXYZ
abcdefghijklmnopqrst

imvxyz (<lfiffflft!?Th)

& 1234567890 £
CORVINUS LIGHT AND BOLD

4 fte EHW VHw Op«trtlan looli Wl»««wi HH»

Certain glyphs are

made up of two

shapes, the stroke and

the dot, for example,

of a question mark. In

order for these shapes

to be seen as one

letterform, combine

them into one glyph.

Holding down the

Shift key, select the

parts of the

letterform to be

united and select

Merge in the

Operation menu.

The two separate

boxes will now
become one larger

box, encompassing

both elements of

the letterform.

^ Open the ScanFont

software and select

File and Open to locate

the image. Use the

Separate Shapes

command located in

the Operation menu.

This command tells

the host software

to treat each shape

on the page as a

separate character.

You will notice boxes

appear around

every character on

the page.

rue Edit : loots Windows Help

T*loj

8 \f :
* F>. |l

' 1

corvinus bmap

: ;

[HHI
Lil J.:.,

j" :.:.:;::

Din

Names Template sir

Templates
] 9 H«w •

»1234567890t

O *PP*y to *" symbols % App>y to S*t*ct«J symbols

Apply Now] ( Get Open-

Ji.

o
H The characters are

almost ready to

export into the font-

editing package. In

order for the glyphs to

appear in the correct

position within the

software it is

necessary to name
them. Select the

Operation menu and

the Assign Names

command. In the

dialog box, type the

characters in the

exact order in which

they appear on the

scan—from top to

bottom and left to

right—otherwise

they will end

up in the wrong

glyph windows

when exported.
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reviving historical fonts continued

: the order of

lamesor

d to merge certain

'is together. If this

is the case, use Edit

and Undo to rectify

the problem first

• I -!! [nn *i*i
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not 41
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-

u t !—i—i— •*>*
1 • 1 ft

t e the Place in

Font command
located in the

Operation menu
to export the

to font-

ig softw i

• s Fontog-

fontlab. (

"ypeTool

. . - 'f pp
- - ...#•. ...

1

r

*

H An

* Since the

letterforms have been

generated from a

scanned image they

may require some

cleaning up once they

are in the font editor.

Here, some of the

shapes have lost

detail and have

become slightly

misshapen. The

software is designed

to manipulate the

glyphs, so these

distortions can be

corrected fairly easily.

Anchor points and

handles can be moved

and manipulated

using the arrow

Selection tool. The

idea is to generate the

character shape with

as f' I points

as possible to produce

a smooth, fluid shape.

Some of the extra

points may need to be

removed. Use the

i tool in the

toolbox .Hid i In k on

.in .mi In ii point oi

handle to delete. One

of the benefits of

TypeTool and

FontLab is that you

can pull out guides

from the rulers, which

can be used to line

up anchor points.
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o
> The lowercase "b"

has become deformed.

Many of the straight

lines that make up the

stem are curved and

some of the anchor

points do not line up.

This makes the shape

appear irregular

and esthetically

unappealing. With

some time, a degree of

manipulation, and

some simplification, it

is not difficult to

correct these problems.

GlyphEdit - [98] b from unnamed font BE
^ 1

100°° »
I ;<"I'H F1^17"T™| ^T^l l»fttl»"

null
'

i 1°
'' "Mil III III I MM I Mil I ill II Ml III III II I II ILU

GlyphEdit - 1981 b from unnamed font HH
«tL9'g»-"'..^j <'r'HR'v[^H ^n aFTi-rTrn-M

ZEE

Q
i The serif on the

lowercase letter "b"

should be a slab

serif, but here it has

become an irregular

blob. Move the

points and rotate the

handles to give the

character a more

angular look.

——±

^

< >

GlyphEdit - 198} b from unnamed font as

..IIW llff.l.M.lltt, IffP If...l, ...llff.j,,

10
<< Compare this

almost complete

lowercase "b" with

the one above. The

strokes are now
more uniform in their

appearance, the serifs

are angular and

straight, and many of

the anchor points

forming the curves

have been lined up

to provide a more

consistent shape. This

process should be

repeated for all the

glyphs before building

the final font suitcase.

AUTOTRACINC AND
DRAWING OVER
EXISTING TYPE

AMENDING
EXISTING TYPEFACES

CREATING YOUR OWN
FONT FROM SCRATCH 164

78

I40

152
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creating hybrid fonts

As their name suggests, hybrid fonts are the result of mixing two parent fonts together to

create a third. They are simple to generate and offer limitless possibilities.

W:
I

ere

jnd matching is

• iking a part ofone

•ibining it with some-

oeen applied to all the arts and

has been a prolifera-

• js of fonts and designers

have created some unconventional display

Method. Whether they are

I
••• Jed together seamlessly or quite crudely

.id pasted, almost anything is possible

and the result is a matter of taste. For exam-

ple. P Scott Makela designed the font Dead

able from the Emigre Type

by simply taking sections of

il and VAG Rounded and splicing

together His methodology was to take

f one and half of the other, using either

the .;ht or top and bottom of letter-

forms, depending on how they could be best

fitted together He made no attempt to blend

fonts but left the uncomfortable mis

matches as they were. Since then, several

other for .em have become available

Another one worth examining is called Time

le from the T-26 Type Foundry.

The two top fonts

have been blended

together in

Fontographer to

Grange

i (below)
•

•is some

of both

• ' .:
'

This methodology can be easily replicated

using two contrasting fonts and Illustrator

and Fontographer. In Illustrator, you can

remove sections of the letters and fuse pieces

of them together simply by using the

Pathway palette. Ifyou then copy these pieces

to the pasteboard, they can be used as

templates to draw around. Alternatively, you

can import the glyphs separately as EPS files

JiiettK into Fontographer. In the examples

opposite and overleaf, we have used OCR A

and Times.

One way of blending two fonts seamlessly

is to use Fontographer's Blend Fonts command

abcdefghijklmn
opqrstuvwxyz

srjcdefghijklmn

cpQpstuvwxyz

abcdefghijklmn
opqrstuvwxyz



creating hybrid fonts

5 Select New Font

in the File window
and open the

appropriate glyph

window and paste in

your copied selection.

Choose the Slice (or

Scalpel) tool from the

toolbox and while

holding down the Shift

key on the keyboard,

drag a line across or

down the glyph. You

will notice new anchor

points appear with

concentric circles

around them. These

are the slice points.

i There are two

ways of completing

this kind of font. One

is to use Illustrator or

another similar

drawing package and

then export the EPS

files into the font

editor. The other is to

directly manipulate

the glyphs in a font

package to create a

working font. Here,

we have done this

using Fontographer.

Begin by opening up

the two fonts you

intend to cannibalize.

Then select the

letterforms one

by one. Using

the Selection tool,

click and drag

around the entire

character and copy

it to the pasteboard. _Copy and paste

the glyph into the

new font file you have

already started. By

placing the characters

side by side it is easier

to scale and position

the second letterform

before slicing it.

A
i Now open the

corresponding glyph

in the other font.

t. It is possible to

select points on

either side of these

new anchor points

and delete them,

leaving only half

the letterform.

IP
uou

n c

± Repeat the Slice

command as you did

previously. However,

this time, remove

the opposite side

of the letterform.
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creating hybrid fonts continued

o

' .rture

nter-

: light faces but it

-ed moft :.ikes the two

in interpolation

between them Ti trange hybrid

.ou have Irttle control over but that can

d further later on.

W ngenuity.you can create some

very unusual hybrid fonts Try taking serifs

from one font and adding them to another, or

g the vertical strokes of one font and

adding them to the bowls of another.

» Erase the

unwanted anchor

points by either

selecting them

individually or clicking

and dragging around

all of them in one

movement and

pressing the

Backspace key.

« Move the two

remaining halves

closer together until

you are satisfied tin y

are positioned

i nun t
I
V I hell sek'l 1

the two adjacent

anchor points. In

the Points menu,

choose Merge Points.

This will unite the

two halves.

Q
« Pen tool.

'Ae to join any

anchor^

not close enough to

each other to be

merged Simptyckkon

one anchor point and

•>ove the cursor

k on the
(

'

The software will join

.vith a

ntli '

'

jntil it is

, unified

One
have been complet i

hen possible to

I file

;• .1 fully

working font
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:'idr<tf(ioiidB!-Roman

The other, less

controllable, way of

merging typefaces is

to use the Blend Fonts

command. This was

originally intended to

create interweights

for font families, but

can produce some
creative results. Start

by opening the two

fonts to be blended.

<< With both font

windows open, select

the Element menu and

choose the Blend Fonts

command. This is an

automated function,

which interpolates

between the two

faces.lt produces an

amalgamation of the

two extremes, resulting

in a hybrid font.

10± In the Font Blend

dialog box, set the

Blend Amount
between the two fonts.

Here, we have chosen

50 percent.

i You can seethe

original outlines and

the new font. The

software retains

many of the original

font's characteristics,

creating an unusual

typeface. If necessary,

the glyphs can then

be manipulated

further to create a

consistent face.

t
' COMBINING AND

1 OVERLAPPING TYPE 86

BLENDING IN
1 ILLUSTRATOR 92

CUSTOMIZING
1 LETTERFORMS 94

AMENDING
EXISTING TYPEFACES 152
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creating your own font from scratch

Creating an entirely new font can be hard work and requires an excellent grasp of the

fundamentals of typography.

Mby sketching the

iscertain the disttn-

of the font, so

draw out your letterforms on graph paper

to make sure they all conform to an x-

height and similar stroke width.

Once complete, some designers then

use the sketches as a template to redraw

the glyphs in a vector illustration program,

such as Illustrator However, if the letter-

forms are relatively simple and only have a

ted amount of curves, you can skip the

sketching stage and draw the characters

on screen with the Square Circle and Pen

tool using the Grid in Illustrator. Then com-

bine the characters into single shapes,

using the Pathfinder palette.

Save your work as an Illustrator EPS file

and import it into Fontographer to refine

the glyphs. The importing process can

change your forms slightly as the software

autotraces the shapes to generate the out-

lines that appear in the glyph windows.

This means you may have to spend a little

time tweaking the form to make sure

everything is how you want it

refining your work

mg a font can be a painstaking

process. You need to make sure that the

'dual glyphs match up and retain uni-

form features it is best to construct the

glyphs from the least amount of anchor

points and Bezier curves as possible so as to

'e no problems with printing

The next step is to use the Metrics win-

dow to look at and manipulate the spacing

for the font. Although the software has the

capability to space the letterforms, it can-

not make the kind of judgments a trained

eye can—it is always better to do the final

spacing yourself. So try using the automatic

function first and then adjust any individ-

ual characters by eye.

Then name your font using the Font

Info command and generate the appropri-

ate font format by using the Generate

Font command.

. First, roughly

sketch out your font.

It may take several

attempts to make

the letterforms

consistent. Sketching

on graph paper makes

it easier to replicate

the shapes using the

grid in Illustrator.

H Ui i

abcdefghiihimn

opqrsluuujMgi.

oin^bjBgi 1 1 I

abctfeFg!

ffnopqr5t uuujh

z

taw out a

complete font,

including numerals

and punctuation.

oooqoq o

n
o

(7=

*ft=J L

1^=*

L



creating your own font from scratch

sing the

Background Grid in

the View menu,

count the correct

number of cells and

draw your rectangle.

i Add the stem

to the bowl. To do this,

simply draw a

rectangle to the right

size and add it to the

shape. You may need

to manipulate some

of the shapes by

either adding new
anchor points or

moving existing ones

around, until your

letterform matches

your drawing.
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creating your own font from scratch continued

EPS Format (lit View Element

»
Compatibility

QlJ/1.1 CMS
Q88 O 5.8/5.5

#> 5.8 3.2 6.8

Ov.«

Options

Include Placed Files

O Include Document Thumbnails

Use Japanese File Format

Include Document Fonts

Preuleui

ONone
O 1-bit IBM PC

O 6-bit IBM PC

01 -bit Macintosh

® 8-bit Macintosh

( Cancel )

DO

New Font... 3SN

Open Font... »0

Save

Save Av

Revert

*S

Preferences- OKP

• Font hies...

Import

Export

Page Setup...

Print... *p

Quit %q

& Open up by using the New Font

Fontographer (or other command from the

font editing software), File menu.

1 en up the

relevant glyph

?w—here, the

lowercase 'a

ielect

Import, then EPS

dialog box

locate your EPS file

^pen



creating your own font from scratch

10
Repeat the process

for all the other

characters in the font.

Once all the

letterforms are in

place, work out the

correct spacing. The

sidebearings (the

dotted guides on

either side of the

letter) control the

amount of space

around the glyph

To produce

the glyph in the

window, the software

autotraces the

EPS file. It should

produce a fairly

smooth character

with anchor points.

If not, use the tools

to simplify the shape.

when typed on the

keyboard. These can

be moved in and out

to provide more or

less space. Open the

Metrics window from

the Metrics menu to

see this in action. By

typing combinations

of letters, you can see

how much space is

required for the

typeface to be legible.

PfT»moiTi»Tsmpi
HBGuKtos
IPHIfiU

intuitu- 1 :a|97]

"-T

canke : Metrics

T»» t |tvabTqn^otfjn
]| a Kerning ^ \ File-

habrnrgurQOcrsiu

: :

habrnrgurgofcTsiul

JJ Points Metrics Wlm
Transform... 8f\

Arrange

J I, '.II. ii>——
Selection Info... aii

Bitmap Info...

Auto Trace- 0*T
Change Weight. 098W
Clean Up Paths-. one
Expand Stroke... 0*E
Recalc Bitmaps- OS6R

Remove Overlap OXO

Correct Path Direction O88K

Clockwise

Counterclockwise

Blend Fonts-

Multiple Master...

Font Information

Style Name
,

Family Name
t a 11

1 Cancel
|

Name:HH Medium |M
Encoding: | Macintosh '1

Font metrics:

731

190

1000

Ascent:

Descent:

Em Square:

Q Retain path coordinates when changing em square

Q Automatically compute em square from ascent * descent

Leading: |9

Underline position: [-100

Underline width: i~50

Notice: Generated by Fontographer 4. 1.4

Number of characters allowed in font: 256

. Control the side-

bearings by clicking

and dragging on

theL, R.and K

markers. Move

them in and out to

adjust the spacing.

± Name and save

the font. In the

Element menu, select

the Font Info

command.

2: In the dialog box,

name the font and

encode it for either a

Macintosh or a PC,

along with setting

some of the default

Metrics, such as the

Leading. In the File

menu, generate the

font file as either a

PostScript or TrueType

font to start using it.

t
1

ANATOMY OF
A TYPEFACE

THE BASICS

—

THE GROUNDWORK

THE BASICS

—

BUILDING THE GLYPHS 146

142

CREATING YOUR OWN
HANDWRITTEN FONT 148
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modular typefaces
There are three types of font design—proportional serif, proportional sans serif, and fixed

width (monospaced). Fixed-width designs are often the basis for modular faces.

Fthe same

>pace. Each character has the

ase "for

ese fonts are ideal for

e space needs to be con-

As we .pe forms can be reduced

example, a lowercase "b" is

a reversed "d" and an inverted "p," which in

q." in effect, a small num-

bers can be adapted and

Jed to produce a full character set

typeface is one that takes this

expands it further by constructing

m a certain number of modu-
cyou look at digital readouts or dot

ters you will see that all the

s are made up of set components in

" ons.

Yc as the basis for designing

:ane Licko built coarse bitmap fonts

as Universal, Oakland, and Emigre for

ng the limited screen grid

tate the design. Each letter was made

up of number of square pixel units. The con-

densed versions have more vertical units to

i appear thinner.

Fontographer and FontLab can both draw

squa gles, and curves, which can be

g blocks of the font. Here,

we took some simple shapes, such as

squares, triangles, rectangles, and a curve to

: letterforms These fonts are easy to

thin the software, as they don't pro-

ved shapes .-.
f h Bezier curves.

imot
, Modular typefaces

are often fixed-width

(monospaced) fonts,

such as Courier. This is

based on typewriter

faces, where all the

glyphs have to be the

same width in order

to space the letters

when typing.

/N P\ /\ /"I /%
I wmwm

vJ\/\. V.IV.

t rilis font is based

on a simple rectangle

and curved shapes. By

changing the order of

the shapes, you

can change the

characteristics of

each letterform.

: :<». nit Ammk. Ammm awm\

Ammm mmmr
^« ' ^mmr ^umr ^BH r

4 This font is built

up from simple

geometric shapes

—

the square and

triangle. We have

used this as the basis

of our design. You can

see that each letter

occupies the same
width as the rest.

4 ni« tan view ehimm Pointi M«<nci wmaowi unu Help

O immed-i:<|<7|

Tl

/V 'V

3 Ttmplal#
jtdtl

i •.

raa n
n

i inn
rut !«I1 Vl»w litmini folrrtl Mtlrltl wmaowi Mum Htlp

us font is going

to be made up of

squares and triangles.

Using the Rectangle

tool in Fontographer,

click and drag out

a square shape in the

glyph window.

UHilli-dl tl»7| I'lH

> A. 'V

:

:

•m i r

1 Buiild up the

letterform by copying

and pasting the

square, stacking one

on top of another.



modular typefaces

4 File Edit View Element Points Metrics Windows Hints Help

D Untitled-1:o[97]

704 189

•- ->
704 188 *?

4 Hit tan View Element

a
c

—El
r

1,1,1,

nnn
n
nriri

Double click on the

tool. This brings up

the dialog box that

allows you to set the

angle of rotation.

<t ' Edit •i'Hi:nl. Points Metrics Windows Hint

N

i Merging two

anchor points

together from a

square and removing

the handles will form

^m

a triangle. Rotate

these using the

Revolve tool to make

up the corners of

the letterforms.

D
nnn

n n
^nnn

Center transformations

|
Center ol selection

Flrjt 1rin>form«lion

|
Rotate -

Then

Do nothing
'I

Trten

Do niithim.i 'I

TM
j

Do nothing -

n

•.-

RBCDEFGHIDKLMNOPQRSTUUHXHZ

1; Modular typefaces

allow certain letters to

be flipped, reversed, or

mirrored to form other

letters. Here, we have

copied the lowercase

"a" and pasted it into

the letter "e" glyph

window by rotating

it 180 degrees and

then making some

changes to give a

more rounded or

straight shape, where

appropriate. This

method can be applied

to several letters, such

as"b"and"d,""u"and

"n,"and"v"and"w."

t'
FONTS OPTIMIZED
FOR SCREEN

HINTING

126

128

CREATING YOUR OWN
FONT FROM SCRATCH 164

DESIGNING PIXEL FONTS I70
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designing pixel fonts

Fonts viewed at low resolution, especially those used on websites, need to retain their

legibility. Serif fonts are a problem because their shapes do not reduce well on the pixel grid.

0-
o use

>els as build-

only horizontal and

nave fewer problems

:e. A simple modular

• nat is legible

pie to create.

: esigning other typefaces, it is

out your letterforms

By using a grid and an

as a template you can fill in

-es on the graph paper to generate

shapes. If you keep it simple and

•o curved shapes, you

can create a bitmap font that can be used

at any size while still retaining all the

shapes of its characters.

The grid is essential for designing an

effective face. The software works by turn-

ing pixels on and off to generate the letter-

forms. The more consideration you give to

the pixel grid and how this will make up

the letters, the better the appearance of

the alphabet.

In addition, the characters in your font

need to be consistent. If you are creating a

small font, you will have to bear in mind

the minimum number of pixels needed to

ReCDEFGHIJKLmn
OPQRSTUUWXYE
abcdef ghiklmn
opqrst u

v

wxy z

1334567090

letter. A lowercase "e" needs to

be at least five pixels high. This means

other glyphs have to use this measurement

even if they can be constructed in fewer

pixels. Photoshop can be used to generate

the characters as you can set the brush size

to one pixel. Using guides, you can then

construct your glyphs to actual size. Once

you have completed the character set, type

combinations of letters to make sure they

have a uniform consistency. These can then

be saved as bitmaps and imported into

Fontographer or FontLab to space and gen-

erate the appropriate font files.

abcdefghi

jkLmnopqr

stuvwxyz

Pixel fonts can look

coarse and ugly at

large sizes. When
designing for the

screen and to be

viewed at small

however, pixel fonts

become much more

legible. They can also

be ii'.cd to |;ivc ,1

modern or "tech" feel

to any piece of design.

t: Pixel fonts are

typefaces that use

the strict modular

approach of using

individual pixels to

construct letterforms.

Above is a font based

on this premise.
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Work out the

shapes of the

letterforms on

paper first before

attempting them on

screen. This results in

a more consistent

font and also means

you can take accurate

measurements from

the graph paper to

work out how many
pixels are needed for

each glyph.

ince there are no

curves, any rounded

strokes have to be

made up from

joined rectangles.

The easiest way to

achieve this is to

leave white gaps

where the arches

would usually occur.

L fa

p

Jl

p Name Untnled-1

(i Photoshop File

° h

p \

>,' y

j •

\ T

Bj
jn j

Edit image Layer Select Filter J J window Help

v. Immm *••" - Proof Setup

Proof Colors

Gamut Warning
$Untttled-l@ lOOXIRCBI

I' I': I?
\" l-.i..

XV

Preset Sizes Custom :
|

Width 18 49 cm •:

Height 1849 cm :

Resolution 72

Mode RGB Color Tl

pixels/inch i '

Cancel

« Open Photoshop

and set your canvas

size to a resolution of

72dpi—standard

screen resolution.

Zoom in

Zoom Out

Fit on Screen

Actual Pixels

Print Size

/ Snap

Snap To

Lock Guides

New Guide...

Contents

^ White

Background Color

Transparent

KO

KR

OX.
Slices

All
£ Photoshop Image Layer Filter View Window

1 pa«b/«vh '-»J f Front tmiQ-

Help

Show Extras Or.

1 """" '

O^n

jfr

1

i In the View

menu, select Show,

then Grid. This

provides a structure

of cells, which can

be used to construct

the letterforms.

"5 Untitled -1 @ 100*(RGB>

-a-

« This is the grid

structure. In the

Preferences menu
you can control

the measurements

between the intervals

and the subdivisions.

J_
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designing pixel fonts continued
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I
lis is a

completed lowercase

"e" letterform.

JL.
'°

•

Jbt' MofJr in tin- linage

Fontographer can read menu to Bitmap, then

if, change the save it as an EPS fill

3Q Options,

M I till- I in inline '"

Binary, then click OK.



designing pixel fonts

Opejen Fontographer

and begin a new font.

Select the appropriate

glyph window, then

choose Import EPS

from the File menu.

.-n
Your EPS file will

appear in the window
as an outline. It

may need minor

adjustments, so check

the character has all

its anchor points

positioned correctly.

a Iflrj fil lt View Element Points Metrics Windows Hints Help
Maui rnnt 'ttkiNew font.

Open Font..,

Close

Save
Save A$„.

Revert

8N
KO

*s

Preferences™, oaep

Generate Font Files

Export

Untitled-!: el 1011 HB
•*- * -«. * -V >V

Page Setup..

Print-

Quit

~o O

r~

s

jtg

MetrRs...

TrueType Character.,

mL

TiTTT

gtbson solid Normal :e[l01]

>V

isur inn J

iO.
•w In the dialog box,

locate the image file

to be imported.

1 i pixel font

iiQ czd Macintosh HD

Eject

Desktop

Cancel

Select an EPS file to import.
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r r
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a with <ail the

letterforms imported,

adjust the metrics to

get the best spacing

and then generate

the font file.

t

FONTS OPTIMIZED
FOR SCREEN

CREATING YOUR OWN
FONT FROM SCRATCH

MODULAR TYPEFACES

126

128
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creating a font from found objects

ispiration for fonts can come from a variety of sources. Quite often, designers can find

their inspiration in places other than existing letterforms.

0,;ner who uses found objects is

s typeface. Bits, was

rigmally to feature in the typo-

grap n fuse 75(1995), with cities

e font was constructed

ds of found materials he then

assembled into letterforms. The letters

were made from metal and plastic items

such as wire, washers, keys, and brackets.

Some of the glyphs were singular items,

others were a combination of objects used

to make up a shape Elhrnan has amassed

hundreds of characters over the years to

an organic face that defies many

typographic conventions

getting objects onto the screen

Constructing a face like this takes time. You

have to spot the potential for typography

• e resulting typeface may

also have a very limited use but it still has a

place within type design. By scanning

either photographs of the object or even

the object directly, you can create a similar

font. First, the shapes need to be reduced to

simple black-and-white images. This can be

achieved by manipulating the Contrast and

Brightness, or Levels, in Photoshop. The

resulting images can then be retraced

using either Adobe Streamline or another

vector illustration package and pasted

directly into the font editor.

You don't have to base your font on sev-

eral different found objects. You can base

letterforms on only one object in
|

and manipulate it to complete an alphabet.

You can use almost anything. Fonts exist

based on objects as mundane as plastic

stirring implements and ring-pulK 1

cola cans Thi to spot the potential

e object and adapt it to make up an

entire typeface.

JlE

Type forms tan be

made up from a

variety of unusual

objei ts Ihese may

provide a quirky and

arresting image.

Assemble and

combine your objei ts

and then either

lilKitnjMjph thi'm and

scan the image, or

|>l,n 1 tin-in ilni'i tly

on the scanner. Above

is a small section

of the strange

glyphs created.



1 Scan the

letterforms in

Photoshop, then

change the Mode
in the Image menu
to Grayscale to

begin the process of

making the shapes

into glyphs.

3

TZE

H Select Adjustments

in the image menu to

increase the contrast

and make the shapes

pure black and white

with no midtones.

Layer Select Filter View Window Help

r

Duplicate...

Apply Image...

Calculations...

image Size...

Canvas Size...

Rotate Canvas

Trim...

Reveal All

Histogram...

Indexed Color...

• RGB Color

CMYK Color

Lab Color

Multichannel

• 8 Bits/Channel

16 Bits/Channel

Color Tat

Assign Profile...

Convert to Profile..

>-—

T

5 With the image

placed, use the

Separate Shapes

command in the

Operation menu to

identify the glyphs and

place them on a

baseline. Some of the

characters are made

up of more than one

shape. In order for

them to be recognized

as one glyph, select

and combine all the

elements using the

Merge command,

also found in the

Operation menu.

. File Edit View C^^i^] Tools Wiimows Help

3 3|^j' *
I [

n %;

Enhance Image
Invert

Flip Horizontal

flip Vertical

Rotate

Separate Shapes
Assign Names

Split

Place Into Font

Retrace

Show Font

L_

inon ^jl^j

s

Duplicate-

Apply Image-.

Image Site-

Canvas Slie-

Crop

Rotate Canvas »

Grayscale..

indeti'd Color

RGB Color

lab Color

ehe: l» I* ..l"....r?

Jb

rBstoiran

UseFontLab's

ScanFont software to

to import these kinds

of glyphs into a font

editor. Open your font

image in the software.

D Names Template 5

Templates :
|
• New • JLl

ibelsErvl

_

(!> Apply lo all symbols O APP'y to selected symbols

d|
Apply Now

| |

Get |
j

Open...
j

Save...

i Name the glyphs

so that they are placed

in the correct window

in the font editor.

Type the characters as

they appear from left

to right and top to

bottom across the

image. Click the

Apply Now button

and the glyph names

will appear.

Operation Tools Vi

Enhance Image
Invert

Flip Horizontal

Flip Vertical

Rotate

Separate Shapes
Assign Names

Merge
Split

Place into Font

Retrace

Show Font

H Arrange the letters

into one file and then

in Mode, change them

from Grayscale

images to Bitmap.

Save the image as a

TIFF file, to be read by

the font editor.

Edit View Operation Tools Windows Help

Close s«w

Save S«S

Save As...

Revert

Select Source...

Acquire...

corvimis bmap
handwriting scan.pic

topic bold

handwriting scan

new font caps image
new font numerals image
new typeface image

Quit 36 Q

« Select the Place

into Font command
from the Operation

menu. This is an

automated function

that positions the

glyphs in the

appropriate windows

within the chosen

font editor.

Q
2 Once in the font

editing software,

adjust the spacing

and generate the font

file to create a

working typeface.
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creating extra weights
?you have created your typeface, you will need to create different weights. The

rity of font editing applications allow you to embolden the type you have created.

Pr°£

numbe

ises the

•ie height. It

•y the process of

g two weights of

iple bold and light, and inter-

poli
- ssence.a

n version. This is known as

ne software pinpoints

• .vo glyphs and plots points to create an

average Using this function can result in

several weights of a face. Fontographer has

•asiest way to achieve this result by

g the Element menu and setting the

ge Weight command.

As with all software, it has default set-

and performs operations on an

not mathematical, basis, so cannot

produce the same result as a carefully con-

sidered hand-drawn font because it does

more than increase the stroke weight

of the original outline A hand-drawn ver-

sion of the character is always much better

as the designer can make judgments on

e qualities of the letterform

and increase the vertical
'•

horizontal ones to produce a more

pleasing character It is much I

iw a bold version and then au'

-nend the software's bold version by

moving and manipulating an

abcdgfghtii.:

abcdgfghijhLm

abcd9fghijhLm

1 Once you have

opened your font in

Fontographer, you can

create extra weights.

To do this, select all

the characters in the

font window, then

choose Change

Weight from the

Element menu.

L2=d
V9

;

':'
IT"

' ,

,, i .,

1 b
|

B
|

3t?i±!r
ij *~ ,

n i) 11
1

i u « m N ^

•w

"]
*-""-*™— — '

1

r
""•'

'

—

,

* _.-
; . : i .

< ~i

:::
pr1! ! 1 I 1 1 i (

;

1

1
1 , |,

\

i+* T
" i * '

<
3

I.

1 ' a l III 1 (. HI I i n-
* t i tJ \ v '

| 9 1 h i
h i :

;

>

1
1 1 •' ¥ w 1 m i ir^

yimi«niMM t^tt)
1

', rw *—^—timmmm

o
+< in i in- iii.iid)', I'm.

select the amount of

change in em units.

As most fonts become

bolder, the x-height

ln< leases along with a

slight increase In the

width. If you do not

wish this to happen,

check the boxes

in.ill.i-il I iim't I ll.lllj'.r

Vertical Size and

Don't Change

Horizontal Size.

H .

- .
— -

jmpare the

original chara<

new

one low

the baseline wt

before.it sat cm

Make any adjustments

necessary to ensure

• the face is cot
i

before generating I

\

BUB
I L_l



creating extra weights

Inti the process of

increasing the weight,

be aware that certain

points may move.

Here, you can see that

the stroke on the top

of the bowl of this

lowercase "d" is

slightly misaligned.

If the point has to

be moved only a

fraction, it is difficult

to move it accurately

with a mouse. Use

Transform from the

Element menu to move

the anchor point.

H Here, you can see

how an unnecessary

anchor point has

distorted the glyph.

Remove this using

the Merge Points

command from the

Points menu.

/^ Font Mend

3r The other way to

create extra weights

is to interpolate

very light one, you can

create a weight in

OK
:

|
canice sansbold ! L

£
f

canice sanshght
!between them. To do

between two this, open up both
Destination font . |

Newfont !
extremes. So if, for

example, you have a

fonts, then in the

Element menu, select

Blend Fonts.

4 All existing source characters

O Selected destination characters

very heavy face and a

Blend amount: ||HB|%

J Points Metrics Windows Hints Help
Ivf Correct oath directions first

Transform „.

Arrange
3 Re-encode fonts to match characters

Font Info-

Selection Info...

Bitmap Info-

•*i

g]ES ice sanslKjIit

P>
Unicode 0041

6S Hex: 41
ie 0067
57

< > ? 2 z ? s %

Auto Trace-
Change Weight...

Clean Up Paths-

Expand Stroke...

Recalc Bitmaps-
Remove Overlap

0*T
098W
096C
038E

-„*.R

09*0

1
i In the dialog box,

set the Source fontsK L tl N

*

+
. 1

and the Blend

t \ 1

'
_ 1n ^~r~ ., | K L amount. Here we

M H I J
have entered a figure

of 50 percent.
Correct Path Direction

Clockwise

Counterclockwise

086K
h I m n

z.
c f n h i

i }
- ~r 9 E N

Blend Fonts...
^ _ -

u (J u r. t t
|

Multiple Master- \

1 1 1 1 1 1 1

\\\

i (,

r

t. The resulting

glyph has the outline

guides of both source

fonts with its own
outline placed

between them.

t'
CREATING YOUR OWN
HANDWRITTEN FONT

REVIVING HISTORICAL
FONTS

CREATING YOUR OWN
FONT FROM SCRATCH 164

148

156
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creating outline fonts

ned versions of a font can be created by using some simple commands in

?ration software. This allows you to control the width and style of the stroke.

I

-or or FreeHand.

yo . oke of a set

me.i f None to obtain

an : ress

does not pre utline font when

g the nmand in the

Me<> II always

tins a v /oil have no con-

trol over" ith

i may also n< . it h

an outline o'

ages allow y<

i / not provide In I best

to produce a version of the font where you

can set the stroke measurement yoursi h

Fontographer and FontLab give you the

control to create an outline version of any

font. You can specify how thick the stroke

width is by specifying it in a measurement

ofems.lt is easy to use and you can m.ini|'

ulate the letterforms by using Expand

Stroke, which appears in the Element menu

ntographer and the Outline submenu

in the Tool menu in lontlab. By keying in

ies you can experini'

you obtain the desired resul' illing

number of em units that make

up the width nt the outline but also

whet h. i the end caps and joins have

mitered, rounded, or beveled corners.

Fontographer also gives you the option

ise the calligraphic pen commands. By

selecting .ill the i harai ters, the software

applies this to the font in the glyph win-

dows v'i'U then just have to generate the

fbnl file In the appropriate format. The

pai mg and hinting may need manipulat-

I. pi nding on tin .imuiiiit i <\ '.In >kr v m

have applied. A large stroke may require

that you increase or decrease the spacing

between i harai ters.



creating outline fonts

First, open the font

in Fontographer. In

the Element menu,

choose Expand Stroke.

In the dialog box,

select Normal pen or

Calligraphic pen and

set the Pen width in

em units. Also select

the join options

—

Miter, Round, or Bevel.

H Once you have

clicked OK, the stroke

width appears in the

glyph window. This

may take some

practice to get right.

To gain a slightly

more expressive

atmosphere, try using

the Calligraphic pen

option. Set the Pen

width and Pen angle

to make the type

look as if it has been

created with a flat nib.

Otrvnitoi ,i

- * ** » Av ^L<
1

i.r.-o HnU

n
Q mmti twv

(u 1
«mt »|

1
fntri )

I.Hn
| tow* -|

• l<ltr>»ivi «>
MMB(M|nM

, ^
\ c~2J

Expand Stroke

OK

Cancel
|

Q« In the same dialog

box, select the Cap

option—Butt, Round,

or Square.

D Hum«ilrtr77W-Bold6: Metrics BE
T.i [S^?i 7^7J| Burning $ | file. |

f- J

SiM®tt X
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Mm
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•• 3 .-. 08
" "

"
i 1
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.1,, Ml 111 I'll
1

-

i If you select all in

the font window, you

will be able to apply

the command to all

the characters at

once. You can see how
this has worked in the

metrics window.

H As you can see in

this screenshot, the

outline is more

uneven in its stroke

width. Experiment

with different pen

angles to obtain

various effects.

t
• OUTLINED TEXT

• SCREEN PRINT EFFECTS

• GLOW EFFECTS

AMENDING
EXISTING TYPEFACES

6o

96

9«

15*
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spacing
ng is just as important as the shapes of the glyphs themselves. Without careful

t of the spacing, the font won't create an even tone of text on the page.

e are

n either

: rox-

gfor

rm. Optically,

socr >e generated

More space than

ild or black char-

Jebearings.

A'- .- s a painstaking

ne basic

vith vertical

irgei :ebearmgs than

have larger side-

bea- angled strokes.

Test -ach other in the

Met- i a lowercase "n,"

ng frve 'S together (nnnnn).

:er should have enough space

around it so that it still looks like an "n,"

rather than running together to form an

The left upright stroke should have

slightly more space than the right curved

stem. Repeat for the lowercase "o," whose

sidebearings should be equal on each side

and less than those on the letter "n." You

can tin
: idapt these values to suit the

other letters. Certain letters, such as "g,""s,"

"t," and "z," are best spaced by eye.

Start spacing capitals with an "H,"an "0,"

and an "A," which form the three basic

shapes of a square, a triangle, and a circle.

Repeat the process as before. "H" receives

the most space, "A" the least.

nnorn nnorn

nnorn mom
nnorn nron

Some of the characters

on the left have an

appropriate amount

of space around them,

whereas others are

too close to each other.

Character recognition

can be difficult with

certain glyph

combinations when
spacing is too close,

such as an "r" and an

"n" looking like an "m."

• seehow
ook

when set next to

each oth<-

Fontographer and

FontLab. this is shown
in the Me'

window Select Open

S Window from

ndows menu.

Windows Hints Help

Open Outline Window %H
Open Bitmap Window '#,\

Open Metrics Window #K
View Windows by

^ siidw iinii Pali

• canice sansbold

ranice sanshyht

nnnnn

i ... ct individual

characters such as a

lowercase "n." Here,

we have the Bitstream

'irary's version

of( Mmond.

Notice the amount of

space surrounding

md how,

when they are placed

side by side, ea< h oni

is easily recogr M

Z u.ilived characters,

such as a lowercase

"o,"can cause

problems when i I

next to ea< ti other, so

check their spacing.

This should be less

ih. in lh.ii given

to horizontal

glyphs, such as"n,"

to compensate for

the curvature and

lo make them look

optically correct.



spacing

fii.- Edit View Element Point*

mmi .

~! I

ppnnn
gF & L/4 I.mj l.»5 i"&*4*=U==*i

1 The

Window* Hint* Help

H5ET

V 3^-

<< To set the spacing,

open the glyph

window and move the

dotted sidebearings

closer to, or farther

away from, the glyph.

To set an identical

amount of space on

either side of the

character, use the

Equalize Sidebearing

command in the

Metrics menu. This

will center the

letterform within the

guides. This should be

used for letters such

as a lowercase "o."

nese are different

weights of the

same font in the

Metrics window. To be

easily recognized,

condensed typefaces

and those with light

stroke widths require

more space than those

of a bolder nature.

canice sansbold : Metrics HB

rnnlte sambold n|IIO|

A^ ?Xi

i Certain characters

require more space on

one side than on the

other. An example of

this is shown here.

Since the glyph has a

prominent serif on

the left-hand side it

needs less space on

that side than on the

right-hand side.

Tex t [oooocl Kerning ^ [ File... j

DlDDOD
47 825

<

ii Once you have

completed the

adjustments, review

them in the Metrics

window to make

sure they are

adequately spaced.

GasslcalGar*mondBT-Homan : Metrics

HOA

T*.t [WW
;

gKemmo ^ | Hte- \HHH
r-i nm

jpercase

letterforms conform

to three basic

shapes—a circle, a

square, and a triangle.

By looking at an "H,"

an "O," and an "A,"you

can ascertain the

amount of space

required for each

of these shapes

and apply them

throughout. As a

basic rule, the 'A"

and "O" will need less

space than the"H."

Dace uppercase

letters exactly the

same as with the

lowercase letters,

repeating glyphs to

see how well they sit

next to each other.

i
CREATING YOUR OWN
HANDWRITTEN FONT

CREATING YOUR OWN
FONT FROM SCRATCH

CREATING A FONT
FROM FOUND OBJECTS

KERNED PAIRS

148

164
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kerned pairs

s are instructions built into the type file to correct spacing between certain

:ers when placed together.

N
*ur-

gssuch

g that

let-

.d of doing it

jt software, you

:o the type file to

combinations. If

•.o glyphs, complete

e placed m separate

boxe those two boxes to

:jce the amount of

e between the letters. A font can have

-,-se are best edited by

eye. Correction can be a laborious process

and although Fontographer and FontLab

have the ability to automatically kern a

typeface, it is never as successful as doing

it manually.

The Metrics window in the software

allows you to adjust kerning pairs. It is a

simple process of typing in the glyphs then

picking up the guides for the sidebearings

and dropping them in the correct position.

This information is saved with the font so

your instructions remain in the file. A suc-

cessful text face relies on paying special

attention to spacing and kerned pairs, so it

is always worth taking some time over

these elements.

typical pairs

The design of the font will typically deter-

mine how many kerned pairs you will need.

Lots of circular, curved, or diagonal strokes

require more kerned pairs as they sit better

with less spacing between them. The char-

acters that normally require attention are

the numerals 4, 6, 7, and 9, and the upper-

case letters A, C, D, F, C. J, K, L, P, S, T, U, V, W,

and Y. Professional type designers can

spend weeks going through this process to

make sure that the text has rhythm and

definition by generating a uniform tone for

the typography. They do this in the knowl-

edge that their designs can then be used

for a multitude of functions.

ovAV
AO to

n«i»(c«l&*r*mond6I-Ptom#fi : Mttrlci

OVAV
AO to

j

. Withm the

font file, embed
instructions to

kern particular

combinations of

letterforms. Certain

glyphs require extra

kerning when placed

side by side. Particular

pairings, such as "A"

and "V,"need special

attention due to the

angled strokes.

You can see in the

Metrics window
that the space

between them looks

too large.



kerned pairs

ClassttafGaramondBT-Roman : Metrics

T«*l |Hvcy>HJ ][ 3 Kerning ^ [ File- j

Avcghio

_Q_

O
"A" and "v," and "c"

and "g" need some
kerning. By clicking

on the letterform in

the Metrics window

you will see the Left,

Right, and Kern

guides appear. By

dragging these guides

closer or farther away

from the character,

you control the

amount of kerning

between them.

o
H The space between

the letters "A," "v," and

"c" in thisGaramond

face looks much

greater than that of

the other characters.

By generating kerning

pairs it is possible

to rectify this without

the need to kern

manually in the

layout software.

canice sanslight : Metrics ,m H@
Text jfWeghio a Kerning ^ Q File.- j

I a a
!

i

t
—

'

HU
a

) CD hin

i n a
Chor
Uidth
Left
Right
Kern

fi V o h i o
493 550 35? 401 402 230 36i
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This process is

labor intensive, but it

is worth doing to

produce typography

that is both legible

and has rhythm.

Once the adjustments

are complete, the

software will save

the information in

the font file. This will

then be used to

display the font in

other programs.

ii In the kern field

at the bottom of

the window you

will seethe letter

combinations along

with the values of

the amount of

kerning required on

the left or right of

the glyph.
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controlling hinting
evelopers and typographers need to consider the problem of rendering scalable

i low-resolution devices. Controlling hinting can help with this.

xon-

- ble.

3 given

nappeal-

.thematically

to make sure

:hroughout vary-

-rough hinting,

jme for the set of tech-

-^g. as far as possible, the

-. of a given typeface,

e process consists of care-

ents to the process of fill-

ne. At low resolutions, round-

ean that parts of some char-

sappear, and other parts can

appear too thick or too thin. Hints attempt

/ equalizing weights of

g parts of glyphs disap-

pearing and generally maintaining esthetic

appearance and legibility down to as low a

:ssible

•^nts have more com-

..ctions. The nature of the

•tie glyph to have its own

• emains con-

•he sizes. PostScript

is effective a system.

ated process, where

•erform has to be

assessec • on to figure out

whe be applied. There

are I troke widths

appear to be the sa vertically and

horizontally, along with how thick the serifs do reduce the need for laborious work

are and how far round figures overshoot on the part of the designer. But these may

the baseline. still need some adjustments later

The software does offer autohinting on to make letters look optically correct at

functions. These work mathematically and low resolution

Hinting is time

consuming and

complicated. It is a

process of going

through every

character and making

sure that it renders

legibly at every point

size. If you have a

large font family this

could mean working

on up to 2,000 glyphs.

Most designers use

autohinting and then

fine-tune the results.



controlling hinting

Window

FontLabhasallthe

hinting information

located in the Tools

menu. Select Hints and

Guides and then

choose Autohinting

from the submenu.

There are two different

types of hinting—Type

i and TrueType.

TrueType is the most

complex but also the

most effective as it

generates a hinting

program for every

character. These

options can be found

in Operations in the

Tools menu.

Outline

Hints & Guides

Templates

Multiple Master

Assign Mask...

Kerning Assistance...

Metrics Assistance...

Transform...

Rcpcr

Transform Range..

Blend Fonts...

External Tools

36T

O88T

Interpolate "*C3€P

Position Bitmap "CStB

ope ^ZXZ

Curve

Set -^.0

Contours XSSI

Set Stanpoints X98T

Type 1 Hinting

TrueType Hinting OS*F7

Customize..

I

Z- If you select the

Type 1 option, you may

see a warning box. It

is worthwhile making

any corrections before

proceeding. A preview

box will then appear

with your typeface

shown at a variety of

sizes. You can see how
the software has

manipulated certain

letterforms to be

legible at a variety of

point sizes.
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Delete this hint

Properties.

V.

3 the glyph

window, you will see a

series of points and

guides. The black areas

are the active contours;

arrows are the direction

of the contours; yellow

areas are overlapping

zones of hints; and

yellow marks the

starting points for

contours. Green "HR"

marks are points for

hint substitutions. To

delete a hint, hold the

Control key and click

with the mouse on the

outline. In the resulting

dialog box, choose

Delete this hint.

TrueType Tools
i

Yt X
<r I <— H* A* '' -*A

m r
!•: 3

—1

1

:

5

± Wo

A± If Vi If you need to add

a hint to a character,

press the Control key,

click with the mouse

and choose Add

Horizontal, Vertical

Hint, or Link. With the

TrueType option

selected, the method

and tools are quite

different. In the glyph

window, you can see

the number of pixels

available and how it

affects the character.

t/ork your way

through a variety of

point sizes to see how
the glyph is affected. A

new toolbox appears

with a selection of

specialist hinting tools

available. These

control horizontal and

vertical directions,

along with alignments

and links. Links are

important as they

are used to set a

relationship between

outline points and set

distances between

stem points.

t
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generating font files and using fonts
have completed the design of your font, the next stage is to write the font files

vorking typeface.

W
Font will

.pported

ems are

e 1. TrueType

Apple and Microsoft

.vo to install and

jre traditionally con-

. and are

:esigners and output

j,uire additional soft-

is Adobe Type Manager (ATM)

e fonts correctly on screen.

regards formats, it is best to create

>sh and Windows versions of

o make sure they work on

all systems

commercial use of fonts

f you j'e designing a font to be sold it is

important to check it for any anomalies or

-ors. Print it from as many

devices and platforms as possible

tot- .vorks correctly.

If you want to sell the face, submit it to

one of the many type foundries. They will

promote and market the font, taking a

percentage of sales revenues in return

You can also make your font available

through your own website This will give

you greater control of revenues but you

will have to do your own marketing.

Alternatively, make the font available as a

shareware dowr m your site.

Si
canice sans regular. bmap CANICESA.TTF CAN CESA.PFM

Si a.
t

canice sans regular.suit Canic CAN CESA.PFB

A ^^ Ptftl Vltw Pim»BI Potmi M»lmt window* Hlnti Htlp

no generate the

font file, first create

the font suitcase. In

Fontographer, simply

use the Generate

Font Files command
in the File menu.

^e dialog box

provides two options,

Easy and Advanced.

Select Easy then

choose your desired

format from the

Computer menu.

e on your

font format, choosing

either TrueType or

PostScript from the

Format menu.



generating font files and using fonts

a Fonts i
|

Q#Gunq seoni

j~\ xHe.ldlineA dfonl

[~\ *PCrnyouncjjo.rtfont

Q*Pil(|lche.tKorit

21, AI6jyan.tif

A
« Select a folder to

save the file to, or

create a new one.

FontLab is similar

to Fontographer,

except that it has

separate commands
for PC and Macintosh

o
The commands

for creating a Mac
file use simple icons

rather than text.

After deciding the

file format, set the

destination folder in

Export Macintosh

Suitcase then click OK.

files. For the PC, use

Generate Font from

the File menu. For the

Mac, use Generate

Mac Suitcase.

Export Macintosh Suitcase

Add * tS

I«aji,*w,i«u

7 5^ cwilce tans regular

•* O p|»,n

1^1 Canlces&nsregular

> O K> 1 " 1

> O »«*r

> © Bold Hilic

Select destination format Macintosh TrueType

Write resources in Data Fork

:'
.nr

( Options. < Cancel > ( OK )

Finally, the Export

Option dialog box

allows you to turn on

and off certain

functions such as

hinting, along with

the AFM file.

<< The Advanced

option is more

complicated. You still

select your platform

from the Computer

menu but this time

you can set your

desired Encoding. You

can also output an

AFM file in Other

options, giving details

of the font.

H Select your

desired Font Format.

FontLab differs from

Fontographer in that

it has the advantage

of being able to

generate OpenType

file formats. These can

contain hundreds of

characters, including

foreign language

glyphs, all in one file.

t

1

CREATING YOUR OWN
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CREATING YOUR OWN
FONT FROM SCRATCH
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index

A

op

Type Managt eluxe 50.54-5

Adobe Type V 'ght54

••

amending typefao

apostrophe 38

Apple Macintosh 1

generating font files 186-7

24

ascender

• -7

autotracmg 78-9

B
Barnbrook. Jonathan 94

baseline grid 45. 48-9

bevel 66 n8

3pS122

blending .

see a/so hybrid fonts

bloat 68-9

blurring 7 3.118

ength 35

optimizing fonts for screen viewing 126-7

type/fonts 28-9, 32-3

upper/lowercase letters 34

book typography 43

bowl 12

brochures 43

Brody. Neville 22, 78

brushes 100-1

calligraphic 96-7

custom 112,113

calligraphic pen 178-9

calligraphy brushes 96-7

capitals 16, 34

drop 40

Cascading Style Sheets (CSS) 120-1

cast metal effect 118-19

character sets 144-5

chrome effect 116-17

circles 58-9

clipping groups 82-3

color

gradients 72-3

misregistration effect 62-3

for web pages 130-1

color wheel 131

columns 36-7, 44-5, 48, 49

combining fonts 94, 154-5

combining letterforms 86-7

condensed letterforms 20, 32

continuous text 28-9, 32-3

copyright 152

count'

Mg fonts 142-3

building glyphs 146-7

character sets 144-5

from handwriting 148-51

objects 174-5

from scratch 164-7

software 140-1

crossbar 12

curves 58-9

customizing letterforms 94-5

cut out/cut up effects 88-9

Dead History font 94, 160

Deck, Barry 142

default settings 30

descender

Digiset 11

digital typography 22-5

digitizing 140-1, 148-9

Dimensions 90-1

distortion filters 102-9

drawing

fonts/characters 146-7, 164-7

over type 78-9

Dreamweaver 120

drop capitals 40

ear 12,13

Egyptian fonts 14, 15

1 lllman, Paul 174

em dash 39

em square 16

embedded Innl'. I •;.' j

emboldening type 176-7

emboss 66-7,116,11/, 118



index

Emigre magazine 22

emphasis 31

en dash 16, 39

EPS files 146, 147, 160, 161, 164, 166, 172, 173

extended letterforms 20, 32

Extensis Suitcase Fusion 50-1, 52-3

eye 12,13

fading type 80-1

fields 44

filters, distortion 102-9

fixed-width (monospaced) fonts 126, 168

Flash 132,136-7

font design 142-5

font embedding 132-3

font files 186-7

font management 50-5

Fontgrapher 140-1, 146, 147, 152-3, 168

blending fonts 160-2

calligraphic pen 178-9

FontLab 140-1, 152-3, 168, 178-9, 185

fonts 28

for body copy 28-9, 32

classification 14-17

combining 94,154-5

commercial use 186

customizing 94-5

default setting 30

formats 24-5

manipulating existing 12-13

optimized for screen 126-7

point size 16-17

selection of 31

FreeHand 41, 74, 78-9, 146

Frere-Jones, Tobias 156

Frost, Vince 10

Frutiger, Adrian 20-1

Frutiger grid 20

Fuse magazine 22, 142, 174

Futura 29, 33,127

Gaussian blur70

GIF (Graphics Interchange Format) images 122-3

animated 134-5

glass effect 108

glow effects 98-9

glyphs 12-13

customizing 94-5

designing 144-5

see also letterforms

good practice, principles 30-7

gradients 72-3,117

grids, typographic 44-5, 48-9

grotesques (sans serif) 14, 15, 19, 29, 39

Gutenberg, Johann 10

H
hairlines 12,13

halftones 76-7

Hamburgerfonts 142, 143

hammered effect 114

hand composition 10

handcrafted effects 100-1

handwritten fonts 148-51

Hell, Dr Ing Rudolph 11

hierarchy 33,46-7

hinting 128-9

controlling 184-5

historical fonts, reviving 156-9

Hoefler, Jonathan 156

hot-metal type 10

HTML (Hypertext Mark-Up Language) 120-1, 126

Humanist fonts 14

hybrid fonts 94, 160-4

see also blending

hyphens 39,40-1

I

Illustrator 60,146

autotracing 78-9

blending 92-3

combining/overlapping type 86-7

gradients 72

perspective 74

text on curves/circles 58-9

Image menu 114

ImageReady software 134-5

images

animated 134-7

text as 122-3

in type 82-3

InDesign 41

internet 23

color and type 130-1

J
JPEG images 122

justified text 36-7, 40-1

K
kerned pairs 182-3

layer masks 81-3

leading (line spacing) 10, 30, 34-5
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nde\

S-9

.8-9

e 100-1

-0-3

68

06-7.118

glow effects

g* 37

. '•admg) 10. 30. 34-5

Linotype 10

v 108-9

logotype* 60

loop

low resolution screens 1.

M

manuscript typography 43

margin guides 48

g

marketing fonts 186-7

masks 80-3

master pages 48-9

metal effects 116-19

Microsoft

Internet Explorer 126, 132

WEFT 132-3

Word 120

misregistration effect 62-3

mistakes, common 38-41

modern fonts 5. 14

modular typefaces 168-9

monospaced fonts 126, 168

Monotype machine 10-11

Morison, Stanley 29

N
neon glow 98

newspapers 36-7. 43, 45

numerals 38-9, 39, 144-5

objects, creating fonts from 174-5

Oliver, Vaughn 76

OpenType 24, 25

orphans 37

outline fonts 179-80

outlined text 60-1

overlapping type 86-7

paragraphs 36-7

patterns 84-5

PC

generating font files 187

viewing text 124

perforated edges 112-13

perspective 74-5

Photoshop 23, 170

brushes 100-1

clipping groups 82-3

nit up type 88-9

3-D effects 66-7

distortion filters 102-9

Effects menu 98-9

glow effects 98-9

gradients 72, 73

layer masks 80-3

perspective 75

shadow effects 64-5

textures 110-11

picas 41

pillow emboss 66

pixel fonts 170-3

point size 16-17

PostSmi't 11, .'.}, 25,128,184,186

primes 38

[Hint ing, history of 10-11

pucker 68-9

puni tuation 38,41,144-5

punk 154

QuarkXpress 25, 40-1, 59, 178

grid construction 48-9

quotation marks 38

ma>

Makela. P Scott 94. 160 page design 42-7



n d ex

ransom note 154-5

readability 42

Reid, Jamie 154

resolution, screen 1247

ripples 104-5

"rivers" 41

rough-textured surfaces 114

roughened edges 68-9

round corners 68-9

sans serif typefaces 14,15,19, 29, 39

ScanFont 140-1, 148, 149

scanning no, 140, 146, 148

screen print effects 96-7

"screening back" 80

screens, low-resolution 124-7

scribble 68-9

serif typefaces 12, 29,39,126

shadow effects 64-5, 73, 117

shapes, mapping type onto 90-1

Shockwave Flash (SWF) software 136

shoulder 12

silk-screen effects 96-7

slab-serif 13,14,15,159

slate effect 111

slug 10

spacing

letters 180-3

lines 10, 34-5

words 34

Spiekermann, Erik 30

spin 70

spur 12

stem 12

Streamline 140,146

"stress" 18-19

stroke weights 18-19, 33. 176-7

stroke-to-height ratio 18

subheadings 33

swashes 94

symmetry 46-7

u

tail 12

terminal 12

terminology 12-13, 28-9

text, continuous 28-9, 32-3

textures

effects 110-11, 114

type as 84-5

three-dimensional effects 66-7, 90-1, 115

Time in Hell 160

"tone of voice" 29

tracking 30,34, 58

transitional fonts 14,15

TrueDoc 132

TrueType 24-5, 128, 184, 186

Tschicholdjan 46

tweak 68-9

tween 134-5

type, defined 28

type alignment 36-7, 40-1

type families 20-1

type management 50-5

typefaces 28

anatomy 12-13

blending 92-3

see also fonts

typographic grid 44-5, 48-9

typography, history 10-11

uppercase letters 16, 34

V
values 29

Vector software 60

visual hierarchy 46-7

Von Gastel, Mikon 102

w
warp text 102-3

wave 104-5

web pages

animated GIFs 134-5

bitmap/GIF images 122-3

color and type 130-1

web safe colors 131

weights 18-19

for body copy 33

creating extra 176-7

widows and orphans 37

wood block style 100-1

wood effect no

word breaks 40-1

word spacing 34

X
x-height 19

zigzag 104-5

zoom 70, 71
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